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Notice

This publication and its contents are proprietary to Tiernan Radyne ComStream, Inc. (Tiernan) and are intended solely for the contractual use of 
its customers for no other purpose than to install and operate the equipment described herein. This publication and its contents shall not be 
used or distributed for any other purpose and/or otherwise communicated, disclosed, or reproduced, in any way whatsoever, without prior 
written consent of Tiernan.
Only experienced personnel should install and/or operate this equipment. Prior to installing or operating any equipment or parts  thereof, 
personnel must carefully read and understand all of the contents of this publication. To properly install and operate this equipment and/or all 
parts thereof, personnel must strictly and explicitly follow all of the instructions in this publication.
FAILURE TO COMPLETELY READ AND FULLY UNDERSTAND AND FOLLOW ALL OF THE CONTENTS OF THIS PUBLICATION PRIOR TO INSTALLING AND/OR 
OPERATING THIS EQUIPMENT, OR PARTS THEREOF, MAY RESULT IN INJURY TO PERSONNEL AND/OR DAMAGE TO THE EQUIPMENT, OR PARTS THEREOF.
Tiernan does not assume any liability arising out of the application or use of any products, component parts, circuits, software, or firmware 
described herein. Tiernan further does not convey any license under its patent, trademark, copyright, or common-law rights nor the similar 
rights of others. Tiernan further reserves the right to make any changes in any products, or parts thereof, described herein without notice.
©2002 Tiernan Radyne ComStream, Inc. All rights reserved.
Tiernan Radyne ComStream is a registered trademark. Other brand and product names mentioned herein may be trademarks or registered 
trademarks of their respective owners.
Contents are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the government is subject to restrictions as set forth in 
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer Software [OCT. 1988] clause at DFARS 252.227-7013 and 
subparagraphs (a) through (d) of the Commercial Computer Software-Restricted Rights [JUNE 1987] clause at FAR 52.227-19, as applicable. 
Manufacturer is Tiernan Radyne ComStream, Inc., 6340 Sequence Drive, San Diego, CA 92121 USA.
Contents of this manual are provided as is without warranty of any kind, either expressed or implied, including, but not limited to, the implied 
warranties of merchantability, fitness for a particular purpose, and non-infringement.
Content could include technical inaccuracies or typographical errors. Changes are incorporated in new editions of this manual. Tiernan may 
make improvements and/or changes in the product(s) and/or the program(s) described in this manual at any time without notice.
In no event will Tiernan be liable for direct, indirect, special, incidental, economic, cover, or consequential damages arising out of the use or 
inability to use the contents even if advised of the possibility of such damages. Some jurisdictions do not allow the exclusion or limitation of 
implied warranties, or the limitation of liability for incidental or consequential damages, so the above limitation or exclusion may not apply to you. 
For further information on legal and intellectual property matters, contact Tiernan.
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC Rules. These 
limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. 
This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the ins truction 
manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful 
interference in which case the user will be required to correct the interference at his own expense.
 

WARNING! Electric Shock Hazard
Do Not Open The Equipment! 
Service Only by Tiernan Radyne ComStream, Inc.
Gefährliche Spannung!
Öffuen des Gerätes und Service nur dur Tiernan Radyne ComStream, Inc.
The TE6000A contains no user-serviceable parts. Do not attempt to service this product 
yourself. Any attempt to do so will invalidate any and all warranties.

DANGER!
Electric Shock
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Preface

Using This Guide This guide is your sourcebook for using the Tiernan TE6000A and describes the 
installation, operation, and configuration for this product. An overview of system 
and product level requirements, technical specifications, and troubleshooting 
procedures are also provided.
This guide is designed to help you find information quickly and easily. To take 
full advantage of this design, please take a moment to review the specific formats.

Important Information
Throughout this guide you will find icons designed to help you identify important 
information. These icons are: 

The hazard icon identifies the possibility of electric shock when you perform an 
operation with the TE6000A or if you do not use the TE6000A according to 
instructions.

The caution icon identifies information that requires careful attention in order to 
prevent equipment damage and/or injury to the operator.

The note icon identifies information for the proper operation of your equipment, 
including helpful hints, shortcuts, or important reminders.

Illustrations
Some illustrations contained in this guide may differ slightly from those shown on 
your front panel display, rear panel, or remote terminal due to variations in your 
system setup, configuration, or customization.
Figures depicting equipment may differ from those at your site; therefore, refer to 
the labeling on your Tiernan equipment to identify the components. An effort has 
been made to use illustrations that reflect basic equipment and configurations of 
the majority of customers.

Issuing Commands
Tasks and examples are presented in a series of step-by-step instructions. 
Commands or information that you enter into the system appear in a different 
type, as shown in the following example:

To restore the factory default configuration, select 
config>presets>restore>dvb from the front panel, or issue the remote 
command cm restore dvb.

If the command contains variable information that is to be typed into the system, 
the variable information is found within karats < >. In the following example, you 
would type TCA DELETE then the correct value for <label>:

Type TCA DELETE <label>

DANGER!
Electric Shock

Hazard

CAUTION!
Please Read

Carefully

NOTE
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Front Panel Navigation
This guide uses right angle brackets (>) to indicate a sequence of menus, 
submenus, and menu items. 
For example, select Config>Control>Clock>Date>June 03, 2003 means:

■ From the config menu, select control.
■ From the control menu, select clock.
■ From the clock menu, select date.
■ At the date option, enter the date, June 03, 2003, in the correct format.

Displays
The system may return values and messages on a front panel LCD, remote 
terminal, or both. In this guide these values and messages appear in a different 
type:

date = 06/23/2003
restore = dvb

Revision History This guide is periodically updated and revised. For documentation updates, call 
Tiernan Customer Service. 

Customer Service We hope this guide provides all the information and instructions you need to 
operate the TE6000A. However, if you need assistance, contact Tiernan Customer 
Service at our corporate headquarters, located in the United States, through any of 
the following methods:

■ Phone 858.657.5454, Monday – Friday, 
7:30 a.m. – 6:00 p.m. pacific standard time

■ Fax 858.657.5455
■ Email support@tiernan.com
■ After-hours Emergency Customer Service Paging: 858.657.5454, option 5

Leave a detailed voice message and your call will be returned.

Product Shipments Please verify that your company name and address are correct on the packing slip 
that is included with your equipment. Notify Tiernan Customer Service if any of 
the information is incorrect. 
Ensure that you write down the following numbers and include them in any 
correspondence with Tiernan concerning your order: 

Errors
If any part of your shipment is missing or incorrect, call Tiernan Customer 
Service.

Revision Date Type of Revision

A 04/2002 Initial release

B 06/2002 Updated Conditional Access and Screen Saver commands for both 
front panel and remote operations.

■ Purchase order ■ Model

■ Reference line ■ Sales order
vi 01-0873-401B 06/02 Preface



Cartons and Packing Materials
The factory shipping carton and packing materials are designed to protect the 
equipment from excessive shock and vibration that can occur during shipping. 
Use the original shipping carton and packing materials to repack the unit for 
shipment to another location or to return the unit to Tiernan for repair.
For additional information on equipment repacking, refer to the Warranty booklet 
that accompanied the product shipment.

LCD Display
When you receive your TE6000A, the LCD display may be covered with a plastic 
protective covering. To remove the protective covering, gently lift one of the 
corners and peel off the covering. 

Warranty Information For warranty or return material authorization information, refer to the Warranty 
booklet that accompanied the product shipment.

Other Tiernan
Products

The Tiernan Web site, found at www.tiernan.com, provides information about the 
entire line of Tiernan products and systems, including encoders, integrated 
receivers/decoders (IRD), switches, ATM products, network interfaces, and 
network management software.

Safety Precautions Carefully read and follow all safety, use, and operating instructions before 
operating the TE6000A. Heed all warnings and cautions contained in this guide. 
Retain these instructions for future reference.
Follow Startup Procedure
Do not plug in the TE6000A until you have connected the system and read the chapter on 
installation.

Provide a Safe Location
Place the TE6000A in a rack or on a stable surface of sufficient size and strength, where it will not 
be jarred, hit, or pushed off its surface. Ensure that all cables and cords are out of the way and will 
not be tripped over, as this could cause personal injury or serious damage to the equipment.

Avoid Water and Moisture
If the equipment is exposed to any liquid, contact Tiernan, as serious damage could occur to the 
TE6000A or its components.

Avoid Heat, Humidity, and Dust
To avoid internal damage, the TE6000A should be placed away from all heat sources, including 
radiators, heater ducts, and so on, out of direct sunlight and away from high humidity, excessive 
dust, or mechanical vibrations that can cause damage to internal parts.

Provide Adequate Ventilation
Slots and openings on the TE6000A are provided for ventilation that is needed to ensure reliable 
operation. To avoid overheating and ensure that the ventilation slots are not blocked, place the 
TE6000A on a smooth, hard surface that has at least two inches of clearance around the unit and 
adequate air circulation. If the equipment is placed in a closed area, such as a rack, ensure that 
proper ventilation is provided and that the internal rack operating temperature does not exceed the 
maximum rated temperature at the position of the TE6000A.
Never place the TE6000A on a soft surface that would obstruct the required airflow into the 
ventilation slots.
Preface 01-0873-401B 06/02 vii



Use Correct Power Source
For units equipped with a North American power cord, the cord has an IEC-compatible female plug 
on one end, and a male plug on the other end. This cord is UL and CSA approved up to 12 5VAC at 
10 A and is ready to use with no user wiring required.
For units equipped with an International power cord, the cord has an IEC-compatible female plug on 
one end, and three stripped and tinned bare wires on the other end. This cord is approved up to 
250 VAC at 6A and complies with the international color codes of green/yellow (ground), blue 
(neutral), and brown (line).
If these color codes do not correspond to the colored markings on the terminals in the plug, use the 
following standards:
■ The green/yellow wire must be connected to the plug terminal marked by the letter E or by the 

earth symbol ( ) or color-coded green and yellow.
■ The blue wire must be connected to the plug terminal marked with the letter N or color-coded 

black.
■ The brown wire must be connected to the plug terminal marked with the letter L or color-coded 

red.
An AC plug must be attached to the International power cord in accordance with government 
standards and codes in effect at the installation site. If an unterminated power cord is supplied with 
the unit, the appropriate certified termination plug must be installed. The following is a list of the 
required certifying agencies for various countries.  

Route Power Cords Safely
Route power cords so they are not walked on or pinched. Pay particular attention to cords and 
connections at the plugs, receptacles (such as power strips), and the point where they exit from the 
TE6000A and attach to other equipment. Do not place any items on or against power cords.

No Stacking
Do not place or stack any objects on top of the TE6000A. Other equipment may be placed in a rack 
or on a shelf above or below the TE6000A, but never stacked directly on top of it.

Protect Against Lightning and Power Surges
When the TE6000A is installed, have the professional installer ground the system to protect against 
voltage surges and built-up static charges. For information on grounding standards for electrical and 
radio equipment, refer to the electrical code in the country of installation. 
Protect the TE6000A from lightning and power-line surges during a storm by unplugging it from the 
wall outlet and disconnecting the coaxial cable.

Turn the TE6000A Off When Changing Circuit Boards
Turn the TE6000A off before installing or removing any circuit boards from chassis slots. Possible 
damage may occur to modem, boards, or related equipment if power is left on during this procedure.

Provide Antistatic Protection
Wear a properly grounded antistatic wrist strap to prevent electrostatic damage to components when 
handling circuit boards or other electronic modules.

Country Agency Country Agency

Australia SAA Italy IMQ

Austria OVE Japan MITI

Belgium CEBEC Netherlands KEMA

Canada CSA New Zealand SECV, SECQ, SECWA, EANSW, ETSA, HECT, SANZ

Denmark DEMKO Norway NEMKO

Finland FEI Rep. S. Africa SABS

France UTE Spain AEE

Germany VDE Sweden SEMKO

India ISI Switzerland SEV

Ireland IIRS United Kingdom (UK) ASTA, BSI
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Keep Objects Outside
Touching internal TE6000A parts is dangerous to both you and the unit. Never put any object, 
including your fingers, through slots or openings, as this could result in touching dangerous voltage 
points, short-circuiting parts, electric shock, or fire.
There are no user-serviceable parts inside the TE6000A. If an object falls into the equipment, unplug 
the unit and contact Tiernan Customer Service, as serious damage could occur to the TE6000A or its 
components.

Use Approved Attachments Only
Use only Tiernan-approved option cards and equipment with the TE6000A.

Clean the TE6000A
Before cleaning the TE6000A, unplug it from the wall outlet. Do not use any type of abrasive pads, 
scouring powders, aerosol cleaners, or solvents such as alcohol or benzene.
Use only a clean, soft cloth lightly moistened with a mild detergent solution. Wipe all equipment 
with a clean, soft cloth lightly moistened with water to remove the detergent solution.

Service the TE6000A
Do not attempt to service the TE6000A yourself, as there are no user-serviceable parts. Opening or 
removing covers may expose you to dangerous voltages or other hazards as well as void your 
warranty. Contact Tiernan Customer Service to obtain qualified service personnel.
The following conditions indicate that the equipment needs servicing:
■ The power cord or plug has been damaged.
■ An object has fallen into the TE6000A.
■ Liquid has been spilled into the TE6000A, or it has been exposed to rain or water.
■ The unit has been dropped or the cover has been damaged.
■ The TE6000A does not operate normally, or it shows a marked change in performance.

Perform Safety Checks
Upon completion of any service or repairs to the TE6000A, ask the service technician to perform 
safety checks to verify that the system is in safe operating condition.
Preface 01-0873-401B 06/02 ix
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1TE6000A Overview

The TE6000A is a rugged, modular 
MPEG-2 encoder designed for news 
gathering and professional broadcast 
applications. Video input may be 
analog, PAL or NTSC, or serial digital 
525/625. Two stereo audio inputs may 
be either analog or AES/EBU.  Encoding may be 4:2:0 in accordance with 
MPEG-2 Main Profile @ Main Level or 4:2:2 Studio Profile @ Main Level 
depending on the encoding module chosen. The compressed digital output is a 
DVB® MPEG-2 or ATSC-compliant transport stream.
The TE6000A compresses the incoming video with the latest adaptive field-frame 
MPEG-2 algorithm. The video compression is performed with I, B, and P frames 
using bidirectional predictive coding and motion estimation. The four stereo or 
eight mono audio channels are compressed using the MPEG audio encoding 
standard. The two auxiliary data channels support both synchronous and 
asynchronous serial formats.
Control and system status is provided by a push-button front panel with an 
illuminated LCD and bright LED indicators.
The integrated DVB®, QPSK satellite modulator is controlled by one touch 
buttons for carrier on/off and modulate. Additionally, remote control is available 
using ASCII commands via the EIA-232 remote control and Ethernet ports.
The TE6000A’s rugged chassis is a 2U high (8.9 cm), 19” width rack-mount unit 
providing full rear panel cabling. The main power switch is conveniently located 
on the front panel.

Features The TE6000A consists of the following standard feature set:
■ Advanced video compression chip-set which encodes the input video 

following either 4:2:2 Studio Profile @ Main Level or 4:2:0 Main Profile @ 
Main Level standards depending upon the installed feature set 

■ A high-quality horizontal decimation filter for intermediate horizontal 
resolutions

■ Supports compressed audio rates of 64 to 384 kbps and four different audio 
channel compression methods

■ Accepts two high-speed, independently programmable auxiliary data 
channels

■ Automatic configuration of video and audio rates to match the available 
transmission bandwidth for optimum performance

■ Dedicated modulator control buttons are provided on the front panel for one 
touch control

■ BISS conditional access
■ Extensive VBI data support of DVB teletext
■ Front panel interface for local configuration, monitoring, and control
■ Front panel lockout to prevent accidental configuration changes
■ At-a-glance status monitoring via a tri-colored Status LED indicator
TE6000A Overview 01-0873-401B 06/02 1



■ Status hot key enables you to toggle between fault lists and other front panel 
menus

■ Remote control via Ethernet or EIA-232 providing all configuration, monitor, 
and control functions

■ Built-in-self-tests and extensive self-diagnostics to assist with system 
checkout and problem solving

■ Non-volatile, field-programmable memory
■ User configuration sets that can store and recall commonly used parameters 

sets
■ Auto-ranging, auto-sensing power supply
■ Rugged chassis construction

Video The TE6000A uses an advanced video compression chip-set which 
encodes the input video following either the 4:2:2 Studio Profile @ Main Level or 
the 4:2:0 Main Profile @ Main Level, according to MPEG-2 standards (ISO/IEC 
13818-2). 
The TE6000A supports the following compressed video rates:

■ MPEG-2 4:2:2 Studio Profile @ Main Level: 2.5 to 50 Mbps which provides 
superior quality compressed images at high data rates

■ MPEG-2 4:2:0 Main Profile @ Main Level: 1 to 15 Mbps 
The video encoder features a low latency mode for interactive applications and a 
Tiernan proprietary, high-quality horizontal resampling filter for intermediate 
horizontal resolutions.
Audio Two stereo or four mono audio channels are compressed using MPEG 
audio encoding standards. 
The TE6000A supports compressed audio output rates of 64 to 384 kbps and four 
different audio channel compression methods. 
Auxiliary Data Two channels of synchronous data up to 4.096 Mbps each (RS-422 
levels) or asynchronous data up to 38.4 kbps each (RS-232 or RS-422 levels) are 
supported by the TE6000A.
Conditional Access The TE6000A supports both BISS, modes 0 and 1, as well as 
Tiernan’s proprietary condition access schemes.
VBI – Vertical Blanking Interval Extensive VBI data support is provided via the 
TE6000A. Supported formats include:

■ Proprietary passage of NTSC line 21 closed-captions
■ ATSC closed captioning
■ DVB Teletext for World System Teletext (WST) on PAL
■ DVB 4:2:2 expanded windows carries WSS, VPS, VITC, CC, AMOL, XDS, 

etc.
Modulator The TE6000A has a built-in DVB®-compatible QPSK modulator with 
a 70  MHz IF carrier capable of supporting up to 20 MSym/sec.
Modulator Control Buttons The TE6000A provides dedicated modulator control 
buttons on the front panel. These are designed to bring carriers up onto satellites 
in a fast and efficient manner.
Transport Stream Output Both single-program-transport-stream (SPTS) and 
multi-program-transport- stream (MPTS) operations are supported and may be 
configured in a point-to-point or point-to-multipoint system. (Note: SPTS and 
MPTS are also referred to as single-channel per carrier, SCPC, and 
multi-channels-per carrier, MCPC, respectively.) 
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The TE6000A accepts all commonly used video and audio input formats and 
outputs an MPEG-2 DVB compliant transport stream in addition to a 
DVB-compliant, QPSK-modulated 70 MHz IF carrier. 
If an external transport stream is provided from another encoder, the TE6000A 
will multiplex the two transport streams to form a combined transport stream 
(MPTS). This daisy chaining of encoders and multiplexing of transport streams 
may continue until the units reach the 70 Mbps limit or the modulator symbol rate 
limit.
Within the data rate limitations of the channel, the TE6000A can be reconfigured 
for different video resolutions, video optimization, and audio compressed bit rates 
to get the best video performance. Higher compressed bit rates result in better 
decoded video quality.
For high reliability applications, the TE6000A provides exceptional MTBF 
performance with its extensive digital processing and proprietary FPGA circuits. 
In addition, the TE6000A can automatically configure the video and audio rates in 
order to match the available transmission bandwidth for optimum performance.
Monitor and Control Functions The TE6000A monitor and control functions 
include:

■ Fault Relay with passive normally-open and normally-closed contacts
■ Front panel operator control utilizing an easy-to-use, intuitive menu and 

backlit push-buttons
■ Remote control using either an Ethernet or RS-232 interface 

Front Panel The TE6000A front panel interface allows you to scroll through a 
standard set of menus to easily set your operating parameters. All configuration 
and monitoring functions can be efficiently performed using the front panel.
At-a-glance system status can be quickly determined by checking the tri-colored 
front panel status LED:

■ Green — indicates that the unit is receiving AC power and that there are no 
faults

■ Yellow — indicates that the unit has a current fault
■ Red — indicates that the unit has a hard fault

If the Status LED indicates that there is a fault, the Status hot key enables you to 
go directly to the current faults list with the press of a button. 
Remote Control A remote unit, such as a computer terminal, is easily connected to 
either the EIA-232 remote control port or Ethernet port allowing the TE6000A to 
be configured, monitored, and controlled using character-based ASCII protocol. 
Programmable Memory The TE6000A is a field-deployable unit with non-volatile, 
field-programmable memory that ensures retention of configuration parameters 
during power outages, power off, and transportation. The TE6000A maintains the 
last user configuration in flash memory.
Configuration Sets The TE6000A has a number of default configurations that can 
be restored as well as numerous user-defined configuration sets that can be saved 
and restored.
Construction The TE6000A is a small, rugged, 2RU (90 mm/3.15”) high, 19-inch 
wide rack-mount chassis with an international, auto-sensing, AC power supply.
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2Installing the TE6000A

This chapter provides step-by-step procedures for installing and cabling the 
TE6000A. 

Do not remove the TE6000A top cover! The TE6000A is powered by an exposed, switching AC 
power supply which presents an electric shock hazard when the top cover is removed. Personal 
injury or damage to the equipment can occur when the top cover is removed. None of the procedures 
in this manual require the removal of the TE6000A top cover.

Before beginning your installation, read the Safety Precautions as they contain important safety 
information and other instructions required to install the TE6000A.

Placement The TE6000A can be installed on a table top or in a rack. Use the following 
guidelines to determine the appropriate installation for your needs:

■ If the equipment must be moved frequently, install the TE6000A on a table 
top or other flat surface.

■ If the equipment is going to be installed permanently, install the TE6000A in 
a rack using rack mount brackets.

Whichever installation is used, always position the equipment to allow easy 
access to the rear panel and provide adequate ventilation.
To properly install the TE6000A, follow the instructions provided in the appendix 
on table top and rack mount installation instructions.

Ventilation
The TE6000A must be positioned to receive adequate ventilation at all times. The 
cooling fan pulls air in through the side vents, circulates the air, and exhausts it 
out the side vents. The minimum air flow clearance required on both sides of the 
chassis is three (3) inches.

Powering On The
TE6000A

The rear panel AC power supply interface includes a fuse holder, and an IEC 320 
power cord receptacle. The typical TE6000A configuration requires 125 amps.
The TE6000A unit is powered by an auto-sensing, auto-ranging AC switching 
power supply. The supply accepts 100 to 120 VAC and 200 to 240 VAC nominal 
input voltage levels cycling at 50 to 60 Hz. A 3.15 amp fuse on the rear panel 
protects the power supply from excessive current. 
The On/Off (—/0) power switch is located on the front panel. 

AC Power Cords
The TE6000A shipping kit includes two AC power cords, one for North American 
applications, specifically the United States and Canada, and the other for 
international applications.

AC wiring must be done in accordance with governmental standards and codes in effect at the 
TE6000A installation site. Refer to the Safety Precautions for additional information.

DANGER!
Electric Shock

Hazard

CAUTION!
Please Read

Carefully

CAUTION!
Please Read

Carefully
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North American Applications One cord has an IEC-compatible female plug on one 
end and a North American male plug on the other. This cord is UL and CSA 
approved up to 125VAC at 10A. This cord is ready to use with no user wiring 
required.
International Applications The international cord has an IEC-compatible female 
plug on one end and three stripped and tinned bare wires on the other end. This 
cord is approved by many international safety agencies, including VDE, up to 
250VAC at 6A. 

Connecting to a Power Source
To connect to an AC power source, follow these steps:
1. Select an AC power cord. If an international power cord is selected, attach a 

connector in accordance with local regulations and laws.
2. Ensure the TE6000A power switch is in the Off, or 0, position.
3. Connect the female plug of the AC power cord to the AC power receptacle on 

the TE6000A rear panel.
4. Connect the male plug of the AC power cord to an external A Cpower 

conditioning surge suppressor.
5. Connect the AC power conditioning surge suppressor to an A Coutlet.

Corrupted AC input power can interrupt TE6000A operations and cause permanent damage to the 
unit. You should purchase and install a commercially available, external AC power conditioning 
surge suppressor to protect the TE6000A against power spikes and line transients.

Power-up Sequence
Once the cabling and interconnections for the TE6000A are 
completed, you may power-up the unit. The TE6000A 
power switch is a rocker switch located on the front panel.  
The power switch is labelled with an l and an 0. 
The l represents the On position, while the 0 represents 
the Off position.
To power up the TE6000A, press the power switch to the On, or l, position. 
The power-on cycle takes approximately two minutes to complete, as the unit 
performs extensive self-diagnostics in this time period. 
During the powered-up cycle, the TE6000A displays TE6000A Encoder 
Initializing..., various messages scroll across the LCD, and the tri-colored 
Status LED illuminates and may flash.
After the unit is initialized, the LCD displays the TE6000A SDTV MPEG-2 
Encoder main menu. 

When you begin the initial TE6000A installation and configuration, the modulator output (Mod 
State) should be turned off until you are ready to begin satellite transmissions.

CAUTION!
Please Read

Carefully

On/Off
Switch

TE6000A

I
0

TE6000A SDTV MPEG-2 Encoder
[Config] Status Version

Software Version: 3.00

NOTE
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Rear Panel
Connections

All TE6000A external connections are located on the rear panel, as shown in the 
following illustration.

Video Ports The TE6000A provides connections for both analog and digital video.

Analog Video Ports (TVIP-6025)
The TE6000A analog video ports, found on the TVIP-6025, are as follows:

■ Analog Video In
■ Analog Video Loop-Thru
■ Analog GenLock

Analog Video In Analog Video In is a female BNC connector with 75Ω 
impedance, accepting a NTSC or PAL composite analog video input that is 
1.0Vpp nominal level. The analog composite video input must be compliant with 
SMPTE 170M NTC, ITU-R BT.470, and PAL-I/B/D. The connector shell is 
connected to signal ground.
Connect the video input cable to the Analog Video In connector on the rear panel.
Analog Video Loop-Thru Analog Video Loop-Thru is a loop through of the 
composite video in signal on a female BNC connector. This connector should be 
terminated with a 75Ω load to maintain proper video levels through the system.
Analog GenLock The Analog GenLock is a female BNC connector with 75Ω 
impedance. The 27 MHz source clock is derived from one of the following 
sources:

■ Incoming video
■ External analog genlock input, SMPTE RP154 (NTCS), EB UD23, and EBU 

D25 (PAL)
The external genlock input permits the user to hot switch the video input during 
the vertical blanking interval without losing synchronization. Typically GenLock 
is connected to a black burst house sync signal in a video plant.
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Digital Video Ports (TVIP-6001)
The TE6000A digital video ports, found on the TVIP-6001, are as follows:

■ D1 Video In
■ D1 Video Out
■ D1 Video GenLock

D1 Video In D1 Video In is a female BNC connector, with 75Ω impedance. The 
port accepts a 525 line or 625 line D1 serial digital video input that is format 
compliant with SMPTE-259M. The video input is expected to be 2 7 0Mbps, with 
10bit ITU-R Rec. BT.601 sampled video in 4:2:2 (YCbCr) component format.
Connect the digital video input cable to the D1 Video In connector on the rear 
panel.
D1 Video Out D1 Video Out is a loop through of the digital video in signal on a 
female BNC connector. When the TE6000A is powered off, D1 Video Out is a 
passive loop through. When the TE6000A is powered on, the D1 Video Out is an 
active loop through driven by a 75Ω driver.
D1 Video GenLock The D1 Video GenLock is a female BNC connector with 75Ω 
impedance. The port accepts external SMPTE 259M input. When activated, the 
D1 Video GenLock is used as the timing reference for the 27 MHz MPEG system 
clock of the TE6000A.
The external genlock input permits the user to hot switch the video input during 
the vertical blanking interval without losing synchronization. Typically GenLock 
is connected to a black burst house sync signal in a video plant.

Audio Ports The TE6000A provides the following audio input connections:
■ Analog audio on the TVIP-6025
■ Digital audio on the TVIP-6001

Analog Audio (TVIP6025)
The TE6000A has two sets of analog audio input ports located on the TVIP-6025:

■ Analog Audio A Right and Left
■ Analog Audio B Right and Left

The ports can be configured for two stereo or four 
independent analog mono channels.
Each port has a female XLR connector with high 
impedance (>10k Ω) termination.
The pin assignments for all the analog audio ports are 
listed in the following table.  

Audio Port Pin Assignments

Pins Signal

1 Gnd

2 + 

3 –
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Digital Audio Ports (TVIP6001)
The TE6000A has two digital audio input ports located on the TVIP-6001:

■ Audio Input A
■ Audio Input B

Each port has a female XLR connector with 110Ω. nominal termination. The ports 
accept AES/EBU serial digital input that is compliant with ANSIAES3-1992 
(ANSI S4.40-1992) recommendations. The ports are typically configured for two 
stereo channels.

Aux Data A and B
Ports

Aux Data A and Aux Data B ports are located on the TMAC-6000. These ports 
are female DB-9 connectors. Each channel can be independently configured as 
synchronous or asynchronous. 

Synchronous Configuration
In synchronous configuration, the ports accept RS-422 input at 1 kbps to 4 Mbps. 
The auxiliary Data A and Data B synchronous port pin assignments are listed in 
the following table.  

Configuring the DTE and TE6000A Clock Interfaces
After you have cabled the data termination equipment (DTE) to the TE6000A, 
you must determine the most effective TE6000A and DTE clock source 
arrangements. There are three different ways to configure the clock interface for 
the TE6000A and the DTE:

■ Clock Interface Configuration 1 is the most reliable clock source 
arrangement. This configuration requires the DTE to provide a clock (TT) 
synchronous with the data (SD) to the TE6000A.

■ Clock Interface Configuration 2 is the second most reliable clock source 
arrangement. This configuration is used when the DTE cannot turn around the 
ST, but has an internal clock source that can be provided as TT to the 
TE6000A.

■ Clock Interface Configuration 3 is the least reliable clock source arrangement 
— it should only be used if the first two clock configurations cannot be used. 
In this configuration the TE6000A is configured to use ST to latch the data.

Aux Data Port Pin Assignments: Synchronous – RS-4 2 2

Pins Signal Direction Definition

1 Unused — —

2 ST+ Out Send Timing

3 SD+ In Transmit Data

4 TT– In Term Timing

5 GND — Ground

6 ST– Out Send Timing B

7 Unused — —

8 SD– In Transmit Data

9 TT+ In Terminal Timing

Shell GND — Ground
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Clock Interface Configuration 1 The most reliable auxiliary data channel clock 
source configuration requires the DTE to provide a clock (TT) synchronous with 
the data (SD) to the TE6000A. This scenario allows the TE6000A to latch the data 
using a clock that has traveled the same path as the data, which ensures that both 
the clock and the data are received in phase at the TE6000A.
The following block diagram shows the clock configuration for a DTE configured 
to turn around the ST clock source, and a TE6000A auxiliary data channel 
configured for an external clock source. 
Notice in the illustration that the switch for the TE6000A auxiliary data channel 
clock source is configured for external even though the TE6000A is providing ST 
to the DTE. 

In this configuration, the TE6000A provides clock (ST) to the DTE. The switch 
for the DTE clock source is configured to accept the external clock (ST) provided 
by the TE6000A. The DTE uses the ST to time the data, sends the data to the 
TE6000A on SD, and returns the ST to the TE6000A on TT. The TE6000A uses 
TT to latch the data. 
The TE6000A auxiliary data channel must be configured for an external clock 
source to accept TT from the DTE.
Clock Interface Configuration 2 If the DTE cannot turn around the ST, but has an 
internal clock source that can be provided as TT to the TE6000A, use this option 
to configure the auxiliary data channel. 
The following block diagram shows the clock configuration for a DTE providing 
an internal clock source as TT to the TE6000A.

In this configuration, the DTE clock is set to internal and the TE6000A auxiliary 
data channel clock source is set to external. The DTE uses its internal clock source 
to time the data, sends the data to the TE6000A on SD, and sends its internal clock 
to the TE6000A as TT. The TE6000A uses TT to latch the data. The TE6000A 
auxiliary data channel must be configured for an external clock source.
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Source
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Internal Clock
ST

TT

ST

SD
Latching Data
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Clock Interface Configuration 3 If the DTE cannot turn around the ST, and does not 
have an internal clock source that can be provided as TT to the TE6000A, 
configure the TE6000A to use the ST to latch the data. However, this scenario is 
not recommended and should be considered only if neither of the other two clock 
source configurations can be used.
The following block diagram shows the clock configuration for a DTE configured 
for an external clock and a TE6000A auxiliary data channel configured for an 
internal clock. 

In this scenario, both the DTE and the TE6000A use ST, but the ST is provided to 
the DTE on one path and to the TE6000A on a different path. Depending upon the 
length of cable between the DTE and the TE6000A, the clock may be received out 
of phase at the TE6000A. The longer the cable, the further out of phase the clock 
will be.

If the internal clock is used to latch the data, the length of cable between the DTE and the TE6000A 
must be limited to one meter (3 feet). Additionally, the auxiliary data rate must be limited to not 
more than 64 kbps. If the cable length exceeds one meter, or if you attempt to process data at rates 
above 64 kbps, the auxiliary data may be corrupted.

Asynchronous Configuration
In asynchronous configurations, ports can be configured to accept RS-232 or 
RS-422 input at rates of 1200 bps to 38400 bps. 
RS-232 The DB-9 connector allows a standard RS-232 DCE connection. The 
auxiliary Data A and Data B asynchronous port pin assignments for RS-232 are 
listed in the following table.

Aux Data Port Pin Assignments: Asynchronous – RS-232

Pins Signal Direction Definition

1 Unused — —

2 Unused — —

3 TD In Transmit Data

4 Unused — —

5 GND — Ground

6 Unused — —

7 RTS In Ready to Send

8 CTS Out Clear to Send

9 Unused — —

DTE
Data SD

Clock ST
ST

Data

Timing Data

TE6000A

Internal Clock
ST

TT

ST

SD
Latching Data

To TTM

Ext
Source

Int
Source

Switch
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RS-422 The auxiliary Data A and Data B asynchronous port pin assignments for 
RS-422 are listed in the following table. 

Remote Unit
Connections

A remote unit can be connected through either of two ports located on the 
TMAC-6000:

■ RS-232 
■ Ethernet Control

RS-232 Control Port
The RS-232 port is a DB-9 female connector. The port can be configured as a 
DTE or DCE. The default configuration is as a DCE. 

DCE Configuration
The pinouts for the RS-232 port configured as DCE are listed in the following 
table.

Aux Data Port Pin Assignments: Asynchronous – RS-422

Pins Signal Direction Definition

1 Unused In —

2 CTS+ Out Clear to Send

3 RD+ In Transmit Data

4 RTS– In Request to Send 

5 GND — Ground

6 CTS– Out Clear to Send

7 Unused — —

8 RD– Receive Data In

9 RTS+ In Request to Send

 RS-232 Port Pin Assignments: DCE 

Pin # Signal Direction Signal Definitions

1 DCD In Carrier Detect

2 RXD In Receive Data

3 TXD Out Transmit Data

4 DTR Out Data Terminal Ready

5 GND — Ground

6 DSR In Data Set Ready

7 RTS Out Request to Send

8 CTS In Clear to Send

9 RI In Ring indicator

Shell GND — Ground
12 01-0873-401B 06/02 Installing the TE6000A



DTE Configuration
The pinouts for the RS-232 port configured as DTE are listed in the following 
table.

Connecting to the RS-232 Control Port
To connect a remote unit to the TE6000A through the RS-232 control port, you 
need a cable that is the appropriate length for the application. The cable must be 
made to the following specifications:

■ RS-232 electrical
■ DB-9 female connector on one end
■ An appropriate connector for the remote unit on the other end

A 6-foot long direct connect DB-9 male to DB-9 female cable is included in the 
TE6000A shipping kit. 
Using the direct connect cable provided with the TE6000A, attach one end to a 
remote unit and the other end to the RS-232 control port. 

Ethernet Control Port
The Ethernet control port is an RJ-45 connector. Remote control using this port 
requires the following:

■ Tiernan Network Management Software (NMS) program
■ Category 5 UTP patch cable (not supplied)

Connecting to a Network Using the Ethernet Port
You can connect the TE6000A to a LAN using the Ethernet port, which enables 
you to monitor and control the TE6000A through a remote unit not directly 
connected to the TE6000A.

When connecting the TE6000A to a LAN using Ethernet, contact your Information System 
department to coordinate installation and setup.

 RS-232 Port Pin Assignments: DTE 

Pin # Signal Direction Signal Definitions

1 Unused — —

2 TXD Out Transmit Data

3 RXD In Receive Data

4 DSR In Data Set Ready

5 GND — Ground

6 DTR Out Data Terminal Ready

7 CTS In Clear to Send

8 RTS Out Request to Send

9 RI In Ring indicator

NOTE
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Perform the following steps to connect to the network using the Ethernet port:
1. Connect a Category 5 cable with RJ-45 connectors (standard ethernet cable) 

between the TE6000A Ethernet port and a LAN hub.
2. Assign the device a unique IP address, if necessary.

The TE6000A default IP address is 0.0.0.0. Contact your Information 
Systems department for a valid IP address.
To change the IP address using the front panel:
a. Select Config>Comm>Network>IP Addr

b. Using the keypad, enter the IP address in the format xxx.xxx.xxx.xxx 
where xxx is a decimal number between 0 and 999.

c. Press the Enter button
To change the IP address using a remote unit, issue the 
MC IP XXX.XXX.XXX.XXX command where XXX is a decimal number 
between 0 and 999.

3. Assign additional network information, if necessary. Depending on the 
configuration of the LAN, you may need to enter additional parameters 
including:
❒ Ethernet IP address mask (IP subnet mask)
❒ Ethernet IP gateway

4. From a personal computer connected to the LAN, try to ping the TE6000A. 
At the command prompt of the personal computer, type ping <TE6000A IP 
address> where <TE6000A IP address> is the address assigned in step 2.
If a reply is received, the TE6000A is correctly configured.

For information on establishing remote communications or on Ethernet 
commands, refer to the chapter on using a remote unit.

DTE/DCE Switch The DTE/DCE switch is used to change the configuration of the RS-232 port. 
When the port is configured as DCE, use a standard cable for the computer Comm 
port. In this configuration, the port supports all of the signals required for basic 
modem support:

When the port is configured as DTE, use a null modem cable to connect the PC to 
the TE6000A.

Fault Relay The Fault Relay is an RJ-11 connector. The fault relay is used in a redundant 
configuration. In this configuration input is fed from distribution amplifiers into 
each of two TE6000s. A Tiernan redundancy switch monitors the output through 
the Fault Relay. If the primary TE6000A faults, the secondary TE6000A 
automatically takes over operation.
A relay fault condition is defined as:

■ A unit power failure
■ Unit power switch turned off
■ Unit is unplugged
■ A unit hardware failure

■ Rdata ■ Tdata

■ DTR ■ DCR

■ CTS ■ RTS

■ DCD
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The fault condition is indicated by contact closure between pins one (1) and three 
(3) and open contacts between pins one (1) and si x(6).
The non-fault condition is indicated by contact closure between pins  one(1) and 
six (6) and open contacts between pins one (1) and three (3).
The illustration indicates the physical locations of pins 1 and 6 
within the fault relay port, as viewed from the rear panel. 
When the fault relay detects a fault condition, the fault relay 
trips, and the Status LED located on the TE6000A front panel 
illuminates red. 

Transport Connection
Ports

The TE6000A multiplexer outputs an ASI transport stream with a variable rate of 
1 to 70 Mbps. This transport stream is the combination of the video, audio, and 
auxiliary data streams in an MPEG-2 compliant transport stream. Depending on 
the operating mode, the transport stream is either:

■ Input to the modulator or the multiplexer of another TE6000A where it is 
multiplexed with another transport stream before being output

■ Output to an external satellite modulator

Operating Modes
The two TE6000A operator modes are:

■ Single program transport stream (SPTS) (also referred to as single channel per 
carrier, SCPC)

■ Multi-program transport stream (MPTS) (also referred to as multiple channel 
per carrier, MCPC)

SPTS Mode In SPTS mode, the ASI transport stream is connected from the 
TE6000A multiplexer to the internal modulator of the same TE6000A. In this 
mode, the modulator supports transport stream data rates from 1 up to 18 Mbps in 
SPTS mode, depending on the FEC rate selected. Output symbol rates range from 
1 to 20 MSps. 
MPTS Mode In MPTS mode, the ASI output of one TE6000A is fed into the 
multiplexer of another TE6000A so that the output of the two encoders are 
multiplexed in a single transport stream. The signal from a series of TE6000s can 
be combined in this way. The combined transport stream is then output to the 
modulator of the final TE6000A in the chain. 
In MPTS mode, the modulator supports transport stream data rates from 1 to 
32 Mbps, depending on the FEC rate selected. Output symbol rates range from 1 
to 20 MSps. For applications requiring higher data rates, an external modulator 
can be used instead of the TE6000A integrated modulator.

Connections
The TE6000A ports used to connect the transport stream to the modulator and the 
MPTS chain are:

■ ASI TS In
■ ASI Out Pri (primary ASI out)
■ ASI Out Sec (secondary ASI out)
■ SMPTE -310
■ DVB/ASI In

����� �����
Installing the TE6000A 01-0873-401B 06/02 15



ASI TS In ASI TS In is a female BNC connector with 75Ω impedance. When the 
encoder is configured for MPTS operation, this port accepts the transport stream 
from either ASI Out port of another encoder.
ASI Out Primary ASI Out Primary is a female BNC connector with 75Ω 
impedance. The port outputs a DVB- compliant ASI transport stream at rates 
between 1 and 70Mbps.
ASI Out Primary is used for normal operation and is typically cabled to the Mod 
ASI In connector with a short (14”) coaxial cable.
The transport stream output on ASI Output Primary is a spare and is not bypassed 
in case of failure. 
ASI Out Secondary ASI Out Secondary is a female BNC connector with 75Ω 
impedance. The port outputs a DVB-compliant ASI transport stream at rates 
between 1 and 70Mbps.
ASI Out Secondary port can be used to output the transport stream of one 
TE6000A to the multiplexer of another TE6000A for MPTS operation. In this 
configuration, this port is cabled to the Mux ASI In port of the next TE6000A in 
the MPTS chain.
If a fault condition or power failure exists, the input transport stream, which is 
connected to ASI TS In, is bypassed directly to ASI Out Secondary through a 
passive bypass relay. This ensures that only the program associated with the failed 
TE6000A in an MPTS chain of encoders or in a redundant configuration is 
interrupted by the failure. 
ASI Out Secondary can also be used to monitor the transport stream.
SMPTE -310 This port is used to output a SMPTE-310 compatible transport 
stream.
DVB/ASI In DVB ASI In, located on the TMOD-6000, is a female BNC connector 
with 75Ω impedance. The port accepts the transport stream from either ASI Out 
port. 
The DVB/ASI In transport data is processed according to DVB standards and 
output from the integrated TE6000A QPSK modulator on the port labeled Tx IF 
Out.

Modulator Output to
Upconverter
Connections

The internal modulator outputs a modulated IF signal, which is connected to an 
upconverter.
Connections are made through the Tx If Out port. This port is a female BNC 
connector that outputs a 70 Mhz, DVB-compliant, QPSK modulated, FEC 
encoded IF signal at symbol rates from 1 to 20 MSps.
Before you cable the modulator output to the upconverter, turn the modulator off 
until you are ready to begin satellite transmissions. 
To cable the modulator output to an upconverter, connect the output of the 
internal modulator from Tx IF Out to an IF-to-RF upconverter.
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3Using the Front Panel

This chapter describes the following TE6000A front panel information:
■ Components
■ Navigating through menus
■ Description of menus, parameters, and options

Front Panel
Components

The front panel enables you to easily and efficiently configure and monitor the 
TE6000A.

The front panel consists of:
■ LCD – displays menus, parameters, information, and messages
■ Enter button – used to select a menu item, issue a command, or set a 

parameter
■ Exit button – used to scroll up to a previous menu level or leave a parameter 

without changing it’s option
■ Left and Right buttons – used to scroll within the current menu level, or to 

scroll through a list of parameters
■ Up and Down buttons – used to scroll through parameter options and increase 

and decrease parameter values
■ Alpha-numeric keypad – used to enter alphabetic and numeric parameter 

values
■ Status button – hot key which toggles between the current front panel menu 

and the current faults list
■ Status LED – tri-color LED alerts you to status and fault conditions
■ Modulator control buttons and LEDs – these two buttons affect the power and 

form of the output IF transmit carrier from the encoder:
❒ Carrier – enables carrier wave at nominal power
❒ Mod – enables modulated carrier at nominal power

EXIT

ENTER GHI JKL MNO

PQRS TUV WXYZ

ABC DEF

MOD

CARRIER

STATUS

TE6000A
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On / Off
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Enter
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Menu Structure

Config Restore
Save

SD Menu Submenus Parameters

Data Data A to B Enable Comm Mode Interface Baud
Data Width Parity Stop Bits Data Rate
Clock Source

Digital Slot 4A to 4B Enable Compression Data Rate 
Format

Delay
Sample Rate

Audio

Analog

Presets

State Password

"Press ENTER to Reset"Control

FP Lock
Clock
Reset

Date Time

Ext TS Enable Ext TS Status
Rate Calc Redund StateChannel Mode Table TypeTx Strm

Service Setup Service ID Name Provider Major Channel 
Minor Channel 

Baud Data Bits Parity Stop Bits Flow Control
IP Addr

Serial
Network IP Mask IP Router TMA

Comm

Version Firmware <firmware version labels>

Status Current
History

<list of current faults>

Relay
List Clear
List Clear

Mod State
Code Rate

Data Rate
Spect InvertTx Power

SymRate Mod Source Tx Power-up Mod Status

Output
Tx Freq 

Out Mode

Slot 1A to 1B

Loc TS Enable Loc TS Status
ExtRate
LocRate

New
Rename
Delete

<list of factory and use configuration sets>
<list of user configuration sets>
<enter new configuration name>
<list of user configuration sets>
<list of user configuration sets>

CA
PGCA Key PGCA Message PID

Video Enable Input Source Format Ctrl
Data Rate ChromaResolution

Optimize Timebase

Format

Delay

PID

VBI Teletext Enable Data ID

PID Source
Data Resolution

D1 Audio Chnl Pair
Enable Compression Data Rate 

Format
Delay
Sample Rate

PID Source
Data Resolution

PID

PCR Delay Transmit Rate

Setup

PGCAcfg

Aspect Ratio

Language

Language

Lst IRD <list of CA IRDs, MAC address, and enabled status>
Add IRD <add an IRD to CA database>

Del IRD <delete an IRD from CA database>

CC Tiernan CC ATSC CC
Data Unit ID

Expand VBI PassThru

Scramble None
PGCA
Biss Mode1

Service

SMPE Enable

PID

BISS Key

<no scrambling selected>
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Navigating Through
the Menus

The front panel LCD display and buttons were designed to help you navigate 
through the TE6000A menu structure quickly and efficiently. 

LCD Display The TE6000A uses the following naming conventions for data that displays on the 
front panel.

LCD Symbols
There are six important symbols that appear on the LCD: 

Brackets As you are moving through menus, parameters, and options, the 
brackets indicate which item is currently selected. 
Arrows As you are navigating through the TE6000A parameters, a right arrow 
will often display on the LCD. This arrow indicates that there are additional items 
available in that parameter list.
Asterisk While the TE6000A is executing a command or setting a parameter 
option, an asterisk (*) appears on the LCD, indicating that the TE6000A is 
processing information. When the asterisk disappears, the process is complete.
Equal Sign Most parameters, though not all, can be modified in order to configure 
the TE6000A. Configurable parameters are followed by an equal sign, denoting 
that the parameter can be modified.
Colon There are some parameters that are automatically set for your system or 
that are query-only parameters. These type of parameters are followed by a colon. 
When a parameter is followed by a colon, that parameter can be viewed but not 
changed.

LCD Text Formats
All menus, parameter options, and system information are displayed on the front 
panel LCD. 
Menus All menus are displayed in the following format.

■ The first line identifies the current menu level. This example shows the 
Configuration menu. 

■ The second and third lines display the available menu items. 
■ The brackets indicate which menu item is selected. In this example, the 

Service menu item is selected.

■ Brackets [ ] ■ Asterisk (*) 

■ Arrows ■ Colon (:)

■ Equal sign (=)

Config>Tx Strm
Channel Mode = [SCPC]

 MCPC
 Redundant

Menu

Parameter
Options}

Config
Presets Output [Service] Tx Strm
CA Control Comm
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Parameter Options All parameter options are displayed in the following format. 

■ The first line identifies the current menu level, in this example, the Auxiliary 
Data A menu.

■ The second line displays the parameter, Data Width. The current setting, [8], 
is surrounded by brackets.
Up to three options (8, 7) can be displayed on the LCD at one time. If there 
were more than three options, you would use the Up and Down buttons to 
scroll through the list of options.

■ The equal sign (=) denotes that this parameter can be modified. If this 
parameter was followed by a colon (:) the parameter would be view-only. 

■ The arrow indicates that there are additional Data A parameters. 
To move to another parameter, such as the Parity parameter, you would use 
the right and left buttons to scroll through the list of parameters.

Information Information, such as current faults, faults in the history log, and 
system messages are displayed as ASCII text strings as shown in the following 
example.

■ The first line identifies the current menu level, in this example, the current 
faults (status) menu. 

■ The second through fourth lines list any current faults, in this example, there 
is only one current fault. 

■ If there were more than three faults, you would use the right and left buttons 
to scroll through the list of faults.

Screen Saver
When the TE600A has detected no front panel activity for more than five minutes, 
the screen saver is activated. The screen saver displays the following information 
for the service currently being processed.

To exit screen saver mode and return to normal front panel operations, press 
the Exit button. 

The Enter button should not be used to exit screen saver mode, as this button may issue new 
commands to the TE6000A.

Config>Service>Data>Data A
Data Width = [8] →

 7

Status>Current
1. VI.A Loss of Input

TE6000A SDTV MPEG-2 Encoder
Service: service currently selected
OutRate: output transport stream rate, channel mode
LocRate: rate of locally generated transport stream

CAUTION!
Please Read

Carefully
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Front Panel
Navigation Buttons

The following front panel buttons are used to move through menus in order to 
issue commands and view status and fault information:  

Right and Left Buttons The Right and Left buttons are used to scroll through menu 
items, or through a list of parameters. 
These buttons move you through the menu structure in the following manner:

■ At a menu level these buttons move the selection brackets [ ] and scroll right 
and left, (forward and backwards), respectively, through all available menu 
items at that current level. The following graphic illustrates how the right 
button functions at a menu level.

■ To navigate from one menu line to another, use the up and down buttons. For 
example, to move from the Presets to the CA menu options, press the down 
button. 

■ In a parameter list, the right and left buttons scroll through the parameter list. 
When the last parameter is reached, the TE6000A scrolls through the list 
again. 

■ Right and Left buttons ■ Up and Down buttons

■ Enter button ■ Numeric keypad

■ Exit button ■ Status button

Press Right Arrow
to Move Brackets

to Next  Menu Item

Config

[Presets] Output Service Tx Strm  

CA Control Comm

Config

Presets [Output] Service Tx Strm  

CA Control Comm

Press Down Button
Brackets Move to Second

Menu Line

Config

[Presets] Output Service Tx Strm  

CA Control Comm

Config

Presets Output Service Tx Strm  

[CA] Control Comm

Config>Service>Video
 Enable On
 PID #

 Delay 0

Press right button;  the next parameter displays
Press right button; the next parameter displays

Press right button; system returns to 
first parameter in list
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■ Using both the right and left buttons enables you to scroll through a parameter 
list in either a forward or backward motion.

If you accidentally scroll past the required parameter, you simply use the 
appropriate left or right button to go back to the required parameter.

■ When entering alpha-numeric characters, the left button is used to delete 
characters.

Enter Button The Enter button is used to:
■ Select the menu item displayed in brackets [ ] on the LCD
■ Issue a command
■ Set a new parameter option

To select a menu item, use the Left/Right buttons until the brackets encompass the 
menu item, then press the Enter button. The Enter button moves you to the 
selected submenu.
To issue a command, such as the clear history log command, press the Enter 
button to execute the command. 
To set a parameter option, such as a new video frame rate, use the Up/Down 
buttons until the brackets encompass the option — the option should be flashing 
— then press the Enter button. The TE6000A is configured with the new 
parameter value and the new value is stored in nonvolatile memory.
Exit Button The Exit button moves you through the menu structure in the 
following manner:

■ At a menu level, the Exit button moves you up one menu level.
■ In a parameter list, the Exit button moves you up to the previous menu level.
■ When selecting a parameter option, the Exit button leaves the parameter 

without changing it, and moves up to the previous menu level.

The exit button is also used to exit screen saver mode.

From Enable, press left  button;
system returns to last parameter Press left button;

the previous parameter displays

Press left button;
the previous parameter displays

Config>Service>Video
 Enable On
 PID #

Timebase Video Input
 Delay 0

Press Exit From any Parameter;
System Returns to the Previous Menu Level

Config>Service
Setup       [Video]     VBI     Audio
Data         PCR

{

Press Exit From any Menu;
System Returns to the 
Previous Menu Level

Config>Service>Video
 Enable On
 PID #

 Delay 0

Config
Presets     Output     [Service]     Tx Strm
CA            Control     Comm
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Up and Down Buttons Once a parameter is displayed, use the Up and Down 
buttons to scroll through all available options until the brackets encompass the 
required option.
The Up and Down buttons will also increase and decrease the numeric value, if 
they are pressed before any keys on the keypad are pressed.
Alpha-numeric Keypad The alpha-numeric keypad is used to enter both alphabetic 
and numeric parameter values. 
To correct any alpha-numeric characters, use the left arrow to delete the 
characters.
Alphabetic Entries — when entering values in an alpha-numeric field, the 
following alphabetic and numeric characters are displayed when a key is pressed: 

The first press of a number key displays the first character in the set; sequential 
presses of the same key advance through the character set, in a circular fashion. 
The cursor is advanced by either pressing another number key, or by pressing the 
right arrow key. For example to enter the word ALL which has two characters in 
the same characters set, the following keys would be pressed:

■ 2 selects A
■ 555 selects L
■ → advances the cursor so the next letter can be selected
■ 555 selects L

A space can be entered by either a single press of the “0” key, or by two or more 
presses of the right cursor key. For example, to enter the words LA Default the 
following keys would be pressed:

■ 555 selects L
■ 2 selects A
■ 0 selects space
■ 3 selects D
■ → advances the cursor so the next letter can be selected
■ 33 selects E
■ → advances the cursor so the next letter can be selected
■ 333 selects F
■ 2 selects A
■ 88 selects U
■ 555 selects L
■ 8 selects T
■ Enter to issue the command 

Key Character Displayed

1 . , ? ! - 1
2 A B C 2
3 D E F 3
4 G H I 4
5 J K L 5
6 M N O 6
7 P Q R S 7
8 T U V 8
9 W X Y Z 9
0 space 0 ‘ +
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Numeric Entries — When entering values in numeric field, you simply type the 
required numeric value using the keypad and press Enter. 
The default value that is initially displayed disappears upon the first numeric key 
press. Once a numeric key is pressed, the Up and Down buttons are nonfunctional; 
they resume their normal functions once the Enter or Exit buttons are pressed. 
To delete an alpha-numeric character, use the left arrow key.
To enter a negative value, press the minus key (-) on the keypad; this toggles the 
value between negative and positive.
Status Button The Status button is a hot key which enables you to immediately 
view any faults currently occurring on the TE6000A and then toggle back to the 
front panel menu on which you were working. 

When leaving the current faults using the Status button hot key, you are returned to the menu level at 
which you were working, not to the parameter level.

Issuing Commands To issue a command from the front panel, perform the following steps:
1. Navigate through the menus to the required command or parameter using the 

navigation buttons.
2. Change the parameter option as required:

❒ Scroll through the options using the Up or Down buttons. Ensure that the 
required option is selected with the brackets [ ] .

❒ If the option requires a numeric value to be entered, enter the value using 
either the Up and Down buttons to increment the value or the numeric 
keypad to type in the value.

3. Issue the command by pressing the Enter key. An asterisk will display and 
then disappear when the system is finished processing the request. The 
parameter, with its updated value, is then displayed in brackets and does not 
flash.
❒ If the Enter button is not pressed, the option is not changed.
❒ While the TE6000A is setting the parameter to the new value, the front 

panel is temporarily disabled. 

When the TE6000A configuration is changed using the front panel, the changes are automatically 
stored in non-volatile memory. The TE6000A automatically restores to the saved configuration 
whenever the unit is reset or powered up.

Correcting Mistakes Selecting Options If you are selecting an option and have not pressed the Enter 
button, use the Up or Down buttons to scroll to the correct option.
Using the Keypad If you are entering a value with the keypad, and you have not 
pressed the Enter button, you can either press the:

■ Left button to delete the numbers and then enter the correct value
■ Exit button which returns you to the previous menu level

Leaving a Parameter If you have not pressed the Enter button, you can leave a 
parameter without modifying it by pressing either the:

■ Exit button which returns you to the previous menu level
■ Left or Right buttons which take you to the next parameter

In either situation, the TE6000A will ignore any values entered and return the 
parameter to its original setting.

NOTE

NOTE
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After Pressing the Enter Button If you accidentally issue an incorrect parameter 
value to the TE6000A, you can correct the error by:
1. Selecting the correct option using the Up and Down buttons. The parameter 

will begin to flash.
2. Pressing the Enter button to set the correct option.

Example
The following example describes how to move through menus and select options. 
In this example the TE6000A video will be enabled.
1. From the main menu select Config and press Enter.

2. The Configuration menu displays. 

3. Select Service. Press the Right button to move the brackets to Service. Press 
Enter.

4. The Service menu displays. Use the Right button to select Video.

TE6000A SDTV MPEG-2 Encoder
[Config] Status Version

Software Version: 3.00

Config
[Presets] Output Service Tx Strm
CA Control Comm

Config
Presets Output [Service] Tx Strm
CA Control Comm

Config>Service
Setup [Video] VBI Audio
Data PCR
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5. The Video menu displays, showing the first video option and it’s current 
parameter setting, which is Enable = Off. 

6. Use the Up or Down button to select On. When selected, the On option is 
surrounded by brackets and begins to flash.

7. Press the Enter button. When the asterisk stops flashing, the TE6000A has set 
the new parameter.

Modulator Control
Buttons

The two modulator control buttons, located at the far right of the front panel, 
affect the power and form of the output IF transmit carrier from the encoder. Each 
button has an associated LED indicator. Only one of the LEDs is illuminated at a 
time. These buttons cause the output carrier to be one of the following:

■ Off
■ Carrier on — full-power CW (constant wave)
■ Modulate on — full-power modulated

A blinking LED indicates that the button is busy implementing its command. 
When the command is executed the LED stops blinking. Command execution 
takes 5 to 10 seconds to complete. Each time you press the button, even if the 
LED is blinking, the command is executed.
The purpose of the buttons is to allow fast and simple operation of the encoder 
when a DSNG operator is coming up on a satellite or taking down a link.
Pressing the modulator control buttons causes the TE6000A to toggle the 
modulator as follows: 

Config>Service>Video
Enable = [Off]

 On

Config>Service>Video
Enable =  Off

[On]

Current Modulator 
State Key Press Resulting Modulator State

Off Mod Modulate On; Carrier Off

Carrier On Mod Modulate On; Carrier Off

Modulator On Mod All Off

Off Carrier Carrier On; Modulate Off

Carrier On Carrier All off

Modulate On Carrier Carrier On; Modulate Off
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Front Panel Menu
Descriptions

The following table provides detailed descriptions of the TE6000A front panel 
menus and commands. The commands are organized in the order in which they 
appear on the front panel. Included are:

■ Menu level
■ Front panel command
■ Command function
■ Available options for that command or the response format if the command is 

query-only

TE6000A Front Panel Menu Descriptions 

Front Panel 
Command

Function Options/Response Format

Configuration Menu — consists of the following submenus:
■ Presets — used to quickly and easily re-initialize the encoder using predefined factory default configuration settings your own user-defined configuration settings
■ Output — used to configure and monitor the TE6000A internal modulator
■ Service — used to setup and configure the video, VBI, audio, data, and PCR services
■ Tx Strm — Transport Stream menu enables you to set and query the TE6000A transport stream system configuration parameters. The configuration parameters set at 

this level impact which options and configuration parameters are available on other menus.
■ CA — Conditional Access menu is used to setup the TE6000A for conditional access and to create and modify a list of authorized decoders
■ Control — allows you to control the TE6000A hardware; submenus are Reset, Clock, Display, and FP Lock.
■ Comm — Communications menu is used to set remote control and network features; submenus are Serial and Network.

Config>Presets Menu — Consists of five submenus, which enable you to quickly and easily save your own user-defined 
configuration sets, manage the user-defined list, and then re-initialize the TE6000A using either your user-defined configuration 
sets or predefined factory default configuration settings. These configuration sets are not altered by reset, power cycling, or factory 
DVB default setting of the encoder.

Restore initializes the TE6000A using either predefined factory 
configuration parameters or the selected user-stored, 
site-specific parameters

■ DVB (default)
■ ATSC
■ user-defined configurations, as needed, based on site-specific requirements

Save saves the current site-specific configuration in non-volatile 
(flash) memory under the selected user configuration 
label

Up to 99 user-defined configuration sets may be saved. Configuration sets must be 
saved to existing user-defined labels. If there are no user labels defined, <empty list> is 
displayed. 
User-defined labels are set using the Config>Presets>New feature. 

New creates a new user configuration label The configuration label may be up to 15 alpha-numeric characters in length. Up to 99 
user-defined configuration sets may be created. Once the label is created, the 
configuration set must be saved using the Config>Presets>Save function.

Rename changes the label (name) of an existing user configuration 
set

Displays the list of existing user configuration labels. If there are no user labels defined, 
<empty list> is displayed.

Delete deletes, or erases, the selected user configuration set Displays the list of existing configuration labels. If there are no user labels defined, 
<empty list> is displayed.

Config>Output — Used to configure and monitor the TE6000A internal modulator. When you begin the initial TE6000A installation 
and configuration, the modulator output (Mod State) should be turned off until you are ready to begin satellite transmissions.

Out Mode setting determines if the internal modulator is used to 
control the bit rate output of the multiplexer

■ QPSK – the internal modulator is used (default)
■ ASI – the internal modulator is not used

SMPTE Enable setting determines whether or not the SMPTE output is 
included in the transport stream.

■ on – SMPTE output is included in the transport stream
■ off (default) – SMPTE output is not included in the transport stream
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Data Rate sets the data rate for the output transport stream ■ If SMPTE is disabled: 1 to 160 Mbps default: 8.448 Mbps
■ If SMPTE is enabled: 19.392658 or 38.785316 Mbps

Additional Information: The data rate you enter using this parameter determines the 
combined transport output of the TE6000A and is the multiplexed collection of the local 
transport stream and the externally supplied ASI transport stream, including overhead. 
You must set the output transport stream data rate to a value that is equal to or greater 
than the sum of the local transport stream and the externally supplied ASI transport 
stream, including overhead. That is: 

Mod Input Data Rate = Mux Output Rate 
AND
Mux Output Rate > Local Rate + Externally Supplied Transport Stream Rate 

The diagram at right represents this relationship.
If the output rate is set to a value that is less than the sum of the internal transport stream and the externally supplied ASI transport stream, 
including overhead, the data received at the decoder will be corrupted.

Mod State setting affects the power and form of the output IF 
transmit carrier from the encoder

■ Off – shuts off the TE6000A modulator output (default)
■ Pure Carrier – CW enabled at nominal power
■ Modulate – carrier enabled at nominal power

Code Rate sets the code rate for forward error correction (FEC) of 
the modulated signal

1/2, 2/3, 3/4, 5/6, 7/8
default: 5/6

Additional Information: The rate selected indicates the number of error correcting bits that will be added to the data stream. For example, if you 
select the 5/6 rate, for every 5 bits that are input to the FEC encoder, the FEC encoder outputs 6 bits.
The relationship between the selected code rate and the data stream prior to modulation, and an indication of the degree of error correction 
provided by each code rate is shown below.

Viterbi Code Rate Transport Stream Data Rate Error Correction

1/2 Increases by a factor of 2 (100% increase) Maximum

2/3 Increases by a factor of 1.5 (50% increase) Very High

3/4 Increases by a factor of 1.33 (33% increase) High

5/6 Increases by a factor of 1.2 (20% increase) Moderate

7/8 Increases by a factor of 1.14 (14% increase) Low

Tx Freq sets the modulator carrier frequency 52.0 to 88.0 MHz
default: 70.0 MHz

Additional Information: The acceptable frequency range is implemented with a pass band filter that filters out all frequencies below 52000 000Hz 
and above 88000000 Hz.
When selecting a carrier frequency, take into account the satellite bandwidth required for transmission. If you select a carrier frequency that is too 
close to either end of the valid range, the modulated carrier may be clipped by the pass band filter. For information on calculating the satellite 
bandwidth, refer to the Config>Output>Sym Rate parameter.

Tx Power sets the output transmit power of the TE6000A modulator -20.0 to -5.0 dBm
default: -5.0 dBm

Spect Invert used to instruct the modulator to invert, or not invert, the 
modulated IF output spectrum
Inverting the IF output spectrum eliminates spectral 
inversion in the RF chain caused by selecting lower side-
band images of an upconverted carrier.

■ normal – modulated IF output is not inverted (default)
■ inverted – modulator inverts the IF output spectrum

SymRate sets the current transmission symbol rate 1.0 to 20.0 MSps
default: 5.500187 MSps

Additional Information: The symbol rate is the number of symbols required to transmit the data stream over a satellite link using quadrature 
phase shift keying (QPSK).
The symbol rate is automatically calculated based on the modulator input transport stream data rate, the Viterbi code rate, and other fixed 
parameters that add overhead to the data stream.
If the displayed symbol rate exceeds the allowable satellite bandwidth, the data will be corrupted during transmission.
To determine the satellite bandwidth required to transmit the displayed symbol rate, use the following equation:

Symbol Rate x 1.35 = Required Satellite Bandwidth (in Hz)

Mod Source selects the modulator input ■ ASI - uses the input from the ASI IN connector 
■ internal - uses the TE6000A backplane as source (default)

TE6000A Front Panel Menu Descriptions  (continued)

Front Panel 
Command

Function Options/Response Format

TE6000A

TTX-6001

TMOD-6000

Output DVB-Modulator
IF Carrier

Local Rate
Externally Supplied
Transport Rate

Mux Output Rate

Mod Data Rate
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Tx Power-up sets the transmit carrier restore mode ■ off – following power-up or reset, the modulator output is disabled regardless of the 
modulator output carrier state prior to the power-up or reset. 

■ restore – following power-up or reset, the modulator output is restored to the state 
that was stored in non-volatile memory just prior to the power-up or reset. (default)

Mod Status query-only; displays if the modulator is locked to the 
incoming signal

■ locked – modulator is locked onto the incoming signal
■ unlocked – modulator is not locked onto the incoming signal

Config>Service # Menu — Used to setup and configure the TE6000A Video, Audio, and Data services

Config>Service # >Setup — Used to setup and query TE6000A services and service providers.

Service ID assigns a number to a service, which, in combination with 
the Service and Provider names, allows the user at the 
decoder site to select a service 
Additional Information: If the Service ID is changed, the 
TE6000A automatically sets the Service ID or Program 
Number within the Event Information Table, Program Map 
Table, and Service Description Table to the same 
number. The Service ID may also be referred to as the 
Program Number. 

■ if DVB: 1 to 231; default: 2
■ if ATSC: 2 to 231; default: 2

Name selects the name of the service text string
if default configuration is:
■ DVB, default is: service 2
■ ATSC, default is: ch2

Provider selects the name of the provider when DVB or MPEG 
tables are enabled
Note: Provider is only available when Tx Strm>Table 
Type is set to DVB or MPEG.

text string
default: unnamed

Major Channel sets the major channel when ATSC table types are 
enabled
Note: Major Channel is only available when Tx 
Strm>Table Type is set to ATSC.

1 to 99
default: 30

Minor Channel sets the minor channel when ATSC table types are 
enabled
Note: Minor Channel is only available when Tx 
Strm>Table Type is set to ATSC.

1 to 99
default: 2

Config>Service #>Video — Used to configure the TE6000A video. Note: for embedded audio, Config>Service # >Video>Input Source 
must be set to digital, Config>Service # >Audio must be set to digital, and Config>Service # >Audio>Source must be set to D1.

Enable setting determines whether or not video is included in the 
output transport stream

■ on – video is included in the output transport stream (default)
■ off – video is not include in the output transport stream

PID query-only; displays the video PID number included in the 
output transport stream

—

Input Source set the encoder input video source ■ digital
■ analog (default)
Note: for embedded audio, Config>Service # >Video>Input Source must be set to 
digital; Config>Service # >Audio must be set to digital, and Config>Service #> 
Audio>Source must be set to D1.

Format query-only; displays the analog video format ■ 525
■ 625
■ no video if there is no video input

Format Ctrl sets the video format mode when the input source is set 
to analog

■ auto – unit automatically senses incoming video signal format and configures the 
video mode to match (default)

■ PAL – 625 line PAL-N mode
■ NTSC – 525 line NTSC mode
■ NTSC 0SU – no pedestals NTS C0SU mode

TE6000A Front Panel Menu Descriptions  (continued)

Front Panel 
Command

Function Options/Response Format
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Resolution selects the picture resizing that the TE6000A performs 
prior to video encoding

720, 704, 544, 480, 352
default: 720

Additional Information: As shown in the following table, the number of lines depends upon whether the video format is set to NTSC or PAL. 

Resolution Encoding
Option NTSC Mode PAL-I Mode Type

AFF352 352 pixels by 480 lines 352 pixels by 576 lines MPEG–2

AFF480 480 pixels by 480 lines 480 pixels by 576 lines MPEG–2

AFF544 544 pixels by 480 lines 544 pixels by 576 lines MPEG–2

AFF704 704 pixels by 480 lines 704 pixels by 576 lines MPEG–2

AFF720 720 pixels by 480 lines 720 pixels by 576 lines MPEG–2
(default)  (full resolution video)

Data Rate sets the output compressed video bit rate for optimum 
video performance 
■ If the Tx Strm>Rate Calc is set to auto, this command 

is query only. 
■ If the Tx Strm>Rate Calc is set to manual, you set the 

data rate.

if chroma set to 4:2:0 – 1.0 to 15.0 Mbps
if chroma set to 4:2:2 – 2.5 to 50.0 Mbps
default: 
■ if analog: 7.443 Mbps
■ if digital: 8.0563 Mbps

Chroma sets the chrominance compression algorithm 4:2:0, 4:2:2

Aspect Ratio sets the picture aspect ratio which is the ratio of the frame 
width to the frame height

■ 4x3 (default)
■ 16x9

Optimize sets the selected optimization mode
Note: The custom parameter is for experienced users 
only. Changing custom optimization features requires 
advanced knowledge of MPEG compression theory and 
encoder commands, and, if set incorrectly, the video 
performance maybe adversely affected. It is 
recommended that users consult with Tiernan customer 
service before using the custom configuration.

■ quality – optimizes the video performance without regard for throughput delay time. 
Quality mode is appropriate for action video scenes such as sports material. 
(default)

■ low-buffer – compensates for undersized decoder buffers
■ low-delay – reduces the throughput time required to process a signal from the 

encoder input, through the compression process, and to the decoder output. In low 
delay mode, the overall delay through a TE6000A to an IRD is  180ms +/ - 40ms. In 
low delay mode, the compressed audio bit rate is automatically set to 256 Kbps. 
Low delay mode is appropriate for real time news interviews. 

■ edit – video compression uses only one frame (no prediction) which makes it easier 
to edit the compressed bit stream. Edit requires a higher data rate to achieve the 
video performance of quality mode.

■ custom – allows you to set site-specific video compression parameters, such as 
GOP structure and VBV size. These parameters must be initially set through a 
remote terminal and then saved using the remote CM SAVE command. Once 
saved through a remote terminal, this custom setup will persist until the video 
optimize setting is changed.
The custom parameter is for experienced users only. Changing custom optimization 
features requires advanced knowledge of MPEG compression theory and encoder 
commands, and, if set incorrectly, the video performance maybe adversely 
affected. It is recommended that users consult with Tiernan customer service 
before using a custom configuration.

Timebase sets the analog video timebase source
This parameter is available only when the video input 
source is set to analog.

■ video input – video input is used for the encoder timebase (default)
■ gen-lock – genlock input is used for the encoder timebase. Input video must be 

synchronized to Genlock input in order for this option to work properly.

Delay sets the compressed bit stream buffer delay which 
controls the time delay between the audio and video

-1000 to +1000 milliseconds
default: zero (0) msec
■ positive numbers cause the decoder to delay the audio output with respect to the 

video (i.e. lag).
■ negative numbers cause the decoder to advance the audio output with respect to 

the video (i.e. lead).
■ zero (0) represents nominal alignment between video and audio output from the 

decoder (i.e. lip sync). In addition, a zero lip sync value assumes that the video and 
audio has lip sync at the input of the encoder.

TE6000A Front Panel Menu Descriptions  (continued)

Front Panel 
Command

Function Options/Response Format
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Config>Service # >VBI>Teletext — used to configure the encoder to transmit teletext data
Note: Teletext should not be enable with other VBI encoding formats, as teletext overwrites all other VBI data.
Note: For additional information on Teletext, refer to the appendix on VBI Data Transmission.

Enable Configures the encoder to transmit teletext information ■ off – does not encode any teletext information (default)
■ all – encodes entire VBI teletext area; i.e., allocates bit-rate to include maximum 

number of Teletext lines
■ auto – automatically allocates bit-rate to include only the number of detected 

Teletext lines.

Data ID Setting determines is EBU data included in the Teletext. 
Values from 0x10 to 0x1F reflect EBU data. 

0 to 255
Default: 1

Data Unit ID Data Unit ID defines if there are EBU Teletext sub-titles 
included in the data. 

Data Unit ID has range from 0 to 255. Values are:
■ 2 = EBU Teletext non-subtitle data is not included (default)
■ 3 = EBU Teletext subtitle data is included 
Note: Data Unit ID must be set to 2 or 3 for proper decoder operation.

Config>Service # >VBI>CC — used to configure the encoder to transmit closed captioning information.
Note: Ensure that VBI>Teletext is disabled when closed captions are enabled, as teletext overwrites all other VBI data.
Note: For additional information on Closed Captions, refer to the appendix on VBI Data Transmission.

Tiernan CC configures the encoder to transmit Tiernan closed 
captioning information
The Tiernan CC transmission described in this document 
is Tiernan proprietary. Only Tiernan decoders 
accommodate the Tiernan CC feature described in this 
document:
Note: Tiernan CC should not be implemented in PAL 
mode, as the closed caption information will be decoded 
and placed on line 22 of the video.

■ on – encodes two lines of VBI information per frame (one per field) at the expense 
of losing two lines of active video (one per field)
The encoded picture is simply shifted up one line to include the last line of VBI and 
to exclude the last line of active video in each field. 

■ off – does not encode any VBI information (default)
Note: Data transmitted in the VBI region using the Tiernan CC command will 
experience a degradation in quality given the inherently “lossy” compression of MPEG.

ATSC CC configures the encoder to transmit ATSC closed 
captioning information

■ on – encodes ATSC VBI information
■ off – does not encode any ATSC VBI information (default)

Config>Service # >VBI>Expand — used to configure the encoder to transmit data in 16-line or 32-line expanded windows mode.
Note: Ensure that both VBI teletext and closed captions are disable when either 16- or 32-line expanded windows are enabled, as 
teletext and closed captions overwrite expanded windows data. 
Note: Chroma must be set to 4:2:2 for proper expanded windows operations.
Note: For additional information on Expanded Windows, refer to the appendix on VBI Data Transmission.

VBI_Passthru Configures the encoder to transmit either 16 or 32 lines of 
VBI information 

■ Off – disables expanded windows mode (default)
■ 16-line – enables 16-line expanded windows mode
■ 32-line – enables 16-line expanded windows mode

Config>Service # >Audio — Used to configure the TE6000A audio. Once you have selected the audio transmission as Digital or 
Analog, you select which audio channel (or slot) to configure. Digital channels are Slot 4A and Slot 4B. Analog channels are Slot 1A 
and Slot 1B. 
Note: for embedded audio, Config>Service # >Video>Input Source must be set to digital; Config>Service # >Audio must be set to 
digital, and Config>Service # >Audio>Source must be set to D1.

Enable setting determines whether or not audio is included in the 
output transport stream

■ on – audio from that channel is included in the output transport stream (default)
■ off – audio from that channel is not include in the output transport stream
default:
■ if digital audio: off
■ if analog audio: on

PID query-only; displays the audio PID number included in the 
output transport stream

—

Compression sets the output compression format for the audio stream MPEG
default: MPEG

Source sets the source of the audio ■ If digital audio: AESEBU, D1 (embedded audio)
■ If analog audio: analog
Note: for embedded audio, Config>Service # >Video>Input Source must be set to 
digital; Config>Service # >Audio must be set to digital, and Config>Service # 
>Audio>Source must be set to D1.
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Data Rate sets the audio compression bit rate
Additional Information: Selecting a high audio 
compressed bit rate will produce a high-quality audio 
signal at the output audio device; however, a high audio 
compressed bit rate reduces the total transport stream bit 
rate available for the video signal. An audio compressed 
bit rate should be selected that meets the audio 
requirements while allowing sufficient bandwidth to meet 
the video requirements.

■ If compression set to MPEG or ATSC: 64, 128, 192, 256, 384 Kbps
■ If compression set to none: 1 to 4096000 bps
default: 256 Kbps

Sample Rate determines how often the TE6000A samples the analog 
waveform during the audio analog to digital conversion 
process.
Additional Information: Selecting a high audio sample 
rate will produce a high-quality audio signal at the output 
audio device; however, a high audio sample rate reduces 
the total transport stream bit rate available for the video 
signal. An audio sample rate should be selected that 
meets the audio requirements while allowing sufficient 
bandwidth to meet the video requirements.

32, 44.1, 48 KHz
default: 48 KHz

Data Resolution query-only; displays the number of bits per audio sample 16-bit, 20-bit, 24-bit

Format sets the audio compression format which determines how 
the left and right channels of the audio input source are 
compressed

■ Stereo – left and right audio channels are compressed separately into two output 
waveforms. Stereo uses more bandwidth than mono; however, if the input audio 
source is stereo, the stereo effect will appear at the output audio device.

■ Dual Mono – the left and right audio channels are compressed separately into two 
output waveforms. This option uses more bandwidth than mono, however, use this 
option when the left and right audio channel inputs represent separate and 
independent audio signals.

■ Joint Stereo – the left and right audio channels are compressed jointly into two 
output waveforms. This option uses more bandwidth than mono but less than the 
stereo and dual mono options. Use this option when the left and right audio channel 
inputs are highly correlated (i.e., left and right stereo channels of one audio 
program source). The TE6000A uses the similarities between the two channels to 
save bandwidth without losing the stereo effect at the output audio device.

■ Mono – during audio compression the TE6000A ignores the right audio channel 
input and produces a single output waveform based on the left channel input. This 
option saves bandwidth; however, if the input audio source is stereo, the stereo 
effect at the output audio device will be lost.

default: stereo

Delay sets the compressed audio bit stream buffer delay, which 
controls the time delay between the audio and video

-1000 to +1000 milliseconds
default: zero (0) msec
■ Positive numbers cause the decoder to delay the audio output with respect to the 

video (i.e. lag).
■ Negative numbers cause the decoder to advance the audio output with respect to 

the video (i.e. lead).
■ Zero (0) represents nominal alignment between video and audio output from the 

decoder (i.e. lip sync). In addition, a zero lip sync value assumes that the video and 
audio has lip sync at the input of the encoder.

Language Sets the audio language descriptor for the selected 
service.

English, French, German, Italian, Japanese, Korean, Portuguese, Serbian, Spanish, 
Chinese, Danish, and Dutch.

D1 Audio Chnl Pair selects one of the eight embedded audio channel pairs 
associated with the digital audio input
Note: D1 Audio Chnl Pair is only available when digital 
audio channels are selected.

■ 1 through 8
default: 1

Config>Service # >Data — Used to configure the TE6000A auxiliary data. The Data menu has two data channels, A and B. Both data 
channels have identical parameters and options that are used to configure the auxiliary data ports.

Enable setting determines whether or not auxiliary data is 
included in the output transport stream

■ on – auxiliary data is included in the output transport stream
■ off – disables the port and does not include auxiliary data in the output transport 

stream (default)

PID query-only; displays the data PID number included in the 
output transport stream

—
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Comm Mode selects the data communication mode; the following 
options display when Comm Mode is set to:
■ Asynchronous:

• interface
• baud
• data bits
• parity
• stop bits

■ Synchronous:
• interface
• data rate
• clock source

■ asynchronous – sets the data communication mode to asynchronous (default)
■ synchronous – sets the data communication mode to synchronous

Interface sets the configuration for the auxiliary data ports; 
dependent upon the Comm Mode setting

■ When Comm Mode is set to asynchronous, the interface options are RS-232 
(default) and RS-422.

■ When Comm Mode is set to synchronous, the interface command is query-only and 
displays the synchronous interface RS-422

Baud sets the baud rate for the asynchronous auxiliary data 
channel
Note: Baud is only available when Service>Data>Comm 
Mode is set to asynchronous.

1200, 2400, 4800, 9600, 19200, 38400 bps
default: 38400 bps

Data Width sets the character length for the asynchronous auxiliary 
data channel
Note: Data Bits is only available when 
Service>Data>Comm Mode is set to asynchronous.

7, 8
default: 8

Parity sets the parity for the asynchronous auxiliary data 
channel
Note: Parity is only available when Service>Data>Comm 
Mode is set to asynchronous.

none, even, odd
default: none

Stop Bits sets the number of stop bits for the asynchronous 
auxiliary data channel
Note: Stop Bits is only available when 
Service>Data>Comm Mode is set to asynchronous.

1, 2
default: 1

Data Rate sets the number of data bits for the synchronous auxiliary 
data channel
Note: Data Rate is only available when 
Service>Data>Comm Mode is set to synchronous.

1 to 4096000 bps
default:1024000 bps
Additional Information: The data rate for the auxiliary data channel reduces the total 
transport stream bit rate available for the video signal; therefore, an auxiliary data rate 
should be selected that meets but does not exceed the site-specific operational 
requirements.

Clock Source sets the clock source for the synchronous auxiliary data 
channel
Note: Clock Source is only available when 
Service>Data>Comm Mode is set to synchronous.

■ internal – uses ST to latch the data (default)
■ external – uses TT to latch the data

Additional Information: Clock Source allows you to select either an Internal (ST) or an External (TT) clock to latch the input auxiliary data (SD). 
There are three different ways to configure the clock sources for the TE6000A and a DTE. The following table lists these different configurations 
along with the circumstances under which each is used.
■ The first option will produce the most reliable auxiliary data. 
■ You should use the last option only if you are unable to configure your DTE for either of the first two options.

Circumstance For Use TE6000A Data TE6000A Clock DTE Clock DTE Clock
Clock Source Used to Source Sent to 
Configuration Latch Data Configuration TE6000A on TT

Option 1: DTE is able to  Internal TT External ST
turn around ST and provide
ST back to the TE6000A as TT.
Option 2: DTE is not able to External TT Internal Internal
turn around ST, but has an 
internal clock that can be 
provided to the TE6000A as TT.
Option 3: DTE is not able to Internal ST External None
turn around ST and does not
have an internal clock to 
provide to the TE6000A as TT.
For more information on configuring the auxiliary data channel clock source, refer to the chapter on installing the TE6000A.
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Config>Service # >PCR — Used to set the program clock reference parameters

PID query-only; displays the PCR PID number i —

Delay used to compensate for decoder buffering issues -1000 to +1000 milliseconds
default: zero (0) msec
■ If the decoder’s buffer overflow, increase the PCR delay
■ If the decoders buffer underflow, decrease the PCR delay

Transmit Rate sets the transmit rate of the PCR packet 0 to 100 Hz

Config>Tx Strm Menu — Enables you to set and query the TE6000A transport stream system configuration parameters. The 
configuration parameters set at this level impact which options and configuration parameters are available on other menus.

Rate Calc selects how the encoder determines the allocation of data 
bit rates for the various transport stream components 
including audio, video, and auxiliary data bit rates

■ auto-video – the TE6000A determines and sets the video bit rate automatically 
(default)

■ manual – you must manually calculate and then set the data bit rates for video, 
audio, and auxiliary data

Additional Information: When Rate Calc is set to Auto, the video bit rate setting is 
inversely proportional to the audio and user data bit rates; that is:
■ if the audio and user data bit rates are high, a smaller portion of the transport 

stream bit rate can be allotted to the video bit rate
■ if the audio and user data bit rates are low, a larger portion of the transport stream 

bit rate can be allotted to the video bit rate

Channel Mode sets the TE6000A to work in an SCPC, MCPC, 
redundant, or PSIP mode

■ SCPC – single-channel-per-carrier (default)
■ MCPC – multiple-channels-per-carrier 
■ redundant – places the TE6000A in a redundant state; used when a system is 

operating in a redundant, or protected, setup.
■ PSIP – for use with a PSIP generator; sets the encoder to PSIP mode

Redund State sets the operating state of the spare encoder in a 
redundant system 
Note: Redund State is only available when Tx 
Strm>Channel Mode is set to Redundant.

■ standby – spare encoder is in an inactive state and will not begin operations in the 
event of a primary encoder failure

■ armed – sets the spare encoder to begin operations in the event that a primary 
encoder fails

■ triggered – this state cannot be set; it is entered into automatically, from the Armed 
state, when the loss of an external service is detected.

Table Type sets the type of PSI/SI tables to be provided ■ DVB (default)
■ ATSC – provides ATSC tables in the transport stream

The fixed ATSC tables output by the THE1 are VCT, MGT, STT, RRT and EIT. RRT 
and EIT tables are dynamically updated by an external PSIP generator.

■ MPEG – provides MPEG tables in the transport stream
■ None – no tables are provided

Ext TS Enable Setting determines whether or not the externally-
generated input is included in the transport stream.
Note: Ext TS Enable is only available when 
Tx Strm>Mode is set to MCPC.

■ enable – includes the externally generated input in the transport stream (default)
■ disable – does not include the externally generated input in the transport stream

Ext TS Status query-only; displays the status of the externally-generated 
transport stream
Note: Ext TS Status is only available when 
Tx Strm>Mode is set to MCPC.

■ absent
■ locked

ExtRate sets the input rate of the externally-generated transport 
stream.
Note: ExtRate is only available when Tx Strm>Mode is 
set to MCPC.

0.000000 to 4294.967295 Mbps

Loc TS Enable setting determines whether or not the locally generated 
input is included in the transport stream.
Note: Loc TS Enable is only available when 
Tx Strm>Mode is set to MCPC.

■ enable (default)
■ disable

Loc TS Status query-only; displays the status of the locally generated 
transport stream
Note: Loc TS Status is only available when 
Tx Strm>Mode is set to MCPC.

■ locked
■ unlocked
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LocRate sets the default rate for the locally generated transport 
stream
Note: LocRate is only available when Tx Strm>Mode is 
set to MCPC.

1 to 70 Mbps
default: 8.448 Mbps

Config>CA menu — Conditional access (CA) is a method for securing and scrambling transmission streams so that only those 
decoders which are authorized to do so can receive the transmitted streams. The TE6000A provides two methods for conditional 
access: 
■ BISS – Basic Interoperable Scrambling System, an industry-standard, conditional access scheme used to secure and scramble 

DSNG broadcasts while allowing full operability between various vendor’s DSNG equipment. 
■ PGCA – a Tiernan-proprietary conditional access scheme used to secure and scramble transmission streams within the Tiernan 

family of products. 
Note: For additional information on BISS or PGCA configuration, refer to the appendix on Conditional Access.

Config>CA>Setup — Enables you to select a service, select the type of conditional access scrambling method to be enabled, and to 
define the conditional access key. 

Service displays the individual services that can be enabled or 
disabled for conditional access
If only one service is available, the service parameter is 
query-only, as this one service is automatically selected.

— 

Config>CA>Setup>Service>Scramble — Used to set the type of conditional access scrambling method for a selected service and to 
define the conditional access key. 

None no scrambling is enabled — 

PGCA enables and disables PGCA at a system level; when 
selected, this setting ensures that only those Tiernan 
decoders listed in the PGCA database and enabled at an 
individual level can receive the broadcast signals.
Non-Tiernan IRDs cannot be authorized by PGCA; 
therefore only authorized Tiernan IRDs can decode 
a service that has been protected through PGCA.

■ PGCA key – sets the PGCA scrambling key to a specified algorithmic table. 
Parameters are 0 to 255.

■ PGCA message PID – query-only; displays the PID for the program map table 
(PMT).

BISS Mode 1 enables BISS Mode 1 for the selected service. With BISS 
Mode 1, all components of the transmission stream are 
scrambled by a fixed control word (CW).

■ BISS key: sets the BISS scrambling key, which is a 12-digit scrambling key, for the 
selected service.

Config>CA>PGCAcfg — The three PGCA configuration menus allow you to modify the PGCA database, enable and disable 
individual Tiernan IRDs for PGCA, and review the PGCA database. 
For additional information on adding, deleting and authorizing individual decoders, refer to the appendix on Conditional Access.

Add IRD adds a Tiernan decoder to the PGCA database. 
Note: Non-Tiernan IRDs cannot be added to the decoder 
database.

to determine the Tiernan decoder’s MAC address, refer to the appropriate Tiernan user 
guide which accompanied that product.

Lst IRD used to enable and disable individual IRDs for conditional 
access. 

displays a list of all Tiernan decoders entered in the PGCA database. Each decoder’s 
MAC address, and its enabled/disabled status is also displayed
To enable and disable an IRD, use the minus key on the alphanumeric keypad to 
toggle between the On (enable) and Off (disable) parameters for the selected IRD.

Del IRD deletes a Tiernan decoder from the conditional access 
database.

displays a list of Tiernan decoders and their MAC addresses

Control Menu — The Control menu allows you to control the TE6000A hardware. The Control submenus are Reset, Clock, Display, 
and FP Lock.

Control>Reset — Used to reset the TE6000A to the last-saved configuration set. When a reset is performed, the TE6000A reloads all 
programmable logic and firmware, restarts the unit, and clears the fault history log. 

press Enter to reset resets the TE6000A to the last configuration set; reloads 
all programmable logic and firmware; restarts the unit; 
and clears the fault history log
Additional Information: As an aid to troubleshooting, the 
fault history log should be reviewed and recorded before 
resetting or turning the TE6000A power off.

returns to main menu after reset
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Control>Clock>Date — used to set the date and time

Date sets the date
If the date is entered incorrectly, or an out-of-range value 
is entered, the TE6000A will display and continue to use 
the previously set date.

mm/dd/yyyy
default: 00.00.0000

Time sets the time
The hours are in a 24-hour format and must be set from 
00 to 23, where 00 is midnight and 23 is 11 PM. Both 
minutes and seconds can be set from 00 to 59.

hh.mm.ss
default: 00:00:00

Control>FP Lock — Used to lock and unlock the front panel

State sets the state of the front panel ■ locked – disables the front panel; the front panel can only be used to view status 
and configuration parameters

■ unlocked – the front panel is unlocked and can be used to enter and change 
configuration parameters (default)

Password unlocks the front panel; used in conjunction with the state 
command; password is only displayed when the front 
panel is set to locked

7384 (default)
Note: ensure that the front panel displays 7384, not alphabetic characters when using 
the default password to unlock the front panel

Config>Comm — The Communications menu is used to set remote control and network features; submenus include Serial and 
Network.

Comm>Serial — Used to configure the remote control port

Baud sets the asynchronous interface baud rate for the remote 
port

1200, 2400, 4800, 9600, 19200, 38400 bps
default: 38400 bps

Data Bits sets the number of data bits for the remote port 7, 8
default: 8

Parity sets the parity for the remote port none, even, odd
default: none

Stop Bits sets the number of stop bits for the remote control port 1, 2
default: 1

Flow Control sets the remote control port flow control ■ soft: software XON/XOFF (default)
■ hard: hardware RTS/CTS

Comm>Network — Used to enter the network address of the TE6000A

IP Addr sets the IP address user defined
default: 0.0.0.0

IP Mask query-only; displays the IP mask
This parameter can be set using a remote terminal and 
the appropriate remote command.

text string
default: 225.225.0.0

IP Router query-only; displays the IP router address
This parameter can be set using a remote terminal and 
the appropriate remote command.

text string
default: 0.0.0.0

TMA query-only; displays the TE6000A network address text string

Status Menu — Used to view current faults and fault history log; clear the fault history log and fault relay

Current queries the current faults log displays current faults

History queries and clears the fault history log ■ list – displays fault history log; faults are time stamped
■ clear – clears the fault history log; after faults are cleared, the LCD displays the 

Status>History menu
Note: Clearing the fault history log does not clear the fault relay.

Relay queries and clears the fault relay ■ list – displays faults which caused the fault relay to trip; faults are time stamped
■ clear – clears the fault relay log; after faults are cleared, the LCD displays the 

Status>Relay menu
Note: Clearing the fault relay does not clear the fault history log.

Version Menu — Used to display the version of firmware and hardware currently in use on the TE6000A

Firmware queries the version of firmware currently in use on the 
TE6000A

firmware version labels
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TE6000A Procedures This section provides detailed steps for performing various TE6000A tasks.

Note: Before you begin the initial TE6000A installation and configuration, the 
modulator output (Mod State) should be turned off until you are ready to begin 
satellite transmissions.

Configuration Sets Restoring a Default or User Configuration
To restore a default or user configuration set:
1. From the main menu, select Config. The Configuration menu displays.
2. Select Presets. The Preset menu displays.
3. Select Restore. The Restore menu displays.
4. Use the Up or Down buttons to select the appropriate option and press Enter. 

The system will perform its initialization process and reconfigure the 
TE6000A with the selected parameters. 
The reconfiguration process may take one to two minutes. When the system 
has completed its configuration process, the LCD returns to the main menu.

The operating parameters in use at the time the restore process is executed are overwritten and will 
be lost if not previously saved as a configuration set.

Creating a New User Configuration Label
To create a new user-defined configuration label:
1. Select Config from the main menu. The Configuration menu displays.
2. Select Presets. The Preset menu displays.
3. Select New. The New Preset menu and its option Enter Name = 0 

displays. The zero is replaced with the first alpha-numeric key press.
4. Using the alpha-numeric keypad, enter a name for the configuration set. The 

name can be up to 15 characters in length. 
5. Press Enter. The new label is added to the configuration list and the system 

returns to the Presets menu. 
6. To save a configuration set under this label, follow the steps under Saving a 

User Configuration Under an Existing Label.

Saving a User Configuration Under an Existing Label
To save a user-defined configuration set under an existing label:
1. Configure the TE6000A with the required parameters.
2. Once all parameters are correctly set, select Config from the main menu. The 

Configuration menu displays.
3. Select Presets. The Preset menu displays.
4. Select Save. The Save menu displays. 
5. Use the Up or Down buttons to scroll through the list and select the correct 

configuration label.
6. Press Enter. The configuration process may take one to two minutes. When 

the system has completed its configuration process, the asterisk will 
disappear.

Any configuration parameters previously stored under the selected label will be overwritten once the 
save process is executed. 

NOTE

NOTE

NOTE
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Deleting a User Configuration Label
To delete a user-defined configuration label:
1. From the main menu, select Config. The Configuration menu displays.
2. Select Presets. The Preset menu displays.
3. Select Delete. The Delete menu displays. 
4. Scroll through the list and select the label that will be deleted.
5. Press Enter. The label is deleted from the configuration list and the system 

returns to the Presets menu.

Renaming a User Configuration Label
To rename an existing user-defined configuration label:
1. From the main menu, select Config. The Configuration menu displays.
2. Select Presets. The Preset menu displays.
3. Select Rename. The Rename menu displays. 
4. Scroll through the list and select the label that will be renamed.
5. Press Enter. The name of the label to be renamed displays and a zero appears 

in the label entry field. 
The zero is replaced with the first alpha-numeric key press.

6. Using the alpha-numeric keypad, enter a name for the configuration set. The 
name can be up to 15 characters in length. 

7. Press Enter. The new label is added to the configuration list and the system 
returns to the Rename menu. 

ATSC PSIP Mode Operating in ATSC PSIP Mode
To operate in ATSC PSIP mode, perform the following steps:
1. Connect a PSIP generator to the encoder. 

If a series of encoders are chained, connect the PSIP generator to the first 
encoder in the chain.

2. Set the table type to MPEG. 
Select Config>Tx Strm>Table Type>MPEG from the front panel or enter 
TAB TYPE MPEG from a remote unit.
If chaining encoders, set the table type for all encoders to MPEG. 

3. Set the control mode to Manual. 
Select Config>Tx Strm>Rate Calc>Manual from the front panel, or 
enter MUX CM PSIP from a remote unit.
If chaining encoders, set the control mode to PSIP on only the first encoder. 
All other encoders should be set to MCPC.

4. On the encoder connected to the PSIP generator, set the local rate equal to the 
Output rate minus 10,000 bps (locrate = outrate - 10,000). A stable picture 
should appear. 
Select Config>Tx Strm>LocRate> <rate> from the front panel, or 
enter MUX LOC_RATE <rate> from a remote terminal
If a stable picture does not display, decrease the local rate until a stable picture 
does appears. 

When the encoder is reconfigured from manual mode to another mux configuration mode, the 
encoder automatically sets the out rate to the local rate. In this case, you should review the new 
out rate parameter and reset it as required for your configuration. NOTE
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Front Panel Lock Locking the Front Panel
To lock the front panel:
1. From the main menu, select Config. The Configuration menu displays.
2. Select Control. The Control menu displays. 
3. Select FP Lock. The status State = Unlocked displays.
4. Press the Up button once. State = Locked displays.
5. Press Enter. State = Locked displays indicating that the front panel is 

now locked.

Unlocking the Front Panel
To unlock the front panel:
1. From the main menu, select Config. The Configuration menu displays.
2. Select Control. The Control menu displays.
3. Select FP Lock. The status State = Locked displays.
4. Press the Left or Right button once. Password = 0 displays.
5. Using the front panel keypad, type in the password and press Enter. The 

default password is 7384.
6. The front panel displays State = Unlocked indicating that the front panel 

is now unlocked.

If the wrong password is entered, the TE6000A displays Password = 0. If this occurs, use the 
front panel keypad to type in the correct password and press Enter.

Data and Time Setting the Date
To set the date:
1. From the main menu, select Config. The Configuration menu displays. 
2. Select Control. The Control menu displays. 
3. Select Clock. The Date parameter displays.
4. Use the keypad to type in the correct date in the format mm/dd/yyyy. The 

TE6000A automatically enters the / for you.
5. Press the Enter button.

If the date is entered incorrectly, or an out-of-range value is entered, the TE6000A 
will display and continue to use the previously set date.

Setting the Time
The hours are in a 24-hour format and must be set from 00 to 23, where 00 is 
midnight and 23 is 11 PM. For example, for 8 AM you would set the hours to 08, 
and for 8 PM you would set the hours to 20. Both minutes and seconds can be set 
from 00 to 59. To set the time:
1. From the main menu, select Config. The Configuration menu displays.
2. Select Control. The Control menu displays.
3. Select Clock. The Date parameter displays.
4. Scroll to the Time parameter using the right or left buttons.
5. Use the keypad to type in the correct hour, minutes, and seconds in the format 

hh:mm:ss. The TE6000A automatically enters the colons (:) for you.
6. Press the Enter button.

NOTE
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System Reset To reset the TE6000A:
1. From the main menu, select Config. The Configuration menu displays.
2. Select Control. The Control menu displays.
3. Select Reset.
4. Press the Enter key.

The TE6000A is reset to the last configuration set; all programmable logic 
and firmware is reloaded; the unit is restarted; and the fault history log is 
cleared.

Embedded Audio
Configuration

Configuring the Encoder for Embedded Audio
To configure the encoder for embedded audio, the following parameters must be 
set:

■ Config>Service # >Video>Input Source must be set to digital
■ Config>Service # >Audio must be set to digital
■ Config>Service # >Audio>Source must be set to D1

Conditional Access:
BISS and PGCA

For information on configuring the TE6000A for BISS or PGCA conditional 
access, refer to the appendix on conditional access.

VBI: Teletext, Closed
Captions, and

Expanded Windows

For information on configuring the TE6000A for teletext, closed captions, or 
expanded windows VBI operations, refer to the appendix on VBI data 
transmission.
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4Using a Remote Unit

In addition to the front panel, a remote unit can be used to configure and monitor 
the TE6000A. The chapter presents the following information for remote 
command operation:

■ Configuring remote software parameters
■ An overview of remote communications
■ Instructions for issuing remote commands
■ Front panel lockout
■ Error messages
■ Remote command listing

For remote control cabling information, refer to Chapter 2.

Any parameter changes made using a remote unit are not automatically stored in flash memory. 
When the TE6000A configuration is changed using a remote unit, an operational test should be 
performed to verify that the system is operating correctly. Then the new configuration should be 
saved by issuing the CM SAVE command. 

If the TE6000A is reset prior to issuing the CM SAVE command, any changes made using the 
remote unit will not be restored. Instead, the TE6000A restores the last changes saved to flash 
memory. Once the configuration is saved using the CM SAVE command, the TE6000A 
automatically restores the saved settings when the unit is reset or powered up.

Configuring the
Remote Control

Software Parameters

After you have cabled the remote unit to the TE6000A, perform the following 
steps to complete your installation:
1. Configure the communications software parameters of your remote unit to 

match the following TE6000A remote control port DVB default settings:
❒ RS-232 signal
❒ Baud rate = 38400 bps
❒ Character length = 8
❒ Parity = none
❒ Number of stop bits = 1
Unless you change the remote control settings and save the changes in 
non-volatile (flash) memory, the TE6000A restores these default 
communications settings whenever the TE6000A is reset or powered-up. 

2. Press the Enter key on the remote keyboard several times to generate a prompt 
(>) on the remote display. Once a prompt appears on the remote display, 
successful communication has been established between the TE6000A and 
the remote unit.
Once communications are established, the remote port parameters can be 
changed to a faster operating speed. 

■ If you are unable to generate a prompt on the remote unit, follow these 
troubleshooting steps:

■ Ensure that the remote unit and the TE6000A are turned on and plugged into 
an active AC outlet.

NOTE
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■ Verify that the baud rate and parity of the remote unit communications 
package match the DVB setting of the TE6000A remote control interface. 
DVB settings are 38400 baud, 8 data, noparity. 

■ Verify that the cable between the terminal, the TE6000A, and the Null 
Modem Adapter are properly connected. 

■ Ensure that the DTE/DCE switch is set to the DTE position
■ If you need assistance, contact Tiernan Customer Service. 

Ethernet Port After you have cabled the TE6000A to a network through the TE6000A Ethernet 
port, perform the following steps to establish remote communications using 
Windows Telnet:

More sophisticated applications are available that allow you to view commands and responses more 
easily.

1. From a remote unit, launch Telnet by typing TELNET at the command 
prompt. 
To access the command prompt, select the MS-DOS Prompt.

2. From the Connect menu, select Remote System. The Remote System dialog 
box appears.

3. At the Host Name or IP Address option, type the TE6000A IP address. For the 
procedure used to assign an IP Address, refer to the installation chapter.

4. For Port Type enter 21846 or 0x5556 (hex).

Do not select “Telnet.” If you select “Telnet,” the program will attempt to log you into the device 
operating system.

5. For Terminal Type, accept the default.
6. Click the Connect button. You should now be connected.
7. If connection is not successful, troubleshoot the installation and setup:

❒ Ensure that the TE6000A is turned on and plugged into an active AC 
outlet.

❒ Verify that the cable between the terminal and the TE6000A is properly 
connected.

❒ In Telnet, verify that the correct IP address and port type have been 
selected.

❒ Check with the Information Systems to determine if problems exist with 
the LAN.

❒ If you need assistance, contact Tiernan Customer Service.

Remote
Communications

Overview

The TE6000A can be configured, monitored, and control from a remote unit. 
Unlike front panel operations, the remote unit has no selection menus; instead, 
you use the remote terminal to type specific commands and parameters in order to 
communicate with the TE6000A.
All TE6000A commands can be issued from a remote unit that is connected to the 
TE6000A remote control port. The remote unit might be an ASCII terminal, a 
personal computer, or any other remote unit capable of asynchronous 
communications. The TE6000A supports ASCII protocol for remote 
communications. 

NOTE
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Command Types The remote unit accepts two different types of commands: 
■ Execute commands direct the TE6000A to perform a specified action, such as 

changing a configuration parameter.
■ Query commands direct the TE6000A to display the current setting of a 

specific parameter or to display current status information.
All commands consists of a command mnemonic, which is followed by a space, 
and the command instruction. 

The TE6000A uses the following command mnemonics to group various 
commands:

Execute commands have an additional parameter which follows the command 
instruction. 

Issuing Remote
Commands

To issue a command from a remote unit, type the command at the remote prompt 
(>) with the appropriate parameter, and then press the ENTER key. The following 
syntax is used:

<command> <parameter>
where 

■ <command> consists of its mnemonic and the instruction; ensure that the 
command is typed correctly and includes spaces and underscore (_) characters 
as appropriate

■ There must be one space between the command and the parameter. A space is 
typed by pressing the Space Bar key.

■ <parameter> is the value pertaining to the command. Parameters can be 
numeric or alphanumeric. No spaces should be typed after the parameter; 
doing so will result in an error.

The TE6000A performs the required function and displays the prompt (>) when it 
is ready to accept another command.
For example, to set the remote port baud rate to 1200 bps, issue the command 
MC BAUD 1200 and press Enter. In this example:

■ The command mnemonic is MC followed by a space
■ The command instruction is BAUD followed by a space
■ The parameter is 1200

■ AE – audio encoder ■ MUX – multiplexer 
■ AXD – auxiliary data ■ TAB – table 
■ CM – configuration management ■ TCA – Tiernan conditional access 
■ FM – fault monitor ■ VE – video encoder 
■ MC – monitor and control ■ VI – video input 
■ MOD – modulator 

MC       BAUD

mnemonic instruction} }Command = {

MC        BAUD     1200

mnemonic instruction

}Command = { parameter}}
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Query commands are issued by typing the command, without a parameter, and 
pressing Enter. The TE6000A responds to the query by displaying information on 
the remote display.
For example, to query the remote port baud rate, issue the command MC BAUD 
and press Enter. In this example:

■ The command mnemonic is MC followed by a space
■ The command instruction is BAUD followed by a space
■ There is no parameter since this is a query command

The TE6000A responds by displaying the baud rate on the remote unit. 

Command Designators – Slot and Port 
The analog video and audio, digital video and audio, and auxiliary data commands 
contain additional command designators which enable you to configure a specific 
port. The command designators, shown on the TE6000A rear panel, are:

■ Analog video input – .1 (slot 1, no port designator is needed, as there is only 
one video input in slot 1)

■ Analog audio right and left – .1.A (slot 1, analog audio A)
■ Analog audio right and left – .1.B (slot 1, analog audio B)
■ Aux data – .3.A (slot 3, data A)
■ Aux data – .3.B (slot 3, data B)
■ Serial digital video input – .4 (slot 4, no port designator is needed, as there is 

only one video input in slot 4)
■ Serial digital audio – .4.A (slot 4, digital audio A)
■ Serial digital audio – .4.B (slot 4, digital audio B)

Designators are typed within the command and are separated by periods (.), for 
example:
<command mnemonic>.<slot>.<port> <command instruction> <parameter>
For example:

■ All audio encoder commands begin with the command mnemonic AE, and 
they contain the <slot> and <port> designators which allow you to select 
which audio port to configure or monitor. All audio encoder commands are 
typed in the following format:
<AE>.<slot>.<port> <instruction> <parameter>

PUSH

HERE

ASI TS IN

PRI SEC
-310

ASI
TS OUT

ASI

TTX-6001 SMPTE

HERE
PUSH

HERE

PUSH
GENLOCK

A B

D1 VIDEO
IN OUT

AUDIO INPUT

TVIP-6001

GENLOCK

RIGHT
ANALOG AUDIO B

LEFT

HERE
PUSH

LEFT
ANALOG AUDIO A

RIGHT

6025VIDEO IN

TVIP-

TMOD-6000

FAULT RLYETHERNET DCE

DTE

RS-232AUX DATA BAUX DATA A

TX IF Out
ASI
In

VIDEO
LOOP-THRU

TENC-600X

4:2:0 OR 4:2:2
VIDEO COMPRESSOR

HERE
PUSH TMAC-6000

DVB /

Analog Audio A 
1A

Analog Audio B
1B

Aux Data
3A

Audio Input
4B

Aux Data
3B

Analog Video In 
1A

Audio Input
4A

D1 Video In
4A
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■ To set the compressed audio bit rate to 256Kbps for analog audio port A, 
issue the command AE.1.A BR 256 typed as follows:
AE.1.A <space> BR <space> 256

■ To include audio in the transport stream for both digital ports, issue the 
following two commands:

AE.4.A Enable On (enables serial digital audio)
AE.4.B Enable On (enables serial digital audio)

The response to a query command always includes the slot and port designator in 
the response, even if none is needed when issuing the query command. 

Typing Remote Commands
Remote commands are not case sensitive. Commands may be entered in lower 
case, upper case, or a combination of both.

Entering Remote Command Parameter Values
Some command parameters must be enter as a numeric value, which is 
represented by the pound sign <#>. If more than one pound sign is shown for a 
given parameter <###>, you must enter a number for each pound sign. When you 
issue a command containing a numeric value, do not type in the pound sign (#) 
nor the bracket <> signs; enter only the numerical value for the parameter.

Error Messages If the TE6000A is not able to execute a command, an error message will be 
returned, indicating the command was not completed. TE6000A error messages, 
along with the action required to resolve the error, are listed in the following table. 

command

AE .1.A  BR

slot and channel
designators,

followed by a space

parameter

256

}}
}

Error Message Explanation Action Required

ERROR:AMBIGUOUS_LOCAL_INST
ANCE

A designator, other than a slot designator, is required in order to 
set or query the command. 
For example, all audio commands require a port designator in 
order to correctly process a command.

Issue the command using the correct syntax, format, and 
parameter. 
Ensure that the appropriate designators are included in the 
command string.

ERROR:AMBIGUOUS_ SLOT A slot designator is required in order to set or query the command. 
For example, all audio and auxiliary data commands require a slot 
designator.

Issue the command using the correct syntax, format, and 
parameter. 
Ensure that the appropriate designators are included in the 
command string.

ERROR:BAD_NUMBER_ FORMAT The parameter number format is incorrect. 
For example, a hexadecimal value was entered when a decimal 
value is required.

Issue the command using the correct parameter format.

ERROR:BAD_RC_ INSTANCE The command mnemonic cannot be matched to a card installed in 
the product. 

Use the ‘?’ command to view the current card types.
Issue the command using the proper syntax and format.

ERROR:BAD_RESOURCE_ 
CONTROLLER_TYPE

The command mnemonic is incorrect. Use the ‘?’ command to view the current command mnemonics.
Issue the command using the proper syntax and format.
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In addition to the actions listed in the error messages table, you can also enter the 
following question mark (?) commands to receive additional information when 
errors are encountered or additional information is needed. 

Remote Command
Descriptions

All standard TE6000A remote commands are listed in alphabetical order in the 
following table, which provides the following information:

■ Remote commands and any command designators 
■ Parameter values or value range
■ Factory default value
■ Description of the command, including parameter definitions and the front 

panel command equivalent

Command designators and parameter values may be shown within brackets <>; these brackets are 
not typed when issuing commands. 

ERROR:COMMIT_ERROR While attempting to set a command, the TE6000A may have 
entered an inconsistent state and may have an integrity error. 

Reset the command to a known valid state. Then re-issue the 
new command. If the command still results in an error message, 
check the configuration of the unit and repeat the command. 
If the TE6000A still does not execute the command, reset the 
unit and attempt the command again. 
If the command cannot be executed, contact Tiernan Customer 
Service.

ERROR:CONFIGURABLE_ 
NOT_QUERYABLE

The command cannot be queried. The command may be set-only 
or an action. 

Review the lists of commands to ensure that a valid command 
was issued.

ERROR:CONFIGURABLE_ 
NOT_SETTABLE

The command cannot be set. The command may be query-only. Review the lists of commands to ensure that a valid command 
was issued.

ERROR:EXPECTED_END_ OF_LINE The command line contains too much information. 
The command may have been issued with extra characters or a 
space after the parameter.

Issue the command using the correct syntax, format, and 
parameter.

ERROR:INVALID_ MNEMONIC The issued command does not match any valid TE6000A 
command.
The command may have been issued with extra characters, a 
missing underscore, a missing space, a space after the parameter, 
or in an improper order.

Issue the command using the proper syntax and format.

ERROR:INVALID_VALUE The TE6000A rejected a request to change a configurable value 
based upon its own logic. 
This value is also returned to indicate that the change was 
attempted, detected to be in error, and then successfully reversed.
(This response is only valid if the attribute “Valid Values Depend 
on State” or equivalent flag is set.)

Issue the command using the correct parameter.

ERROR:STRING_TOO_ LONG The parameter’s length has been exceeded. Issue the command using the correct parameter.

ERROR:TOO_LARGE The parameter’s numeric value is too large. Issue the command using the correct parameter.

ERROR:TOO_SMALL The parameter’s numeric value is too small. Issue the command using the correct parameter.

Error Message Explanation Action Required

Remote Question Mark (?) Commands Response

? Lists all available command mnemonics associated with the 
current version of code installed on the TE6000A

<mnemonic>.<slot>.<port> ?
For example: AE.1.A ?

Lists all commands associated with that mnemonic

<mnemonic>.<slot>.<port> <instruction> ?
For example: AE.1.A BR ?

Lists information available for that particular command, including 
all valid parameters

NOTE
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TE6000A Remote Command Descriptions 

Remote Command Parameter Range Factory 
Default

Description

AE.<slot>.<port> BR 64, 128, 192, 256, 384 
Kbps

256 Kbps Sets the audio compressed bit rate. 
Note: Selecting a high audio compressed bit rate will produce a high-quality 
audio signal at the output audio device; however, a high audio compressed bit 
rate reduces the total transport stream bit rate available for the video signal. 
Select an audio compressed bit rate that meets the audio requirements while 
allowing sufficient bandwidth to meet the video requirements. 
Front panel command equivalent: Config>Service>Audio>Data Rate

AE.<slot>.<port> CHFMT Dual, Mono, Stereo, 
Jstereo

Stereo Compressed audio format ; determines how the TE6000A will compress the 
audio channels.
■ Dual – left and right audio channels are compressed separately into two 

output waveforms. Use dual when the left and right audio channel inputs 
represent separate and independent audio signals. 

■ Mono – during audio compression the right audio channel input is ignored 
and a single output waveform is produced based on the left channel input. 
Mono uses half the bit rate of dual; however, if the input audio source is 
stereo, the stereo effect at the output audio device will be lost. 

■ Stereo – left and right audio channels are compressed separately into two 
output waveforms. Stereo uses more bandwidth than mono; however, if the 
input audio source is stereo, the stereo effect will appear at the output audio 
device.

■ Jstereo – the left and right audio channels are compressed jointly into two 
output waveforms. Jstereo uses more bandwidth than mono but less than 
stereo and dual. Use Jstereo when the left and right audio channel inputs 
are highly correlated (i.e., left and right stereo channels of one audio 
program source). The similarities between the two channels are used, 
saving bandwidth without losing the stereo effect at the output device.

Front panel command equivalent: Config>Service>Audio>Format

AE.<slot>.<port> COMPRESS MPEG2, ATSC, None MPEG2 Sets the output compression format for the audio stream. 
Front panel command equivalent: Config>Service>Audio>Compression

AE.<slot>.<port> D1_CH_PAIR 1 to 8 1 Selects one of the eight embedded audio channel pairs associated with the 
digital audio input
Note: D1 Audio Chnl Pair is only available when digital audio channels are 
selected.
Front panel command equivalent: Config>Service>Audio>D1 Audio Chnl Pair

AE.<slot>.<port> DELAY -1000 to +1000 
milli-seconds 

0 (zero) Compressed audio stream time delay; enter a numeric value to adjust the 
audio presentation time stamp; affects the synchronization between the audio 
and video. 
Positive numbers cause the decoder to delay the audio output with respect to 
the video (i.e. lag). Negative numbers cause the decoder to advance the audio 
output with respect to the video (i.e. lead). Zero (0) represents nominal 
alignment between video and audio output from the decoder (i.e. lip sync). In 
addition, a zero value assumes that the video and audio has lip sync at the 
input of the encoder. 
Front panel command equivalent: Config>Service>Audio>Delay

AE.<slot>.<port> ENABLE Off, On If digital audio: 
Off

If analog audio: 
On

Enables or disables the audio channel in the transport stream. Parameters are: 
■ Off = audio is not included in the transport stream
■ On = audio is included in the transport stream. 
Front panel command equivalent: Config>Service>Audio>Enable

AE.<slot>.<port> LANGUAGE ENG, JPN, CHI, KOR, 
DAN, POR, DUT, RUS, 
GER, SPA, ITA, FRE, 

UND

ENG Sets the audio language descriptor for a selected audio channel. Parameters 
are: 
■ ENG (English) JPN (Japanese)
■ CHI (Chinese) KOR (Korean)
■ DAN (Danish) POR (Portuguese)
■ DUT (Dutch) RUS (Russian)
■ GER (German) SPA (Spanish)
■ ITA (Italian) FRE (French)
■ UND (undetermined)
Front panel command equivalent: Config>Service>Audio>Language

AE.<slot>.<port> PID — — Displays the audio PID number included in the output transport stream.
Front panel command equivalent: Config>Service>Audio>PID
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AE.<slot>.<port> SRATE 32, 44.1, 48 KSps 48 KSps Audio sample rate: determines how often the TE6000A samples the analog 
waveform during the audio analog to digital conversion process.
This command is query-only for digital audio input ports; it is both set and query 
for analog audio input ports.
Note: Selecting a high audio sample rate will produce a high-quality audio 
signal at the output audio device; however, a high audio sample rate reduces 
the total transport stream bit rate available for the video signal. An audio 
sample rate should be selected that meets the audio requirements while 
allowing sufficient bandwidth to meet the video requirements. 
Front panel command equivalent: Config>Service>Audio>Sample Rate

AE.<slot>.<port> SRC Analog, AESEBU, D1 — Sets the source of the audio. 
■ If digital audio: AESEBU, D1 (embedded audio)
■ If analog audio: analog
Note: for embedded audio, VE SRC must be set to digital; the digital audio slot 
must be enabled (AE.4.# Enable on), and AE SRC must be set to D1.
Front panel command equivalent: Config>Service>Audio>Source

AXD.<slot>.<port> BAUD 1200, 2400, 4800, 9600, 
19200, 38400 bps

38400 bps Sets the asynchronous serial communication baud rate. 
Front panel command equivalent: Config>Service>Data>Baud

AXD.<slot>.<port> DR 1200 to 4096000 bps 1024000 bps Sets the number of data bits for the synchronous auxiliary data channel. 
Note: The data rate for the auxiliary data channel reduces the total transport 
stream bit rate available for the video signal; therefore, an auxiliary data rate 
should be selected that meets but does not exceed the site-specific operational 
requirements.
AXD DR is only available when AXD Mode is set to sync. 
Front panel command equivalent: Config>Service>Data>Data Rate

AXD.<slot>.<port> EN Off, On Off Enables or disables the auxiliary data channel in the transport stream. 
Parameters are: 
■ Off = auxiliary data is not included in the transport stream
■ On = auxiliary data is included in the transport stream. 
Front panel command equivalent: Config>Service>Data>Enable

AXD.<slot>.<port> IF RS232, RS422 RS232 Sets the auxiliary data electrical interface. Parameters are: 
■ When AXD Mode is set to async, AXD IF options are RS-232 (default) and 

RS-422.
■ When AXD Mode is set to sync, this command is query-only and displays 

the synchronous interface RS-422 
Front panel command equivalent: Config>Service>Data>Interface

AXD.<slot>.<port> MODE Async, Sync Async Sets the data communication mode; parameters are: async = sets the data 
communication mode to asynchronous; sync = sets the data communication 
mode to synchronous. The following commands can be issued when 
AXD Mode is set to:
■ Async: AXD IF, AXD BAUD, AXD DATA, AXD PARITY, AXD STOP
■ Sync: AXD IF, AXD DR, AXD SRC 
Front panel command equivalent: Config>Service>Data>Comm Mode

AXD.<slot>.<port> PARITY N, O, E N Sets the parity bit for asynchronous serial communication. Parameters are: 
N = none, O = odd, E = even. 
Front panel command equivalent: Config>Service>Data>Parity

AXD.<slot>.<port> PID — — displays the data PID number included in the output transport stream.
Front panel command equivalent: Config>Service>Data>PID

AXD.<slot>.<port> SRC INT, EXT INT Sets the clock source for the synchronous auxiliary data channel; parameters 
are:
■ INT = internal, uses ST to latch the data
■ EXT = external, uses TT to latch the data
AXD SRC is only available when AXD Mode is set to sync. 
Front panel command equivalent: Config>Service>Data>Clock Source

AXD.<slot>.<port> STOP 1, 2 1 Sets the number of stop bits for the asynchronous serial protocol. 
Front panel command equivalent: Config>Service>Data>Stop Bits

AXD.<slot>.<port> WIDTH 7, 8 8 Sets the number of data bits for asynchronous serial communication. 
Front panel command equivalent: Config>Service>Data>Data Bits

TE6000A Remote Command Descriptions  (continued)
Remote Command Parameter Range Factory 

Default
Description
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CM CREATE <string> where string specifies a 
user-defined label

Creates a user-defined label under which a configuration set may be saved. 
The <string> parameter must be an alpha-numeric label of not more than 15 
characters. The string must begin with an alphabetic character. Up to 100 user 
configurations may be saved and recalled.
Front panel command equivalent: Config>Presets>New

CM DELETE <string> where string specifies a 
user-defined label

— Deletes the specified user-defined configuration.
Front panel command equivalent: Config>Presets>Delete

CM LIST — — Query-only; displays a list of all current configuration labels.
Front panel command equivalent: none

CM RENAME <old label>;<new label> where <old label> 
specifies the current 
user-defined label and 
<new label> defines the 
new label name

— Renames an existing label. 
Front panel command equivalent: Config>Presets>Rename

CM RESTORE <string>1 where string specifies a 
user-defined label or 

factory defined labels of 
DVB, ATSC

DVB Recalls one of the factory- or user-defined configuration sets from memory and 
saves it in flash memory as the current configuration (i.e., power-up or reset 
restores the configuration set). For example, to restore or load the 
configuration set labeled SD MCPC, issue the command CM LOAD CD MCPC 
Note: When the TE6000A is set to the DVB default setting, the remote port 
baud rate is set to 38400 bps. If the remote unit is set to communicate with the 
TE6000A at a baud rate other than 38400 bps, immediately after the DVB 
default command is issued, the remote unit will not be able to communicate 
with the TE6000A. To resolve this issue, the equivalent parameter in the 
software settings of the remote unit must be changed to 38400bps. However, 
the remote unit software settings must not be changed before issuing the DVB 
default command to the TE6000A, as the remote unit will not be able to 
communicate with the TE6000A. 
Front panel command equivalent: Config>Presets>Restore

CM SAVE 1 — — Saves the current configuration to flash memory. 
Front panel command equivalent: none

CM SAVE_CFG <string>1 where string specifies a 
user-defined label

— Saves the current configuration settings to the specified user-defined label. The 
user label must be created using the CM CREATE command prior to storing 
the configuration settings.
For example, to store the unit’s current configuration settings to the existing 
user configuration label SD MCPC, issue the command: 
CM SAVE_CFG SD MCPC.
Caution: Any configuration parameters previously saved under a specified 
label are overwritten and lost when a new configuration set is saved to the 
same location. 
Front panel command equivalent: Config>Presets>Save‘

FM CURR_LIST — — Query-only command; displays all current faults. 
Front panel command equivalent: Status>Current

FM LOG_CLR — — Clears the fault history log.
Note: Clearing the fault history log does not clear the fault relay. 
Front panel command equivalent: Status>History>Clear

FM LOG_LIST — — Query-only command; displays the fault history log with time stamps.
For a complete description of the fault history log, refer to the chapter on 
troubleshooting. 
Front panel command equivalent: Status>History>List

FM RELAY_CLR — — Clears the fault relay.
Note: Clearing the fault relay does not clear the fault history log. 
Front panel command equivalent: Status>Relay>Clear

FM RELAY_LIST — — Query-only command; displays a list of faults which trigger the fault relay. 
Front panel command equivalent: Status>Relay>List

MC BAUD 1200,2400, 4800, 9600, 
19200, 38400 bps

38400 bps Sets the asynchronous interface baud rate for the RS-232 remote control port 
configuration.
Note: The TE6000A and remote terminal baud rates must match in order for 
the remote terminal and TE6000A to communicate. Once the MC 
RS232_BAUD rate command is issued, the equivalent parameter in the remote 
unit software settings must be set to match the new baud rate. However, the 
remote unit software settings must not be changed before issuing the DVB 
default command to the TE6000A, as the remote unit will not be able to 
communicate with the TE6000A. 
Front panel command equivalent: Config>Comm>Serial>Baud

TE6000A Remote Command Descriptions  (continued)
Remote Command Parameter Range Factory 

Default
Description
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MC BITRT_CTL Auto, Manual Auto Video bit rate selection. Parameters are: Auto = automatically calculates the 
correct compressed video bit rate given other configured parameters. When in 
the Auto mode, you cannot change the video bit rate parameter using the 
VE.<port> BR command; Manual = allows you to manually set the compressed 
video bit rate.
Note: When MC BITRT_CTL is set to Auto, the video bit rate setting is 
inversely proportional to the audio and user data bit rates; that is:
■ if the audio and user data bit rates are high, a smaller portion of the 

transport stream bit rate can be allotted to the video bit rate
■ if the audio and user data bit rates are low, a larger portion of the transport 

stream bit rate can be allotted to the video bit rate 
Front panel command equivalent: Config>Tx Strm>Rate Calc

MC DATA 7, 8 8 Sets the number of data bits for the RS-232 remote control port configuration. 
Front panel command equivalent: Config>Comm>Serial>Data Bits

MC DATE mm/dd/yyyy numeric value in the 
format: mm/dd/yyyy

— Sets the TE6000A internal date.The date is set in mm/dd/yyyy format where:
■ mm = month from 01 to 12
■ dd = day of the month from 01 to 31
■ yyyy = current year
For example, to set the date to June 21, 2003, issue the command 
MC DATE 06/21/2003
Note: The TE6000A real- time clock does have a battery backup source. If the 
unit loses power, is turned off, or reset, the real-time clock is set to the current 
(correct) day and time. 
Front panel command equivalent: Config>Control>Clock>Date

MC DUPLEX Half, Full Full Sets the duplex operation for the RS-232 remote control port configuration. 
Front panel command equivalent: none

MC FLOW Soft, Hard Soft Sets the remote control port flow control. Parameters are: 
■ Soft = Software XON/XOFF
■ Hard = Hardware RTS/CTS. 
Front panel command equivalent: Config>Comm>Serial>Flow

MC FP_STATE Locked Unlocked Used to query or set the state of the front panel. 
If queried, responses are: unlocked = the front panel is unlocked, operators can 
use the front panel to configure, monitor, and control TE6000A operations; 
locked = front panel is locked and is only available to monitor TE6000A 
operations.
If used to set the state of the front panel, only a LOCKED parameter may be 
issued. The front panel must be used to unlock the unit. For additional 
information on locking and unlocking the front panel, refer to the chapter on the 
front panel. 
Front panel command equivalent: Config>Control>FP Lock>State

MC FTPSERVER On, Off Off Turns the FTP Server on and off.
Front panel command equivalent: none

MC GATEWAY #.#.#.# where # is a decimal 
number from 0 to 255

0.0.0.0 Sets the designated gateway in an IP network. 
Front panel command equivalent: Config>Comm>Network>IP Router

MC MAC — — Displays the unit’s Medium Access Control (MAC), or network, address. The 
format for the returned value is #:#:#:#:#:# where # represents a hexadecimal 
number. 
Front panel command equivalent: Config>Comm>Network>TMA

MC IP #.#.#.# where # is a decimal 
number from 0 to 255

0.0.0.0 Sets the IP address. 
Front panel command equivalent: Config>Comm>Network>IP Addr

MC MASK #.#.#.# where # is a decimal 
number from 0 to 255

 225.225.0.0 Sets the IP mask. 
Front panel command equivalent: Config>Comm>Network>IP Mask

MC OUT_MODE QPSK, ATSC QPSK Setting determines if the internal modulator is used to control the bit rate output 
of the multiplexer.
■ QPSK – the internal modulator is used
■ ASI – the internal modulator is not used
Front panel command equivalent: Config>Output>Out Mode
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MC PARITY N, O, E N Sets the parity for the RS-232 remote control port configuration. Parameters 
are: 
■ N = No parity
■ O = Odd parity
■ E = Even parity 
Front panel command equivalent: Config>Comm>Serial>Parity

MC RE — — Resets the TE6000A, reloads all programmable logic and firmware, and 
restarts the system. All parameters return to the last settings stored in flash 
memory or the last changes made using the front panel. The TE6000A restores 
configuration settings as follows:
■ All changes made using the front panel are automatically stored in flash 

memory. When the TE6000A is reset, any changes made using the front 
panel are restored.

■ Changes made using a remote unit are not automatically stored in flash 
memory. If the TE6000A is reset before issuing the CM SAVE command, 
changes made using a remote unit are not restored. Instead, the last 
changes saved to flash memory are restored.

■ If the TE6000A configuration is changed using a remote unit, an operational 
test should be performed to verify system operations. Then the new 
configuration should be saved by issuing the CM SAVE command. Once 
the configuration is saved, the TE6000A automatically restores the saved 
settings when the unit is reset or powered up.

Note: The TE6000A real- time clock includes a battery backup source. If the 
unit loses power, is turned off, or reset, the real-time clock reverts to the current 
day and time. 
Front panel command equivalent: Config>Control>Reset

MC STOP 1, 2 1 Sets the number of stop bits for the RS-232 remote control port. 
Front panel command equivalent: Config>Comm>Serial>Stop Bits

MC TIME hh:mm:ss numeric value in the 
format: hh:mm:ss

— Sets the TE6000A internal real-time clock. The time is set in hh:mm:ss format 
where:
■ hh = hours, in a 24-hour format, from 00 to 23, where 00 is midnight and 23 

is 11 PM
■ mm = minutes from 00 to 59
■ ss = seconds from 00 to 59
For example, to set the time to 10:20:59 AM, issue the command 
MC TIME 10:20:59. To set the time to 10:20:59 PM, issue the command 
MC TIME 22:20:59.
Note: The TE6000A real- time clock does have a battery backup source. If the 
unit loses power, is turned off, or reset, the real-time clock is set to the current 
(correct) day and time. 
Front panel command equivalent: Config>Control>Clock>Time 

MC VERSION — — Displays the firmware version of the master controller card. 
Front panel command equivalent: none

MOD CK Carrier_Off, Carrier_Low, 
Carrier_On, Modulate

Carrier_Off Sets the power and form of the output IF transmit carrier from the encoder. 
Parameters are: carrier off = off; carrier low = low-power CW (constant wave); 
carrier on = full-power CW; modulate = full-power modulated.
This command works in conjunction with the MOD TC command. When MOD 
CK is set to off, the MOD TC command setting is not implemented. 
Front panel equivalent: Use the modulator control buttons or issue the front 
panel command: Config>Output>Mod State

MOD CLDELTA -10.0 to 0.0 dB -10.0 dB Carrier-low-delta; number, in tenths of dB (i.e., 0.1 dB), used to define the 
modulator output power level when the front panel modulator control button 
carrier low is pressed. For this command, the output power is equal to the 
transmit power value (MOD TP) minus the carrier-low-delta value. 
Front panel command equivalent: none

MOD CR 1/2, 2/3, 3/4, 5/6, 7/8 5/6 Viterbi code rate; sets the code rate for forward error correction (FEC) of the 
modulated signal.
The rate selected indicates the number of error correction bits that will be 
added to the data stream. For example, if you select the 5/6 rate, for every 5 
bits that are input to the FEC encoder, the FEC encoder outputs 6 bits.
Viterbi forward error correction increases the transmitted symbol rate by 
increasing the number of bits in the data stream. 
Front panel command equivalent: Config>Output>Code Rate
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MOD DR 921569 to 32254902 bps 8448000 Data rate; used to set the modulator input transport stream data rate.
The data rate you enter is a function of the symbol rate and the code rate. 
The data rate may be entered directly by issuing a MO DDR command or may 
be computed based upon the symbol rate you enter. Specifically, the data rate 
is equal to the Symbol Rate x 2 x 188/204 x V, where V=the Viterbi code rate. 
Front panel command equivalent: none

MOD SI Inverted, Normal Normal Spectrum Inversion; used to set the modulator so that the modulated IF 
spectrum is inverted. Parameters are: 
■ Inverted = the modulated IF spectrum is inverted
■ Normal = the modulated IF spectrum is not inverted. 
Front panel command equivalent: Config>Output>Spect Invert

MOD SR 1000000 to 20000000 
Sps

— Used to enter the modulator symbol rate
The symbol rate is the number of symbols required to transmit the data stream 
over a satellite link using quadrature phase shift keying (QPSK).
The symbol rate is a function of the data rate and the code rate, including any 
overhead. 
The symbol rate may be entered directly by issuing a MOD_SR command or 
will be automatically computed based upon the entered data rate and code 
rate. The symbol rate is equal to the Data Rate x 1/2 x 204/188 x 1/V, where 
V=the Viterbi code rate. 
When you enter the code rate, the data rate remains unchanged, however, the 
symbol rate is recomputed.
If the displayed symbol rate exceeds the allowable satellite bandwidth, the data 
will be corrupted during transmission. To determine the satellite bandwidth 
required to transmit the displayed symbol rate, use the following equation:
symbol rate x 1.35 = required satellite bandwidth measured in Hz 
Front panel command equivalent: Config>Output>SymRate

MOD SRC ASI, Backplane ASI Modulator input source; used to select either ASI or the backplane as the 
source for the modulator’s digital input stream.
The TE6000A outputs the internal transport stream in ASI format on a BNC 
connector, which is located on the back panel.
Front panel command equivalent: Config>Output>Mod Source

MOD TC Off, On Off Disables or enables the carrier modulation for testing purposes. Parameters 
are: 
■ Off = disables pure carrier – the carrier is modulated with the data stream 

before being transmitted
■ On = enables pure carrier – the carrier is not modulated with the data 

stream before being transmitted.
This command works in conjunction with the MOD CK command. When MOD 
CK is set to off, the MOD TC setting is not implemented. 
Front panel command equivalent: none

MOD TCMODE Off, On Off Transmit carrier restore mode. Parameters are: 
■ Off = following power-up or reset, the modulator output is disabled 

regardless of the modulator output carrier state prior to reset or power-up
■ On = following power-up or reset, the modulator output is restored to the 

state that was stored in flash memory just prior to reset or power-up. 
The On setting is most common for unmanned applications which may 
encounter power outages. For these situations, the modulator should return to 
a modulated carrier following power restoration. 
Front panel command equivalent: Config>Output>Tx Power-up

MOD TEMP — — Query-only command; displays the current temperature of the modulator in 
Celsius. 
Front panel command equivalent: none

MOD TF  52000000 to 
88000000Hz, in 1Hz 

increments

70000000Hz Used to set the modulator carrier frequency.
The acceptable range of options is implemented with a pass band filter that 
filters out all frequencies below and above the range.
When selecting a carrier frequency, you must take into account the satellite 
bandwidth required for transmission. If you select a carrier frequency that is too 
close to either end of the valid range, data may be clipped by the pass band 
filter. For information on calculating the satellite bandwidth, see the MOD SR 
command. 
Front panel command equivalent: Config>Output>Tx Freq
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MOD TP -20.0 to -5.0dBm, in 
0.1dB increments

-5.0 dBm Transmit power; used to set the output transmit power of the TE6000A 
modulator. 
Front panel command equivalent: Config>Output>Tx Power

MOD XL Locked, Unlocked — Displays if the modulator is locked to the input transport data stream. 
Responses are: locked = the modulator is locked onto the incoming signal; 
Unlocked = the modulator is not locked onto the incoming signal. 
Front panel command equivalent: Config>Output>Mod Status

MUX BISS_EN On, Off Off Enables and disables BISS at a system level.
■ on – enables BISS 
■ off – disables BISS
Note: BISS cannot be enabled if PGCA is enabled. 
Front panel command equivalent: none

MUX CM SCPC, MCPC, Redund, 
PSIP

SCPC Defines the system as SCPC, MCPC, redundant, or PSIP. Parameters are: 
■ SCPC = single channel per carrier, disables multiplexing of incoming 

external transport stream; outputs only local program elements.
■ MCPC = multiple channels per carrier; enables the multiplexing of an 

incoming external transport stream with local program elements. MCPC 
allows the internal transport stream rate and the output transport stream 
rate to be independently defined; these parameters are not automatically 
calculated and set by the TE6000A in MCPC mode.

■ Redund = places the TE6000A in a redundant state; used when a system is 
operating in a redundant, or protected, setup. When Redund is selected, 
also set MUX RED_STATE. 

■ PSIP – places the encoder in PSIP mode; used when a PSIP generator is 
connected to the encoder

Front panel command equivalent: Config>Tx Strm>Mode

MUX EXT_ENABLE Off, On On Setting determines if the external transport stream is processed or discarded. 
MUX EXT_Enable works in conjunction with the MUX CM command. 
Parameters are: 
■ On = transport stream is processed; MUX CM must be set to MCPC or 

Redund
■ Off = transport stream is discarded; MUX CM must be set to SCPC 
Front panel command equivalent: Config>Tx Strm>Ext TS Enable

MUX EXT_RATE — — Displays the measured external input transport rate in bps. 
Front panel command equivalent: Config>Tx Strm>ExtRate

MUX EXT_STATUS — — Displays the status of the externally-supplied transport stream. Responses are: 
Absent = no signal, Unlocked = signal present, but no transport lock, 
Locked = transport lock detected. 
Front panel command equivalent: Config>Tx Strm>Ext TS Status

MUX LOC_ENABLE On, Off On Setting determines whether or not the locally generated input is included in the 
transport stream. 
Front panel command equivalent: Config>Tx Strm>Loc TS Enable

MUX LOC_RATE  1000000 to 70000000 
bps

8448000 Sets the local transport stream rate (generated internally by the TE6000A) in 
bits/second. 
Front panel command equivalent: Config>Tx Strm>LocRate

MUX LOC_STATUS — — Displays the status of the local input transport stream. Responses are: 
Absent = no signal; Unlocked = signal present, but no transport lock; Locked = 
transport lock detected. 
Front panel command equivalent: Config>Tx Strm>Loc TS Status

MUX OUT_RATE If SCPC= 1000000 to 
70000000

If MCPC = 1000000 to 
160000000

8448000 Sets the output transport stream rate. Range is dependent upon MUX CM 
setting. 
Front panel command equivalent: Config>Output>Data Rate

MUX PCR_RATE 1-100 Hz Sets the transmit rate of the PCR packet.
Front panel command equivalent: Config>Service>PCR>Transmit Rate

MUX PROG_INFO — — Displays the current conditional access settings for all services. Information 
includes: program number, program name, previous scrambling mode, current 
scrambling mode, and the key.
Front panel command equivalent: Config>CA>Setup>Service
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MUX RED_STATE 2 Standby, Armed, 
Triggered

Standby Sets the operating state of the spare encoder in a redundant system. 
Parameters are:
■ Standby = spare encoder is in an inactive state and will not begin 

operations in the event of a primary encoder failure
■ Armed = sets the spare encoder to begin operations in the event that a 

primary encoder fails
■ Triggered = this state cannot be set; it is entered into automatically, from the 

Armed state, when the loss of an external service is detected. 
Front panel command equivalent: Config>Tx Strm>Redund State

MUX RSR2 — — Displays the name of the external service that has been replaced by the 
redundant unit. Valid only in TRIGGERED state.3 

Front panel command equivalent: none

MUX SCRAM_EN <service#> Off, Mode_1 Off Sets the BISS scrambling mode for the selected service.
■ Off – disables BISS for the selected service
■ Mode_1 – enables BISS Mode 1 for the selected service. With Mode 1, all 

components of the transmission stream are scrambled by a fixed control 
word (CW).

To query the active services, and the BISS conditional access settings, use the 
MUX PROG_INFO command.
Front panel command equivalent: Config>CA>Setup>Service>Scramble>BISS 
Mode 1

MUX SCRAM_KEY <service#> <key> where <service#> is the 
service to be configured 

for BISS
where <key> = 

000000000000 to 
FFFFFFFFFFFF

— Sets the BISS scrambling key for the selected service. The key is a 12-digit 
hexadecimal number.
Front panel command equivalent: Config>CA>Setup>Service>Scramble>
Biss Mode 1>Biss Key

MUX SMPTE_EN On, Off Off Setting determines whether or not the SMPTE output is included in the 
transport stream. 
Front panel command equivalent: none

MUX SMPTE_RATE 19, 38 19 Sets the SMPTE output rate. 
■ 19 – sets the rate to 19.392658
■ 38 – sets the rate to 38.785316
Front panel command equivalent: none

TAB ATSC_NAME <string> <string> — Sets the ATSC name; up to 8 characters may be used. 
Front panel command equivalent: none

TAB AUD_A_PID <#> where # is a valid PIDs 0 Sets the Audio A PID to be included in the output transport stream. Zero is the 
default PID.
Front panel command equivalent: none

TAB AUD_B_PID <#> where # is a valid PIDs 0 Sets the Audio B PID to be included in the output transport stream. Zero is the 
default PID.
Front panel command equivalent: none

TAB CARRIER_HZ 0-2000000000
in Hz

566310000 Hz Sets the carrier frequency when ATSC table types are enabled. 
Front panel command equivalent: none

TAB MINORCH 1 to 99 2 Sets the minor channel in the ATSC tables. 
Front panel command equivalent: Config>Service>Setup>Minor Channel

TAB MAJORCH 1 to 99 30 Sets the major channel in the ATSC tables. 
Front panel command equivalent: Config>Service>Setup>Major Channel

TAB NIT_CC 1/1, 1/2, 2/3, 3/4, 5/6, 7/8 5/6 Sets the current FEC Convolution Code Rate entered in the NIT. 
Front panel command equivalent: none 

TAB NIT_MOD QPSK — Sets the NIT modulation type. 
Front panel command equivalent: none

TAB NIT_NAME <string> MPEG-2 
Encoder

Used to enter the network name; up to 115 characters may be used. 
Front panel command equivalent: none 

TAB NIT_NETID 0 to 65535 (decimal) 0 (zero) Used to enter the Network ID in the NIT. 
Front panel command equivalent: none
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TAB NIT_POL Hor, Vert, Left, Right Ver Sets the transmitted signal polarization. Parameters are: 
■ Hor =linear-horizontal polarization
■ Ver = linear-vertical polarization
■ Left = circular- left polarization
■ Right = circular- right polarization
Front panel command equivalent: none

TAB NIT_SATFREQ <###.#####> 000.00000 to 999.99999 011.75725 Sets the satellite frequency in GHz. 
Front panel command equivalent: none

TAB NIT_SATPOS <###.#> 000.0 to 999.9  019.2° Sets the satellite orbital position in degrees. 
Front panel command equivalent: none

TAB NIT_SR <###.#####> ###.##### — Sets the NIT transmitted symbol rate in sps.
Front panel command equivalent: none

TAB NIT_WSTFLG East, West West Sets the satellite orbital position. Parameters are: 
■ East = satellite orbital position is East
■ West = satellite orbital position is West.
Front panel command equivalent: none

TAB PCR_PID <#> where # is a valid PIDs 0 Sets the PCR PID to be included in the output transport stream. Zero is the 
default PID.
Front panel command equivalent: none

TAB PMT_PID <#> where # is a valid PIDs 0 Sets the Program Map Table (PMT) PID to be included in the output transport 
stream. Zero is the default PID.
Front panel command equivalent: none

TAB PROGNUM DVB = 1-223
ATSC = 2-223

If DVB = 1
If ATSC = 2

Controls the program number for the PAT. Changing the PAT program number 
automatically sets the PMT to the same program number and sets the EIT and 
SDT service ID to match the program number. 
Front panel command equivalent: Config>Service>Setup>Service ID

TAB PROVIDER <string> <string> Unnamed Used to enter the service provider name; name can be up to 115 characters in 
length.
Front panel command equivalent: Config>Service>Setup>Provider

TAB SDT_NAME <string> <string> If DVB = service 
1

If ATSC = ch2

User to enter the service name; name can be up to 115 characters in length.
Front panel command equivalent: Config>Service>Setup>Name

TAB TSID  0 to 65535 1 Sets the transport stream ID for the PAT. Changing the PAT Transport Stream 
ID automatically changes the EIT, NIT, SDT Transport Stream IDs to the same 
ID.
Front panel command equivalent: none

TAB TYPE None, MPEG, DVB, 
ATSC

DVB Controls the type of PSI/SI tables to be provided. Works in conjunction with the 
CM Load Def command.
Front panel command equivalent: Config>Tx Strm>Table Type

TAB USR_A_PID <#> where # is a valid PIDs 0 Sets the Data A PID to be included in the output transport stream. Zero is the 
default PID.
Front panel command equivalent: none

TAB USR_B_PID <#> where # is a valid PIDs 0 Sets the Data B PID to be included in the output transport stream. Zero is the 
default PID.
Front panel command equivalent: none

TAB VID_PID <#> where # is a valid PIDs 0 Sets the video PID to be included in the output transport stream. Zero is the 
default PID.
Front panel command equivalent: none

TCA ADD <string> where string is the alpha-
numeric label in the 

format
name@MAC address

— Adds a decoder to the conditional access database. The string can be up to 90 
alphanumeric characters in length and must include a name, the @ sign, and 
the decoder’s MAC address in the format name@mac address. The string 
cannot contain any spaces. The name parameter can be up to 15 characters 
in length.
To determine the decoder’s MAC address, refer to the appropriate Tiernan 
user guide which accompanied that product.
Note: Decoders are automatically authorized when they are added to the list.
Note: Non-Tiernan IRDs cannot be added to the decoder database.
Front panel command equivalent: Config>CA>PGCAcfg>Add IRD
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TCA AUTH <label> where label is the alpha-
numeric string specified 

in the TCA Add command

— Authorizes a Tiernan decoder to receive broadcast signals.
Note: Non-Tiernan IRDs cannot be authorized.
Front panel command equivalent: Config>CA>PGCAcfg>Lst IRD

TCA CLR — — Clears the active subscriber list.
Front panel command equivalent: none

TCA DEAUTH <label> where label is the alpha-
numeric string specified 

in the TCA Add command

— De-authorizes a Tiernan decoder so that it cannot receive broadcast signals.
Front panel command equivalent: Config>CA>PGCAcfg>Lst IRD

TCA DELETE <label> where label is the alpha-
numeric string specified 

in the TCA Add command

— Deletes a Tiernan decoder from the conditional access database.
Front panel command equivalent: Config>CA>PGCAcfg>Del IRD

TCA ENABLE Off, On Off Enables and disables PGCA at a system level. Parameters are: 
■ on – enables PGCA; this setting ensures that only those Tiernan decoders 

listed in the PGCA database and authorized at an individual level can 
receive the broadcast signals. 

■ off – disables PGCA, all decoders, whether authorized or not, can receive 
the broadcast signal 

Note: PGCA is a proprietary conditional access method used by Tiernan 
equipment that provides basic signal protection and the ability to authorize 
individual Tiernan IRDs. Non-Tiernan IRDs cannot be authorized by PGCA; 
therefore only authorized Tiernan IRDs can decode a service that has been 
protected through PGCA.
Note: For additional information on system-level PGCA, or on adding, deleting 
and authorizing individual decoders, refer to the appendix on Conditional 
Access.
Note: PGCA cannot be enabled if BISS is enabled. 
Front panel command equivalent: Config>CA>Setup>Service>Scramble> 
PGCA 

TCA LIST — — Displays a list of all Tiernan decoders registered in the PGCA database. The 
list includes the decoder’s label, MAC address, and if the decoder is 
authorized.
Front panel command equivalent: Config>CA>PGCAcfg>Lst IRD

TCA MASK 0 to FF 0 (zero) Sets the PGCA scrambling key to a specified algorithmic table.
Front panel command equivalent: Config>CA>Setup>Service>Scramble> 
PGCA>PGCA Key

TCA UPDATE — — Loads the active subscriber list from the PGCA database.
Front panel command equivalent: none

TCA UR 1 to 60 seconds 15 TCA update rate; specifies how often, in seconds, PGCA information is 
transmitted.
Front panel command equivalent: none

TT DATA_ID 0 to FF 1 Setting determines is EBU data included in the Teletext. Values from 0x10 to 
0x1F reflect EBU data. 
Front panel command: Config>Service>VBI>Teletext>Data ID

TT ENABLE Off, All, Auto Off Configures the encoder to transmit teletext information. Parameters are:
■ On = enables ATSC closed captioning
■ Off = does not encode any ATSC closed captioning information
Front panel command: Config>Service>VBI>Teletext>Enable

TT UNIT_ID 0 to FF 2 Unit ID defines if there are EBU Teletext sub-titles included in the data. Data 
Unit ID has range from 0x00 to 0xFF. Values are:
■ 0x2 = EBU Teletext non-subtitle data is not included 
■ 0x3 = EBU Teletext subtitle data is included 
Note: TT Unit_ID must be set to 2 or 3 for proper decoder operations.
Front panel command: Config>Service>VBI>Teletext>Data Unit ID

VE ASP_RATIO 4x3, 16x9 4x3 Sets the picture aspect ratio.
Front panel command equivalent: Config>Service>Video>Aspect Ratio

VE ATSC_CC On, Off Off Configures the encoder to transmit ATSC closed captioning information. 
Parameters are:
■ On = enables ATSC closed captioning
■ Off = does not encode any ATSC closed captioning information
Front panel command equivalent: Config>Service>VBI>CC>ATSC CC
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VE BR 1.0 to 15.0 Mbps — Sets the output compressed video bit rate.
This command is query-only when the MC BITRATE_CTL command is set to 
Auto.
Front panel command equivalent: Config>Service>Video>Data Rate

VE CHROMA 4_2_0, 4_2_2 4_2_0 Queries the chroma encoding format.
Front panel command equivalent: Config>Service>Video>Chroma

VE ENABLE On, Off On Setting determines whether or not video is included in the output transport 
stream. Parameters are: On = video is included in the output transport stream; 
Off = video is not include in the output transport stream.
Front panel command equivalent: Config>Service>Video>Enable

VE HRES 352, 480, 544, 704, 720 720 Sets the horizontal pixel resolution; the TE6000A uses this parameter, as well 
as the video format parameter, NTSC or PAL, to resize the picture prior to 
video encoding.
For all parameters the number of lines per frame are: NTSC = 480; PAL = 576.
Front panel command equivalent: Config>Service>Video>Resolution

VE OPTIMIZE Quality, Low_Delay, 
Low_Buff, Edit, Custom

Quality Sets the video compression optimization. Parameters are: 
■ Quality = optimizes the video performance without regard for throughput 

delay time. Quality mode is appropriate for action video scenes such as 
sports material.

■ Low_Delay = reduces the throughput time required to process a signal from 
the encoder input, through the compression process, and to the decoder 
output. In low delay mode, the overall delay through a TE60 to an IRD is 
360 ms +/-20 ms. In low delay mode, the compressed audio bit rate is 
automatically set to 25 6Kbps. Low delay mode is appropriate for real time 
news interviews.

■ Low_Buff = allows for small buffers
■ Edit = video compression uses only one frame (no prediction) which makes 

it easier to edit the compressed bit stream. Edit requires a higher data rate 
to achieve the video performance of quality mode.

■ Custom = allows you to set site-specific video compression parameters, 
such as GOP structure and VBV size. These parameters must be initially 
set through a remote terminal and then saved using the remote CM SAVE 
command. Once saved, this custom setup will persist until the video 
optimize setting is changed.
The custom parameter is for experienced users only. If this option set 
incorrectly, the video performance maybe adversely affected. It is 
recommended that users consult with Tiernan Customer Service before 
using the custom configuration.

Front panel command equivalent: Config>Service>Video>Optimize

VE PID — — Displays the video PID number included in the output transport stream

VE SRC Digital, Analog Analog Sets the source of the input video.
Front panel command equivalent: Config>Service>Video>Input Source

VE TCC On, Off Off Configures the encoder to transmit Tiernan closed captioning information. 
Parameters are:
■ On = encodes two lines of closed captioning information per frame (one per 

filed) at the expense of losing two lines of active video (one per field)
■ Off = does not encode any closed captioning information
Front panel command equivalent: Config>Service>VBI>CC>Tiernan CC

VE VBI_PASS Off, 16_LINES, 
32_LINES

Off Configures the encoder to transmit either 16 or 32 lines of VBI information
■ Off – disables expanded windows mode
■ 16_lines – enables 16-line expanded windows mode
■ 32_line – enables 16-line expanded windows mode
■ Front panel command equivalent: 

Config>Service>VBI>Expand>VBI Passthru

VI.<slot> AGC On, Off — Enables or disables AGC for the analog video input.
Front panel command equivalent: none
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VI.<slot> FMTCTL Auto, PAL_N, NTSC, 
NTSC OSU

Auto Sets the video format mode when the input source is set to analog. Parameters 
are:
■ Auto – unit automatically senses incoming video signal format and 

configures the video mode to match (default)
■ PAL N – 625 line PAL-N mode
■ NTSC – 525 line NTSC mode
■ NTSC 0SU – no pedestals NTSC0SU mode
Front panel command equivalent: Config>Service>Video>Format Ctrl

VI.<slot> FORMAT — — Query-only; displays the incoming analog video frame rate. Responses are: 
■ 525 Line Video Input
■ 625 Line Video Input
■ No video present
Front panel command equivalent: Config>Service>Video>Format

VI.<slot> GENMODE Main, Genlock Main Selects the video timebase source. Parameters are: 
■ Main = video input is used for the encoder timebase
■ Genlock = Genlock input is used for the encoder timebase. Input video must 

be synchronized to Genlock input in order for this to work properly.
Front panel command equivalent: Config>Service>Video>Timebase

1 The TE6000A contains a bank of flash memory that is used to store firmware, software, and hardware configuration files as well as unit configuration parameters. 
Parameter changes made using the front panel are automatically stored in flash memory. When the TE6000A is reset, any changes made using the front panel are restored. 
Any parameter changes made using a remote unit are not automatically stored in flash memory. If the TE6000A is reset prior to issuing the C MSAVE command, any changes 
made using the remote unit will not be restored. Instead, the TE6000A restores the last changes saved to flash memory. When the TE6000A configuration is changed using a 
remote unit, an operational test should be performed to verify that the system is operating correctly. Then the new configuration should be saved by issuing the CM SAVE 
command. Once the configuration is saved, the TE6000A automatically restores saved settings when the unit is reset or powered up.
2 Command only valid when MUX CM is set to Redund.
3 Refer to the MUX RED_STATE command for additional information.
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5Configuring the TE6000A

This chapter presents the following information:
■ A high-level procedure used to configure a TE6000A using either the front 

panel or a remote unit.
■ Detailed procedures for configuring a TE6000A to the default standards using 

either the front panel or a remote unit
■ Examples of common TE6000A configurations, including:

❒ Configuring a basic DSNG setup using the front panel
❒ Configuring a simple SCPC setup using a remote unit
❒ Configuring a simple 2:1 MCPC setup using the front panel or a remote 

unit

TE6000A
Configuration

Procedure

Whether you use the front panel or a remote unit to configure the TE6000A, 
perform the following steps to configure your system:
1. Make a list of your operational requirements.
2. Compare your requirements to the corresponding TE6000A default parameter 

settings. 
3. Determine which TE6000A default parameters must be changed for your 

operational requirements.
4. Write down the new TE6000A parameter values and the corresponding front 

panel or remote commands required to change those parameters.
5. Configure the TE6000A to the default configuration.
6. Configure the TE6000A with any new parameters.
7. Ensure that the decoder is correctly configured to operate with the TE6000A 

parameter settings.

All TE6000A configuration changes issued from the front panel are automatically save to flash 
memory. Unlike front panel operations, TE6000A parameter changes made from a remote unit are 
not automatically saved to flash memory. If configuration changes are made from a remote unit, 
issue the command CM SAVE to save the configuration to flash memory.

Setting a Default
Configuration

The TE6000A is configured with a set of default, DVB-compliant parameters 
before it is shipped from the factory. This DVB configuration consists of a 
standard set of operating parameters that allow you to quickly and easily begin 
operations. When configured to the DVB default settings, the TE6000A:

■ Encodes both audio channels and the video channel at the default DVB rate
■ Compresses the channels
■ Includes the channels with a standard set of table information in the internal 

transport stream
■ Does not include either of the Aux data channels in the transport stream
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The TE6000A should be operated using either the DVB or ATSC default 
configuration unless your site-specific operations require a change to the default 
settings. If a change is required, modify only those parameters that meet your 
operational requirements.
When you begin operations using either the DVB or ATSC default configuration, 
ensure that the decoder is also initialized to the appropriate defaults. If you modify 
the TE6000A operating parameters, ensure that the decoder parameters are also 
modified to match the new TE6000A parameters.

Using the Front Panel to Set the Default Configuration
To initialize the TE6000A to a default configuration using the front panel, 
perform the following steps.
1. From the main menu, select Config. 

2. The Configuration menu displays. Select Presets. 

3. The Presets menu displays. Select Restore.

4. The Restore menu displays. The current configuration is set to DVB, 
indicated by the brackets [ ]. 

Even if the current configuration displayed on the LCD is the correct configuration for your 
requirements, some or all of the parameters may have been manually changed since the unit was 
initialized. To ensure that all of the TE6000A parameters are set to the factory default configuration, 
continue with steps 5 through 7.

TE6000A SDTV MPEG-2 Encoder
[Config] Status Version

Software Version: 3.00

Config
[Presets] Output Service Tx Strm
CA Control Comm

Config>Presets
[Restore] Save New Rename
Delete

Config>Presets>Restore
Restore = [DVB]

ATSC
User01
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5. Scroll through the list until the correct option is selected [ ] and is flashing. In 
this example, ATSC will be selected. To select ATSC, use the down arrow to 
move the brackets to ATSC. 

6. Press the Enter button. 
7. When the TE6000A has completed the initialization process, the main menu 

displays and the TE6000A is set to the selected default configuration.

Using a Remote Unit to Set the Default Configuration
To initialize the TE6000A to the default configuration using a remote unit, issue 
the following command:

■ CM RESTORE <string> 
where <string> is the default parameter such as DVB or ATSC

When the TE6000A is set to the DVB default setting, the remote port baud rate is set to 38400 bps. 
If the remote unit is set to communicate with the TE6000A at a baud rate other than 38400 bps, 
immediately after the DVB default command is issued, the remote unit will not be able to 
communicate with the TE6000A. To resolve this issue, the equivalent parameter in the software 
settings of the remote unit must be changed to 38400 bps. However, the remote unit software 
settings must not be changed before issuing the DVB default command to the TE6000A, as the 
remote unit will not be able to communicate with the TE6000A.

Configuration
Examples

All examples presented in this section follow the TE6000A Configuration 
Procedure presented at the beginning of this chapter and use the DVB factory 
configuration as the default.

Configuring a Basic DSNG Setup Using the Front Panel
This example configures the TE6000A to a basic DSNG setup. Use this example 
as a guideline, substituting your site-specific parameter values as required.
Step 1: In this example, assume that the following is a list of your TE6000A 
operational parameters:
Input channels: 

■ Audio A: On
■ Audio B: Off
■ Video: On

Config>Presets>Restore
Restore =  DVB

[ATSC]
User01

TE6000A SDTV MPEG-2 Encoder
[Config] Status Version

Software Version: 3.00
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Audio encoder parameters:
■ Source of input audio: analog left and right input
■ Compressed output audio format: stereo
■ Audio compressed bit rate: 256 kbps
■ Audio channel sample rate: 48 kSps

Video encoder parameters:
■ Source of input video: composite analog
■ Video format mode: PAL
■ Pixel and line sample resolution: 720 x 576 resolution video (full resolution 

video)
■ Output compressed video bit rate: auto-rate calculation

Aux data parameters: 
■ Aux data channel inputs – Aux data channel A disabled; Au xdata channel B 

disabled
Multiplexer Transport Stream Parameters: 

■ SCPC Operation – ASI output at 8.448 MHz
PSI tables: Minimal complete set
Steps 2 and 3: After comparing these operational requirements against the 
TE6000A DVB parameters, it is determined that all the parameters required to set 
the audio and video encoders to the basic DSNG setup are DVB settings, with the 
exception of the Audio B channel.
Step 4: The Audio B channel must be set to Off. The front panel menus used to 
change this parameter are:

Service>Audio>Analog>AudioB>Enable = Off
Step 5: To configure the TE6000A for this example, you must first initialize the 
unit to DVB default settings. The steps to perform this initialization are presented 
in the previous section.
Step 6: Once the TE6000A is set to the DVB default settings, the Audio B 
channel parameter must be changed to Off.
1. From the main menu select Config.

2. The Configuration menu displays. Use the right arrow to select Service and 
press Enter.

TE6000A SDTV MPEG-2 Encoder
[Config] Status Version

Software Version: 3.00

Config
Presets Output [Service] Tx Strm
CA Control Comm
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3. The Service menu displays. Use the right or left button to select Audio and 
press Enter.

4. The Audio menu displays. Use the right button to select Analog and press 
Enter. 

5. The Analog Audio menu displays. Use the right button to select Audio Slot 
1B and press Enter.

6. The Analog Audio B menu displays, showing the current Enable parameter.

7. Press the Down button to select Enable = Off. This parameter should be 
flashing.

8. Press the Enter button to set the parameter.
After you have set the parameter to disable the Audio B channel, all of the audio 
and video encoder parameters are set to the basic DSNG setup for this example.
Step 7: Ensure that the decoder is correctly configured to operate with the 
TE6000A parameter settings.

Config>Service
[Setup] Video VBi Audio
Data PCR

Config>Service>Audio
[Digital] Analog

Config>Service>Audio>Analog
[Slot 1A] Slot 1B

Config>Service>Audio>Analog>Slot 1B
Enable = [On] →

Off

Config>Service>Audio>Analog>Slot 1B
Enable = On →

[Off]
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Configuring a Simple SCPC Setup Using the Remote Unit
This example configures the TE6000A to a simple SCPC setup. Use this example 
as a guideline, substituting your site-specific parameter values as required.
Step 1: In this example assume that the following is a list of your TE6000A 
operational parameters:
Input channels

■ Audio A: On
■ Audio B: On
■ Video: On

Audio encoder parameters
■ Source of input audio: analog left and right input
■ Compressed output audio format: Stereo
■ Audio compressed bit rate: 256 kbps
■ Audio channel sample rate: 48 kSps

Video encoder parameters
■ Source of input video: D1 serial digital
■ Video format mode: PAL mode
■ Pixel and line sample resolution: 480 x 576 resolution video
■ Output compressed video bit rate: auto-calc

Aux data parameters: No Aux data required
Multiplexer Transport Stream Parameters: 

■ SCPC Operation: ASI output at 4 Mbps
PSI tables: Minimal complete set
Steps 2 and 3: After comparing these operational requirements against the 
TE6000A DVB parameters, it is determined that all the parameters required to set 
the audio and video encoders to a simple SCPC configuration are DVB settings, 
except for the following parameters:

■ Video source
■ Video resolution
■ Multiplexed transport rate

Step 4: To change these parameters the following remote commands will be 
used:

Parameter Remote Command

Video source = D1 serial digital VE SRC DIGITAL

Video resolution = 480 x 576 VE HRES 480

Multiplexed transport rate =4 Mbps MUX OUT_RATE 4000000
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Step 5: To configure the TE6000A for this example, you must first initialize the 
unit to DVB default settings. 
1. Issue the DVB default command CM RESTORE DVB. 

When the remote unit displays the system prompt (>) all of the TE6000A 
parameters have been set to the DVB default settings.

2. If the baud rate setting of the communications package in your remote unit is 
not set to 38400 bps, you must change the baud rate before you can continue.

When the TE6000A is set to the DVB default setting, the remote port baud rate is set to 38400 bps. 
If the remote unit is set to communicate with the TE6000A at a baud rate other than 38400 bps, 
immediately after the DVB default command is issued, the remote unit will not be able to 
communicate with the TE6000A. To resolve this issue, the equivalent parameter in the software 
settings of the remote unit must be changed to 38400 bps. However, the remote unit software 
settings must not be changed before issuing the DVB default command to the TE6000A, as the 
remote unit will not be able to communicate with the TE6000A.

Step 6: Once the TE6000A is set to the DVB default settings, issue the following 
commands to change the required parameters:
1. To set the source of the input video to D1 serial digital, issue the command 

VE SRC DIGITAL. After the TE6000A sets the parameter, the system prompt 
is displayed.

2. To set the pixel and line sample resolution to 480, issue the command 
VE HRES 480.

3. To set the output transport rate on the TTX-2000 ASI port to 4 Mbps issue the 
command MUX OUT_RATE 4000000.

Your TE6000A is now configured to a simple SCPC setup. To save this 
configuration to flash memory issue the CM SAVE command.
Once you have saved the settings, the TE6000A automatically restores to the 
simple SCPC setup whenever you reset or power-up the unit.
Step 7: Ensure that the decoder is correctly configured to operate with the 
TE6000A parameter settings.

Configuring a Simple 2:1 MCPC Setup Using the Front Panel or a 
Remote Unit
This example configures the TE6000A to a simple 2:1 MCPC setup. To configure 
the TE6000s for MCPC operations, perform these steps:
1. Setup and identify the encoders.
2. Calculate the overall output rate requirements for your system. 
3. Follow the TE6000A Configuration Procedure to configure the encoders and 

verify MCPC operation.
Setup and Identify the Encoders The 
interconnections of the encoders must be 
established and each encoder identified by label as 
shown in the illustration. 
For detailed information on MCPC 
interconnections, and video and audio input 
connections, refer to the chapter on installation.

NOTE

TE6000A #2

Tx IF

TE6000A #1

ASI Interconnect
TTX #1 Out to 
TTX #2 ASI Input

ASI Loop TTX to TMod

Tx IF Out

DVB ASI In

ASI Out Primary

ASI TS In

TS Out
Secondary ASI
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Calculate the Local and Total Transport Output Rates To perform the required 
calculations you must know the following values:

■ Satellite transponder bandwidth allocation
■ DVB-compliant QPSK Spectral Mask = 1.35
■ Viterbi FEC rate 

Perform the following calculations:
1. Calculate the symbol rate that fits into the available satellite bandwidth using 

the DVB-compliant QPSK spectral mask: 
Bandwidth / QPSK Spectral Mask = Symbol Rate

2. Calculate the transport output rate that fits into the available symbol rate:
Symbol Rate x 2 [QPSK] x 188/204 [Reed-Solomon FEC] x Viterbi FEC = 
Total Transport output rate

3. If both encoders are running at the same rate, divide the total transport output 
rate by the number of programs:
Total Transport output rate / # Programs = Local Rate
Ensure that the local rate does not exceed the total transport output rate.

4. If both encoders are not running at the same rate, ensure that the addition of 
the two local rates is less than or equal to the total transport output rate.

Example: The following calculation example uses these assumptions:
■ Two programs are multiplexed into one transport stream
■ The stream is transmitted in 1 5MHz of satellite transponder bandwidth
■ A Viterbi FEC rate of 5/6 provides adequate link margin.
1. Calculate the symbol rate that fits into the available satellite bandwidth using 

DVB-compliant QPSK spectral mask: 
15 MHz / 1.35 = 11.11 MSps

2. Use the Viterbi FEC rate of 5/6 to calculate the transport rate that will fit into 
the available symbol rate:
11.11 MSps x 2 [QPSK] = 22.22 Mbps
22.22 Mbps x 188/204 [Reed-Solomon FEC] = 20.477 Mbps
20.447 Mbps x 5/6 [Viterbi FEC] = 17.064 Mbps

3. Since both encoders are running at the same rate, the transport output rate is 
divided by two in order to balance the available bit rate equally between the 
two programs:
17.064 Mbps / 2 = 8.53 Mbps

Perform the TE6000A Configuration Procedure to Configure the 
Encoders and Verify MCPC Operation
Step 1: In this example assume that the following is a list of your TE6000A 
operational parameters:
Input channels

■ Video: On
■ Audio A: On
■ Audio B: On
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Audio encoder parameters
■ Source of input audio: analog
■ Compressed output audio format: stereo
■ Audio compressed bit rate: 256 kbps
■ Audio channel sample rate: 48 kSps

Video encoder parameters
■ Source of input video: composite
■ Pixel resolution per line: 720

Aux data parameters: No Aux data required
Multiplexer Transport Stream Parameters

■ PSI/SI tables: minimum complete set
■ TE6000A #1 transport output at 8.53 Mbps
■ TE6000A#2 internally generated transport rate 8.53 Mbps
■ TE6000A #2 transport output at 17.064 Mbps

Modulator Parameters
■ Output frequency: 70MHz
■ FEC rate: 5/6
■ Input data rate: 17.064 Mbps

Steps 2 and 3: After comparing these operational requirements against the 
TE6000A DVB parameters, it is determined that all the parameters required to set 
the audio and video encoders to a simple 2:1 MCPC configuration are DVB 
settings, except for the following parameters:
For the TE6000A #1

■ Multiplexer transport output rate
For the TE6000A #2

■ Multiplexer internally generated transport rate
■ System configuration
■ Modulator input data rate
■ Multiplexer transport output rate

Step 4: To change these parameters the following front panel or remote 
commands can be used:

TE6000A #1 Parameter Front Panel Menus Remote Commands

Multiplexer transport output rate = 8.53 Mbps Config>Output>Data Rate>8530000 MUX OUT_RATE 8530000

TE6000A #2 Parameters Front Panel Menus Remote Commands

Multiplexer internally generated transport rate = 
8.53 Mbps

Config>Tx Strm>LocRate>8530000 MUX LOC_RATE 8530000

System configuration = MCPC Config>Tx Strm>Mode>MCPC MUX CM MCPC

Multiplexer transport output rate = 17.064 Mbps Config>Output>Data Rate> 17064000 MUX OUT_RATE 17064000
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Steps 5 and 6: Set the TE6000s to the DVB default settings and issue the 
following commands to change the required parameters:
1. Initialize the TE6000A #1 (the first encoder in the chain) to the DVB defaults.
2. Configure the TE6000A #1:

a. Set the encoder to SCPC mode using either the front panel Config>Tx 
Strm>Mode>SCPC option or the remote command MUX CM SCPC.

b. Set the local rate using either the front panel 
Config>Tx Strm>LocRate value option or the remote command 
Mux Loc_Rate value (where value is the calculated local rate).

3. Initialize the TE6000A #2 (the second encoder in the chain) to the DVB defaults.
4. Configure the TE6000A #2:

a. Set the encoder to MCPC mode using either the front panel Config>Tx 
Strm>Mode>MCPC option or the remote command MUX CM MCPC.

b. Set the local rate using either the front panel 
Config>Tx Strm>LocRate value option or the remote command 
Mux Loc_Rate value (where value is the calculated local rate).
The current fault Mux.A Loc Overflow may display. This fault will 
clear when the total output rate is adjusted in the next step.

c. Set the total transport output rate using either the front panel 
Config>Output>Data Rate value option or the remote command 
Mux Out_Rate value (where value is the calculated total transport 
output rate). 

5. If a remote unit was used to set the MCPC configuration parameters, issue the 
CM SAVE command for each TE6000A unit in order to save their 
configurations to flash memory.

If you are using a remote unit to perform the TE6000A configuration, and the baud rate setting of the 
communications package in your remote unit is not set to 38400 bps, you must change the baud rate 
immediately after initializing the TE6000A to the DVB defaults in order to continue 
communications between the TE6000A and the remote unit.

Step 7: To verify the MCPC stream, use an IRD in a digital IF loop or satellite 
downlink and perform the following steps:
1. Configure the demodulator and/or IRD to the appropriate parameters.
2. When the IRD is fully locked on the MCPC transport stream, verify that 

multiple services are being received. Services can be viewed on the front 
panel of Tiernan IRDs.

3. Select a required service. The IRD should receive and process the service.
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6Troubleshooting

This chapter includes the following information:
■ Fault reporting and monitoring, including the status LED and status button, 

viewing current faults, and viewing the fault history and fault relay logs
■ Initialization self-test diagnostic functions
■ Summary listing all TE6000A faults
■ Operational problems and their solutions

Fault Reporting and
Monitoring

The TE6000A has an internal micro-controller that continually performs real-time 
monitoring of system conditions. When the unit detects a fault, the front panel 
Status LED is triggered, the fault it is stored in the fault history log and, depending 
upon the type of fault, the fault may be viewed by querying the current faults.

Status LED At-a-glance system status is quickly determined by checking the tri-colored Status 
LED found on the front panel. The color of the Status LED identifies the state of 
the TE6000A:

■ Green – unit is operating correctly and has no current faults
■ Yellow – current fault is detected
■ Red – internal hardware faults are detected or the video or audio encoders are 

not processing data
If the Status LED illuminates yellow or red, the Status Button can be pressed, 
which will display the faults listing.
Refer to the Faults Summary List for a description of the faults and actions to take 
to resolve the faults.

LED indicators may be visible through holes in the chassis side and rear panel filler plates. These 
indicators are used by factory technicians during the production process but are not used during 
normal operations. These indicators should be ignored.
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Current Faults Current faults are reported real-time, which means that only conditions that are 
present at the time of the query are displayed, regardless of what fault conditions 
have existed in the past. A current fault exists when the Status LED is yellow.

Viewing Current Faults on the Front Panel
To view the current faults on the front panel LCD, perform these steps.
1. From the main menu, select Status.

2. The Status menu displays. Select Current. 

3. The Current Status menu displays. Up to three faults can be displayed on the 
LCD at one time. If there are more than three faults detected, they can be 
viewed by pressing the Up and Down buttons.

If no current faults exist, or if the current fault condition clears, No Fault is 
displayed.

All current faults are recorded in the fault history log; however, not all faults that are detected by the 
TE6000A are shown on the current faults log. To determine if other hardware or operational 
problems exist, the fault history log must be viewed. 

TE6000A SDTV MPEG-2 Encoder
Config [Status] Version

Software Version: 3.00

Status
[Current] History Relay

Status>Current
1. VI.A Loss of Input

Status>Current
No Fault
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Viewing Current Faults Using a Remote Unit
To view current faults using a remote unit, issue the FM CURR_LIST command. 
The TE6000A responds with either No Faults, if none are present, or one or 
more fault messages.
For example, assume that the input source to the video encoder is interrupted or 
disconnected. To view current faults, issue the FM CURR_LIST command. The 
remote unit displays:

Current Faults (LIST)16:25:43 08/21/2001
--------------------------------------------------
VI.x Loss of Input

The query response shows:
■ The type of information queried — current faults

■ The time the query was issued — 16:25:43

■ The day the query was issued — 08/21/2001

■ A listing of all current faults
Individual faults do not include a time tag since they were occurring at the 
time the query was issued, in this example at 16:25:43 on 08/21/2001. 
To determine the time that the fault initially occurred, you must query the 
fault history log. For example, the loss of input could have occurred prior to 
16:25:43 on this day.

Fault History Log The fault history log is more than just a list of current faults that have occurred 
over a period of time. The TE6000A can detect a variety of other hardware and 
operational faults that are not reported as current faults. These faults are stored in 
the fault history log in addition to any current faults that have occurred.
The fault history log records up to 20 repeated occurrences of the same fault 
condition. The TE6000A stops logging faults after they occur more than 20 times. 
All faults are saved in the fault history log until one of the following events occur:

■ The unit’s power is turned off
■ The unit is reset
■ The fault history log is cleared by selecting Status>History>Clear from the 

front panel or issuing the remote command FM LOG_CLEAR.
Individual faults include a time and date tag. The time tag allows you to determine 
how often a particular event or fault is occurring and to track the performance of 
internal components. The TE6000A maintains an internal run-time clock, which 
is used to time-tag faults and other events to help you monitor system 
performance and diagnose problems.
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Viewing Fault History Log on the Front Panel
To view the fault history log on the front panel, perform these steps.
1. From the main menu, select the Status menu.

2. The Status menu displays. Select History.

3. The History menu displays. Select List.

4. The LCD displays the most recent faults. Up to three faults can be displayed 
on the LCD at one time. If there are more than three faults detected, they can 
be viewed by pressing the Up and Down buttons.

If no faults exist, the LCD displays No Fault.

5. To view all faults in the history log, use the Up and Down buttons. 
Faults stored in the fault history log are displayed on the front panel LCD in 
ASCII string format and consist of:

■ A time tag
■ The name of the fault

TE6000A SDTV MPEG-2 Encoder
Config [Status] Version

Software Version: 3.00

Status
Current [History] Relay

Status>History
[List] Clear

Status>History>List
1. 15:23:17VI.A Loss of Input

Status>History>List
No Fault
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For example, at 3:23 pm the input source to the video encoder was interrupted. 
The fault history log, when queried, would display:

■ 15:23:17 VI.x Loss of Input
where:

■ 15:23:17 is the time tag
■ VI.x Loss of Input is the name of fault

Viewing the Fault History Log Using a Remote Unit
To view fault history log using a remote unit, issue the FM LOG_LIST command. 
The unit responds with either No Faults if none are present, or one or more 
fault messages.
The remote unit displays the fault history log beginning with the time and day tag 
followed by the fault descriptor.
For example, assume that the current day is August 21, 2003, and it is 4:25 pm. 
You have just noticed that the status LED is illuminated and you query the fault 
history log. You issue the FM LOG_LIST command. The remote terminal 
displays the following information:

Fault Log at 16:25:43 08/21/2003
--------------------------------------------------
15:23:17 08/21/2003, VI.x Loss of Input
08:57:39 08/20/2003, VI.x Loss of Input

The query response shows:
■ The type of information queried — fault log

■ The time the query was issued — 16:25:43

■ The day of the year the query was issued — 08/21/2003

■ A listing of all faults in the fault history log

Fault Relay
Monitoring

The Form-C fault relay is a real-time indicator for specific fault conditions. The 
relay contacts are passive. 
A Form-C relay has a common contact (C) and two other contacts (A and B). 
Normally the common contact C is connected to A and not to B. 
When the relay is indicating a fault condition, the common contact C is connected 
to B and not A. This relay indicates a fault condition when power has failed. A 
power failure, power switch turned off, or an unplugged unit is defined as a fault 
condition. 
When the fault relay detects a fault condition, the fault relay trips and the Status 
LED illuminates red.
Once a fault condition sets the fault relay and illuminates the status LED on the 
front panel, they must be cleared manually by either:

■ Selecting the front panel Status>Relay>Clear option
■ Issuing a remote FM RELAY_CLR command
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Viewing Fault Relay Log on the Front Panel
To view the fault relay log on the front panel, perform these steps.
1. From the main menu, select the Status menu.

2. The Status menu displays. Select Relay.

3. The Fault Relay menu displays. Select List.

4. The most recent faults are displayed. Up to three faults can be displayed on 
the LCD at one time. If there are more than three faults detected, they can be 
viewed by pressing the Up and Down buttons.
If no faults exist, No Fault is displayed. 

5. To view all faults in the relay log, press the Up and Down buttons.

Initialization Self-Test
Function

In addition to internal fault monitoring, the TE6000A micro-controller 
automatically performs built-in-self-tests during the initialization process. If a 
failure is detected, a fault is displayed to alert you to the problem. 
If the TE6000A did not display an error message during initialization, but is not 
operating properly, perform the following diagnostic steps.
1. Verify that the unit is configured correctly for your requirements.
2. If your system is configured properly, but still not operating correctly, issue 

the front panel CONFIG>PRESETS>RESTORE command or the CM 
LOAD_DEF remote command to reset the TE6000A to the defaults.

3. Reset any custom configuration parameters specific for your site.

TE6000A SDTV MPEG-2 Encoder
Config [Status] Version

Software Version: 3.00

Status
Current History [Relay]

Status>Relay
[List] Clear

Status>Relay>List
No Fault
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4. If the TE6000A is still not operating properly, query the current faults to 
determine if a current fault exists. Correct all current faults.

5. Query and review the fault history log. Correct all faults, if possible.
6. Clear all faults.
7. Query the current faults and fault history log. 
8. If the unit continues to fail, record the fault history. Contact Tiernan Customer 

Service for assistance.

Fault Summary Most TE6000A faults are non-critical, informational faults. When faults occur, 
perform the following steps:

■ If the unit is functioning normally, clear the faults and continue operations.
■ If the unit continues to fail:

❒ Reset the box to the defaults
❒ Configure the unit to the site specific parameters
❒ If the unit is still not operating properly, query the current faults to 

determine if a current fault exists. Correct all current faults.
❒ Query and review the fault history log. Correct all faults, if possible.
❒ Clear all faults.
❒ Query the current faults and fault history log. 
❒ If the unit continues to fail, record the fault history. Contact Tiernan 

Customer Service for assistance.
All TE6000A faults, whether current faults, faults listed in the fault history log, or 
faults that cause the fault relay to trip, are listed in alphabetical order in the 
following table.  

TE6000A Fault Summary

Front Panel Display Remote Unit Display Description Action Required

Digital Video Input
AE.x Init AE.x Init Error Audio Init Error Power cycle the unit.

If normal operations do not resume, contact Tiernan Customer 
Service.

AE.x Inp Invd AE.x AESEBU Input Invd AESEBU Input Error If unit is functioning normally, clear faults and continue operations.
If faults continue check connection; ensure input source is in 
proper format and conforms to specified input levels.
If unit continues to fail, contact Tiernan Customer Service.

AE.x Inp Loss AE.x AESEBU Input Loss AESEBU Audio Not Present If unit is functioning normally, clear faults and continue operations.
If faults continue, check connections; ensure input source is in 
proper format and conforms to specified input levels. Disable 
AESEBU input if it is not used.
If unit continues to fail, contact Tiernan Customer Service.

AE.x L-Ch Idle AE.x Left Channel Idle Left Channel Idle Status message – informational only.
Continue operations.

AE.x PesOvrFlw AE.x PES FIFO Overflow Audio PES (packetized 
elementary stream) FIFO Full

MUX rate is set too low.
Recalculate all bit rates and enter correct rates or select AUTO 
mode.

AE.x PesUndFlw AE.x PES FIFO Undrflow Audio PES (packetized 
elementary stream) FIFO Empty

If unit is functioning normally, clear faults and continue operations.
Contact Tiernan Customer Service.

AE.x R-Ch Idle AE.x Right Channel Idle Right Channel Idle Status message – informational only.
Continue operations.
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MOD.x Init MOD.x Init Error Modulator Initialization Error Power cycle the unit.
If normal operations do not resume, contact Tiernan Customer 
Service.

MOD.x Inp Loss MOD.x Loss of Input Modulator is not receiving the 
transport stream.

Verify connections.
Set modulator input to backplane.
Ensure Mux rate = the Modulator rate.

MOD.x LO Lock MOD.x Local Oscill Unlocked Modulator Loss of Local Oscillator 
Lock

Verify connections.
Set modulator input to backplane.
Ensure Mux rate = the Modulator rate.

MOD.x No Mux MOD.x No Local Input Source Modulator is not receiving the 
transport stream.

Verify connections.
Set modulator input to backplane.
Ensure Mux rate = the Modulator rate.

MOD.x SC Lock MOD.x Symbol Clock Unlock Modulator Loss of Symbol Clock 
Lock

Verify connections.
Set modulator input to backplane.
Ensure Mux rate = the Modulator rate.

MUX.x CPO Ovfl MUX.x CPO Out Overflw TTX CPO Overflow Verify internal and external MUX rates. 
Verify MCPC stack configuration. Ensure encoder MUX rates are 
in sync.

MUX.x CPO Sync MUX.x CPO Sync Loss TTX CPO Sync Loss Verify internal and external MUX rates. 
Verify MCPC stack configuration. Ensure encoder MUX rates are 
in sync.

MUX.x CPO Underflow MUX.x CPO Output Underflow TTX CPO Underflow Verify internal and external MUX rates. 
Verify MCPC stack configuration. Ensure encoder MUX rates are 
in sync.

MUX.x EPO Ovfl MUX.x EPO Out Ovrflw TTX EPO Overflow Verify internal and external MUX rates. 
Verify MCPC stack configuration. Ensure encoder MUX rates are 
in sync.

MUX.x EPO Sync MUX.x EPO Sync Loss TTX EPO Sync Loss Verify internal and external MUX rates. 
Verify MCPC stack configuration. Ensure encoder MUX rates are 
in sync.

MUX.x EPO Underflow MUX.x Ext Output Underflow TTX EPO Underflow Verify internal and external MUX rates. 
Verify MCPC stack configuration. Ensure encoder MUX rates are 
in sync.

MUX.x Ext Input MUX.x Ext Input Loss TTX External Input Loss Verify input connections.
Verify external transport stream.
Ensure input source is in proper format and conforms to specified 
input levels.

MUX.x Ext Sync Loss MUX.x Ext Inp Sync Err TTX External Input Sync Loss
Occurs when configuring stack 
and unit encounters momentary 
loss of signal. 

If unit is functioning normally, clear faults and continue operations.
If unit continues to log this as a current fault, reset unit. 

MUX.x Ext Tab MUX.x Ext Table Ovrfl TTX ECPI Overflow Verify internal and external MUX rates. 
Verify MCPC stack configuration. Ensure encoder MUX rates are 
in sync.

MUX.x Init MUX.x Init Error Mux Initialization Error Power cycle the unit.
If normal operations do not resume, contact Tiernan Customer 
Service.

MUX.x LCPI Tab MUX.x Loc Table Overfl TTX LCPI Overflow Verify internal and external MUX rates. 
Verify MCPC stack configuration. Ensure encoder MUX rates are 
in sync.

MUX.x Loc Input MUX.x Loc Input Loss TTX Local Input Loss If current fault, reset unit. If unit continues to fail, contact Tiernan 
Customer Service.
If in fault history log, clear faults and continue operations.

MUX.x Loc PAT MUX.x Loc PAT Timeout TTX Local PAT (program 
association table) Timeout
Occurs on power-up. 

If unit is functioning normally, clear faults and continue operations.
If unit continues to log this as a current fault, reset unit. 

TE6000A Fault Summary (continued)

Front Panel Display Remote Unit Display Description Action Required
76 01-0873-401B 06/02 Troubleshooting



MUX.x Loc Sync MUX.x Loc Input Sync TTX Local Input Sync Loss
Occurs when configuring stack 
and unit encounters momentary 
loss of signal. 

If unit is functioning normally, clear faults and continue operations.
If unit continues to log this as a current fault, reset unit. 

MUX.x LPI Ovfl MUX.x Loc Input Ovrflw TTX LPI Overflow Verify internal and external MUX rates. 
Verify MCPC stack configuration. Ensure encoder MUX rates are 
in sync.

MUX.x LPO Ovfl MUX.x Loc Outpt Ovrflw TTX LPO Overflow Verify internal and external MUX rates. 
Verify MCPC stack configuration. Ensure encoder MUX rates are 
in sync.

MUX.x LPO Sync MUX.x LPO Sync Loss TTX LPO Sync Loss Verify internal and external MUX rates. 
Verify MCPC stack configuration. Ensure encoder MUX rates are 
in sync.

MUX.x LPO Udfl MUX.x Loc Outpt Underflow TTX LPO Underflow Verify internal and external MUX rates. 
Verify MCPC stack configuration. Ensure encoder MUX rates are 
in sync.

no front panel fault S/W Error: Software trap encountered. Internal software error. Reset the unit.
If normal operations do not resume, contact Tiernan Customer 
Service.

no front panel fault S/W Error: Software exception 
encountered.

Internal software error. Reset the unit.
If normal operations do not resume, contact Tiernan Customer 
Service.

no front panel fault S/W Error: VxWorks internal signal 
caught. 

Internal software error. Reset the unit.
If normal operations do not resume, contact Tiernan Customer 
Service.

no front panel fault S/W Error: Hardware exception 
caught.

Internal software error. Reset the unit.
If normal operations do not resume, contact Tiernan Customer 
Service.

TAB.x Init TAB.x Init Error Table Initialization Error Power cycle the unit.
If normal operations do not resume, contact Tiernan Customer 
Service.

VE.x Init VE.x Init Error Video Encoder Initialization Error Power cycle the unit.
If normal operations do not resume, contact Tiernan Customer 
Service.

VE.x EncOvrflw VE.x ENC FIFO Overflow Video FIFO (first in, first out) 
Overflow

MUX rate is set too low.
Recalculate all bit rates and enter correct rates or select AUTO 
mode.

VE.x PesOvrflw VE.x PES FIFO Overflow Video PES (packetized 
elementary stream) FIFO 
Overflow

MUX rate is set too low.
Recalculate all bit rates and enter correct rates or select AUTO 
mode.

VI.x FormatErr VI.x Format Mismatch Analog Video Format Mismatch – 
Input format does not match set 
configuration. 

Verify source format matches configuration.
If unit continues to fail, contact Tiernan Customer Service.

VI.x Gen Loss VI.x Loss of Genlock Analog Genlock Input is Not 
Present

If GenLock source was enabled, ensure input source is in proper 
video format and conforms to specified input levels.
If unit continues to fail, disable GenLock.

VI.x Init VI.x Init Error Video Initialization Error Power cycle the unit.
If normal operations do not resume, contact Tiernan Customer 
Service.

VI.x Inp Level VI.x Input Level Large Analog Video Input Too Large Ensure input source is in proper video format and conforms to 
specified input levels.
Adjust video input signal levels.
Ensure video is terminated.

VI.x Inp Level VI.x Input Level Small Analog Video Input Too Small Ensure input source is in proper video format and conforms to 
specified input levels.
Adjust video input signal levels.

TE6000A Fault Summary (continued)

Front Panel Display Remote Unit Display Description Action Required
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Operational Problems
and Possible

Solutions

The following troubleshooting tips were designed to help you diagnose and 
correct minor operational problems in the unlikely event that you encounter 
difficulties with your TE6000A. If you try all of the suggested solutions and the 
unit still fails, contact Tiernan Customer Service. 
 

VI.x Inp Loss VI.x Loss of Input Video Main Input Not Present If unit is functioning normally, clear faults and continue operations.
If faults continue, check connections; ensure input source is in 
proper video format and conforms to specified input levels.
If unit continues to fail, reset unit.

VI.x Ovrflw VI.x D1 FIFO Overflow Digital Video D1 Video FIFO (first 
in, first out) Full

If unit is functioning normally, clear faults and continue operations.
If faults continue, check connections; ensure input source is in 
proper video format and conforms to specified input levels.
If unit continues to fail, reset unit.

VI.x Ovrflw VI.x FIFO Overflow Analog D1 FIFO (first in, first out) 
Overflow

If unit is functioning normally, clear faults and continue operations.
If faults continue, check connections; ensure input source is in 
proper video format and conforms to specified input levels.
If unit continues to fail, reset unit.

VI.x Udrflw VI.x FIFO Underflow Analog D1 FIFO (first in, first out) 
Underflow

If unit is functioning normally, clear faults and continue operations.
If faults continue, check connections; ensure input source is in 
proper video format and conforms to specified input levels.
If unit continues to fail, reset unit.

VI.x Undflw VI.x D1 FIFO Underflow Digital Video D1 Video FIFO (first 
in, first out) Empty

If unit is functioning normally, clear faults and continue operations.
If faults continue, check connections; ensure input source is in 
proper video format and conforms to specified input levels.
If unit continues to fail, reset unit.

TE6000A Fault Summary (continued)

Front Panel Display Remote Unit Display Description Action Required

Front Panel Symptoms

Problem: The front panel is not enabled, is in view-only mode, does not accept commands or 
button pushes.

Solutions: The front panel may be in lock-out mode. Unlock the front panel.

Remote Unit Monitor Symptoms

Problem: No sign-on message on the remote terminal after power-up.
Solutions: Ensure that the remote unit and the TE6000A are turned on and plugged into an active 

AC outlet.
Verify that the baud rate and parity of the remote unit communications package match 
the DVB setting of the TE6000A remote control interface. DVB settings are 38400 
baud, 8 data, no parity, and 1 stop bit.
Verify that the cable between the terminal, the TE6000A, and the Null Modem Adapter 
are properly connected.
Ensure that the DTE/DCE switch is correctly set.

Transmission or Transport Problems

Problem: Modulator transmit clock faults or frame sync faults.
Solutions: Ensure that the clock rates of the TE6000A and the modulator match.

Ensure that the coax cable is connecting the transport output connector (A SIOut) to 
the correct modulator connector (Mo dAS IIn).
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Maintenance TE6000A encoders require no periodic or preventative maintenance other than 
keeping the cooling fan intake grills free of obstruction. 

Field Software
Upgrades

The TE6000A is controlled by a built-in micro-controller equipped with a 
non-volatile memory that is used to store configuration settings, operational 
software, operational firmware, and field programmable gate array (FPGA) 
configuration files. 
For instructions on performing a field software upgrade, contact Tiernan 
Customer Service.

Decoder Problems

Problem: No video output from the decoder.
Solutions Verify that the video cabling to the encoder is correctly connected. Verify that the 

cabling from the decoder to the monitor is correctly connected.
Ensure that the TE6000A is configured for the video input source that is being 
provided.

Problem: No audio output from the decoder.
Solutions: Verify that the audio cabling to the encoder is correctly connected. 

Verify that the cabling from the decoder to the audio monitor is correctly connected.
Ensure that the TE6000A is configured for the audio input source that is being 

provided. 

Problem: No video or audio output from the decoder.
Solutions: Data link problem between the encoder and decoder. This could be caused by 

excessive satellite noise or other data corruption.

Problem: Green or black stripes across the middle of the video.
Solutions: Noisy or “dirty” AC power. Change to a “clean” power source, or use an AC power filter 

or power conditioner. 
Ensure that the input source is in the proper format and conforms to specified input 
levels.

Front Panel Symptoms
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A Specifications

VIDEO INPUT PAL (625) or NTSC (525)
■ Analog: SMPTE-170M NTSC or ITU-R BT.470-6 PAL-I/B/D, BNC connector
■ Serial Digital: SMPTE 259M SDI @ 270 Mbps, BNC connector with embedded audio

VIDEO PROCESSING MPEG-2 4:2:2 and/or 4:2:0 depending on the encoding module installed
■ Horizontal resolutions: 720, 704, 544, 480, and 352 pixels
■ Vertical resolutions: 480 (NTSC) or 576 (PAL)
■ Video data rates: 

• MPEG-2 4:2:0 Main Profile @ Main Level (1.0 to 15 Mbps)
• MPEG-2 4:2:2 Studio Profile @ Main Level (2.5 to 50 Mbps)

ASPECT RATIO ■ 4:3 and 16:9 configurable

VERTICAL BLANKING 
INTERVAL

■ Proprietary passage of NTSC line 21 closed-captions
■ ATSC closed captioning
■ DVB Teletext for World System Teletext (WST) on PAL
■ DVB 4:2:2 expanded windows carries WSS, VPS, VITC, CC, AMOL, XDS, etc.

AUDIO INPUTS ■ Two stereo or four independent analog mono channels on XLR connectors
■ Two AES/EBU digital stereo pairs on XLR connectors 
■ Two AES/EBU digital stereo pairs embedded in SDI video input per SMPTE-272M

AUDIO PROCESSING ■ MPEG Layer II
■ Sampling rates of 32, 44.1 and 48 ksps
■ Output rates from 64 to 384 kbps

AUXILIARY DATA Two independently programmable auxiliary data ports on DB-9 connectors
■ Asynchronous: 1200 to 38400 bps, EIA-232 or EIA-422 levels
■ Synchronous: 1 to 4096 kbps, resolution 1 bps, EIA-422 levels

CONTROL TABLES ■ Standalone support for fixed ATSC compliant tables
■ Internally-generated DVB®-compatible PSI/SI tables

LATENCY ■ Normal: 180 to 720 ms (transport rate dependent)
■ Low Delay: 180 ms

CONDITIONAL ACCESS ■ PGCA proprietary conditional access in the transport stream
■ BISS (Basic Interoperable Scrambling System) Mode 1 and 0

TIMING ■ Program clock reference (PCR) in the transport layer
■ Presentation time stamp (PTS) in the PES layer
■ Genlock to either incoming composite video or external composite black burst signal

TRANSPORT OUTPUT ■ MPEG-2 DVB®-compliant transport stream
■ Two DVB® ASI outputs (75 Ω BNC connector)

• Single program transport stream (SPTS/SCPC) 1 to 25 Mbps
• Multi-program transport stream (MPTS/MCPC) 1 to 70 Mbps

TRANSPORT INPUT DVB® ASI transport input (75 Ω BNC connector) for chaining encoders to create a multi-
program transport stream (MPTS/MCPC) 
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MODULATOR OUTPUT ■ QPSK, DVB®-compliant
■ Symbol Rate: 1 to 20 Msps
■ IF frequency: 52 to 88 MHz
■ Power output: -20 to -5 dBm, in 0.1 dBm steps

FAULT MONITORING Contact closure for programmable alarm conditions on an RJ-11 connector

REMOTE CONTROL ■ EIA-232-D on a DB-9 connector, DTE or DCE configurable, ASCII commands
■ IEEE 802.3 10baseT (Ethernet) on an RJ-45 connector, ASCII commands
■ SNMP v2

FRONT PANEL CONTROL ■ Pushbuttons, illuminated LCD, bright indicator LEDs, AC power switch
■ 20 user-programmable preset configurations

PHYSICAL ■ 2U: 8.9 cm high, 44.5 cm wide, 53.3 cm deep (3.5” x 17.5” x 21”)
■ Weighs less than 12.7 kg ( 28lbs.)

POWER SUPPLY ■ Auto-ranging 100 to120VAC and 200 to 240VAC
■ 50/60 Hz universal power supply
■ 100 Watts typical

OPERATING CONDITIONS Ambient temperature: 0° to +50° C

Specifications subject to change without notice
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BVBI Data Transmission

Overview The Tiernan TE6000A and the latest series of Tiernan decoders, such as the 
TDR60, can be configured to transmit various types of Vertical Blanking Interval 
(VBI) data when it is present in the input video.
The following encoders and decoders support one or more methods for 
transmitting VBI data:

■ TE6000A and TE6000 – software V2.21 or later
■ TDR60 – software V4.10 or later

VBI Basics A standard NTSC TV signal consists of 525 horizontal lines, referred to as a 
frame. Each frame is divided into two fields, each with 262 ½ lines. The first 21 
lines of each field are the VBI region; the remaining lines contain the active video 
picture. 
A standard PAL TV signal consists of 625 horizontal lines, referred to as a frame. 
Each frame is divided into two fields, each with 312 ½ lines. The first 22 lines of 
each field are the VBI region; the remaining lines contain the active video picture.
For standard NTSC and PAL video encoding, the first 6 lines of the VBI region 
contain vertical timing pulses. VBI data is not allowed on these lines, however the 
remaining lines in the VBI region are available to carry any type of data. 

Typical forms of data included in the VBI of broadcast video transmissions are 
World System Teletext (WST), VPS, WSS, NABTS, Closed Captions, XDS, 
AMOL, Vchip, and VITC.

Active Picture

VBI Region

Line 22 First Line of Active Video

Line 262 Last Line of Active Video

Normal Field  for an Encoded Picture Frame

Lines 7 to 21 VBI Region}
NTSC

Line 23 First Line of Active Video

Line 311 Last Line of Active Video

Lines 7 to 22 VBI Region }
PAL
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MPEG and VBI Originally, the MPEG video compression scheme discarded all VBI information 
and included only the compressed, active video portion of the picture for 
transmission. This caused all VBI data to be lost when the video was digitally 
compressed for transmission using MPEG. 
Today, however, enhancements to the original MPEG compression system have 
provided two methods for including VBI data in digital-compressed MPEG 
streams:

■ The first method is to extract the data from the baseband video input and 
insert that data digitally into the transport stream as either a dedicated PES 
stream on a dedicated PID, as in DVB-Teletext, or as an extended data field in 
the video frame header information as in ATSC-CC.

■ The second method is to shift, or expand, the active video portion of the 
picture to include the VBI lines in the compressed picture frame, as in DVB 
4:2:2 expanded windows.

For either of these methods to work, it is required that both the encoder and 
decoder are:

■ Functionally capable of processing the required video
■ Correctly configured, either manually or via auto-sensing functionality, for 

the employed VBI method
All of the VBI schemes described in this document, with the exception of Tiernan 
Proprietary Closed Captions, adhere to industry standards and formats, defined 
either by ATSC or DVB. Tiernan Radyne ComStream equipment does inter-
operate with all other vendor’s equipment that is found to be compliant with these 
industry standards.
Tiernan’s TE6000 and TE6000A encoders and the TDR60 decoder can process 
data contained in the VBI region of a video signal according to the following 
methods and standards:

■ DVB-Teletext: – DVB standard for transmission of World System Teletext 
(WST) included on a composite analog PAL format video signal.

■ ATSC-CC – ATSC standard for transmission of Line 21 closed captions 
included on a composite analog NTSC format video signal.

■ Tiernan-CC – A Tiernan proprietary scheme for transmission of Line 21 
closed captions included on a composite analog NTSC or component digital 
(525) format video signal.

■ DVB 4:2:2 Expanded Windows – DVB standard for transmission of 16 or 32 
lines of VBI data included on a composite analog or component digital (SDI) 
format video signal. This standard supports both PAL/625 and NTSC/525 
format video standards.
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Configuring Your
System

This section describes how to configure your system for successful end-to-end 
processing of VBI data for each VBI scheme. For a detailed description of the 
front panel or remote commands used to implement the various VBI schemes, 
refer to the appropriate command sections found in this manual.

DVB Teletext
Tiernan encoders and decoders process VBI teletext data within a video signal 
according to WST standards. Teletext is supported on composite analog PAL 
format video signal only.

Hardware Requirements
■ Encoders require a TVIP-6025 module.
■ The TDR60 decoder processes VBI data in its standard configuration.

Operational Considerations
VBI teletext should not be enable with other VBI encoding formats, as teletext 
overwrites all other VBI data.

End-to-End Configuration
To configure the encoder and decoder for Teletext processing, follow these steps:
Encoder

1. Ensure that Teletext VBI data is included in the selected service video input 
signal.

2. Ensure that the video input source is set to auto or analog. Use the front panel 
command Config>Service #>Video>Input Source or the remote 
VI.<port> FMTCTL command.

3. Set the encoder to PAL mode. Issue the front panel command 
Config>Service #>Video> Format Ctrl=PAL or the remote 
VI.<port> FMTCTL PAL_N command.

4. Enable the encoder for Teletext processing. Issue the front panel command 
Config>Service #>VBI>Teletext>Enable=All or the remote
TT ENABLE ALL command.

5. Set the data ID to 1. Issue the front panel command
Config>Service # >VBI>Teletext>Data ID=1 or the remote
TT DATA_ID 1 command.

6. Set the data unit ID to 2 or 3 as appropriate. Issue the front panel command 
Config>Service # >VBI>Teletext>Data Unit ID=# or the remote 
TT UNIT_ID # command (where # = 2 or 3).

Decoder

7. Set the decoder VBI format control to manual. Issue the front panel command 
VBI>Format>VBI Format Cntrl=Manual or the remote 
VBI CONTROL MANUAL command.

8. Set the VBI format to off. Issue the front panel command
VBI>Format>VBI Format= Off or the remote VBI FORMAT OFF 
command. 
Note: To ensure the proper display of Teletext data, VBI Format must be set 
to Off.

9. Enable Teletext mode. Issue the front panel command 
VBI>Teletext>Mode=On or the remote VBI TELETEXT MODE ON 
command.
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10. Set the type of Teletext standard to be decoded, either the DVB standard or a 
vendor’s proprietary standard. Issue the front panel command 
VBI>Teletext>Standard=type or the remote
VBI TELETEXT STANDARD TYPE command.

11. To specify a particular PID within the selected service that contains Teletext 
data. Issue the front panel command VBI>Teletext>PID=PID number or 
the remote VBI TELETEXT PID NUMBER command.

ATSC Closed Captions
Tiernan encoders and decoders support industry-standard ATSC EIA-608 closed 
captions. On the encoder side, ATSC closed captions, the data found on line 21 is 
stripped out, placed in the picture header, encoded and transmitted. At the decoder 
end, the data is processed and re-inserted on line 21 for proper broadcasting.
ATSC closed captions are supported on a composite analog NTSC format video 
signal.

Operational Considerations
Ensure that VBI teletext is disabled when closed captions are enabled, as teletext 
overwrites all other VBI data. 

Hardware Requirements
■ Encoders require a TVIP-6025 module.
■ The TDR60 decoder is not currently configured to process ATSC closed 

captions. This feature will be implemented in the second quarter of 2002.

End-to-End Configuration
To configure the encoder and decoder for ATSC closed captioning, follow these 
steps:
Encoder

1. Ensure that Teletext is disabled. Issue the front panel command 
Config>Service #>VBI>Teletext>Enable=off or the remote TT 
ENABLE OFF command.

2. Ensure that closed caption VBI data is included in the selected service video 
input signal. 

3. Enable the encoder for ATSC closed captions. Issue the front panel command 
Config>Service #>VBI>CC=On or the remote
VE ATSC_CC ON command.

Decoder

4. The set-top box should automatically detect and process ATSC closed 
captions. 
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Tiernan Proprietary Closed Captions (Tiernan CC)
Using Tiernan proprietary closed captions, two lines of VBI information are 
encoded per frame (one per field) at the expense of losing two lines of active 
video (one per field). The encoded picture is simply shifted up one line to include 
the last line of VBI and to exclude the last line of active video in each field. 

This proprietary mode is intended as a method to transmit line 21 EIA-608 closed 
captions in an NTSC system without incurring more bandwidth requirements. 
Tiernan proprietary closed captions are supported on a composite analog NTSC or 
component digital (525) format video signal.

Operational Considerations
Ensure that VBI teletext is disabled when closed captions are enabled, as teletext 
overwrites all other VBI data. 

Hardware Requirements
■ Encoders will properly process Tiernan closed captions with any of the 

following modules: TVIP-6021, TVIP-6025, or TVIP-6001.
■ The TDR60 decoder processes VBI data in its standard configuration.

End-to-End Configuration
To configure the encoder and decoder for Tiernan proprietary closed captioning, 
follow these steps:
Encoder

1. Ensure that Teletext is disabled. Issue the front panel command
Config>Service #>VBI>Teletext>Enable=off or the remote
TT ENABLE Off command.

2. Ensure that closed caption VBI data is included in the selected service video 
input signal. 

3. Enable the encoder for Tiernan closed captions. Issue the front panel 
command Config>Service #>VBI>Tiernan CC=On or the remote
VE TCC ON command.

Encoded Picture Is Shifted
UP One Line

VBI Region

Line 21 Becomes First Line of Active Video
in Tiernan CC Mode

Line 261 is Last Line of Active Video in Tiernan CC Mode
Last Line of Normally Active Video Is Lost (Line 262)1 line

1 line

Tiernan CC Field for an Encoded Picture  Frame

Tiernan CC Mode is for NTSC Format Only
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Decoder

4. Ensure that Teletext mode is set to off. Issue the front panel command 
VBI>Teletext>Mode=Off or the remote VBI TELETEXT MODE OFF 
command.

5. Set the decoder VBI format control to automatically detect the type of VBI 
data to decode. Issue the front panel command
VBI>Format>VBI Format Cntrl=Auto or the remote 
VBI CONTROL AUTO command.

6. If your system requires you to manually set the type of VBI data to decode, 
follow these steps:
a. Set the decoder VBI format control to manual. Issue the front panel 

command VBI>Format>VBI Format Cntrl=Manual or the remote
VBI CONTROL MANUAL command.

b. Set the VBI format to Tiernan closed captions. Issue the front panel 
command VBI>Format>VBI Format=Tiernan CC or the remote
VBI FORMAT TIERNANCC command. 
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DVB 4:2:2 Expanded Windows, 16-line and 32-line
Tiernan encoders and decoders support both 16- and 32-line expanded windows 
operations. As with normal video encoding, the first 6 lines of the VBI region 
contain timing set-up information. Expanded Windows use the remaining lines in 
the VBI region, either 16 or 32 per frame (8 or 16 per field), to transmit data.

DVB 4:2:2 Expanded Windows is supported on a composite analog or component 
digital (SDI) format video signal. This standard supports both PAL/625 and 
NTSC/525 format video standards, and can transmit any of the following VBI 
services:

■ PAL mode: Teletext, PDC, WSS, and VPS
■ NTSC mode: ATSC Closed Captions, V-Chip, AMOL I and II, and VITC

Active Picture

VBI Region

Line 22 First Line of Active Video

Line 262 Last Line of Active Video

16-Line Expanded Windows Field  for an Encoded Picture Frame

Lines 14 to 21 VBI Data}
NTSC

Line 23 First Line of Active Video

Line 311 Last Line of Active Video

Lines 15 to 22 VBI Data }
PAL

Active Picture

VBI Region

Line 22 First Line of Active Video

Line 262 Last Line of Active Video

32-Lines Expanded Windows Field for an Encoded Picture Frame

Lines 7 to 21 VBI Data}
NTSC

Line 23 First Line of Active Video

Line 311 Last Line of Active Video

Lines 7 to 22 VBI Data }
PAL
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Operational Considerations
■ Ensure that both VBI teletext and closed captions are disable when either 16- 

or 32-line expanded windows are enabled, as teletext and closed captions 
overwrite expanded windows data. 

■ Chroma must be set to 4:2:2 for proper expanded windows operations.

Hardware Requirements
■ Encoders will properly process Expanded Windows VBI data with any of the 

following modules: TVIP-6021, TVIP-6025, or TVIP-6001.
■ The TDR60 decoder processes VBI data in its standard configuration.

End-to-End Configuration
To configure the encoder and decoder for DVB 4:2:2 Expanded Windows 
operation, follow these steps:
Encoder

1. Ensure that all other VBI schemes are disabled, including Teletext, ATSC 
closed captions, and Tiernan closed captions.

2. Ensure that VBI data is included in the selected service video input signal. 
3. Set chroma to 4:2:2 mode. Issue the front panel command 

Config>Service #>Video>Chroma=4:2:2 or the remote
VE.<port> CHROMA 4_2_2 command.

4. Configures the encoder to transmit either 16 or 32 lines of VBI information. 
Issue the front panel command Config>Service #>VBI>Expand> 
VBI_Passthru=type or the remote VE VBI_PASS type command, 
where type is set to 16_lines or 32_lines.

Decoder

5. Ensure that Teletext mode is set to off. Issue the front panel command 
VBI>Teletext>Mode=Off or the remote VBI TELETEXT MODE OFF 
command.

6. Set the decoder VBI format control to automatically detect the type of VBI 
data to decode. Issue the front panel command 
VBI>Format>VBI Format Cntrl=Auto or the remote 
VBI CONTROL AUTO command.

7. If your system requires you to manually set the type of VBI data to Expanded 
Windows, follow these steps:
a. Set the decoder VBI format control to manual. Issue the front panel 

command VBI>Format>VBI Format Cntrl=Manual or the remote
VBI CONTROL MANUAL command.

b. Set the VBI format to either 16- or 32-lines Expanded Windows. 
From the front panel, issue the command VBI>Format>VBI Format=# 
where # is set to 16-line or 32-line. 
From a remote terminal, issue the command VBI FORMAT # where # is 
set to lines16 or lines32 .
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Command Listing This section provides a detailed description of the front panel and remote 
commands used to configure Tiernan encoders and decoders for VBI operations. 

Encoder Command
Listing

Front Panel Commands for Encoder Configuration 

Teletext Commands

ATSC Closed Captions Front Panel Commands

Tiernan Closed Captions Front Panel Commands

Expanded Windows Front Panel Commands

Config>Service # >VBI>Teletext — used to configure the encoder to transmit teletext data

Enable Configures the encoder to transmit teletext 
information 

■ off – does not encode any teletext information 
(default)

■ all – encodes entire VBI teletext area; i.e., allocates 
bit-rate to include maximum number of Teletext 
lines

■ auto – automatically allocates bit-rate to include only 
the number of detected Teletext lines.

Data ID Setting determines is EBU data included in 
the Teletext. Values from 0x10 to 0x1F reflect 
EBU data. 

0 to 255
Default: 1

Data Unit ID Data Unit ID defines if there are EBU Teletext 
sub-titles included in the data. 

Data Unit ID has range from 0 to 255. Values are:
■ 2 = EBU Teletext non-subtitle data is not included 

(default)
■ 3 = EBU Teletext subtitle data is included 
Note: Data Unit ID must be set to 2 or 3 for proper 
decoder operation.

Config>Service # >VBI>CC — used to configure the encoder to transmit closed captions

ATSC CC Configures the encoder to transmit ATSC 
closed caption information 

■ on – encodes ATSC VBI information
■ off – does not encode any ATSC VBI information 

(default)

Config>Service # >VBI>CC — used to configure the encoder to transmit closed captions

Tiernan CC configures the encoder to transmit Tiernan 
closed captioning information
The Tiernan CC transmission described in 
this document is Tiernan proprietary. Only 
Tiernan decoders accommodate the 
Tiernan CC feature described in this 
document:
Note: Tiernan CC should not be 
implemented in PAL mode, as the closed 
caption information will be decoded and 
placed on line 22 of the video.

■ on – encodes two lines of VBI information per frame 
(one per field) at the expense of losing two lines of 
active video (one per field)
The encoded picture is simply shifted up one line to 
include the last line of VBI and to exclude the last line 
of active video in each field. 

■ off – does not encode any VBI information (default)
Note: Data transmitted in the VBI region using the Tiernan 
CC command will experience a degradation in quality 
given the inherently “lossy” compression of MPEG.

Config>Service # >VBI>Expand — used to configure the encoder to transmit data in 16-line or 
32-line expanded windows mode

VBI_Passthru Configures the encoder to transmit either 16 
or 32 lines of VBI information 

■ Off – disables expanded windows mode (default)
■ 16-line – enables 16-line expanded windows mode
■ 32-line – enables 16-line expanded windows mode
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Remote Commands for Encoder Configuration

Teletext Commands

ATSC Closed Captions Remote Commands 

Tiernan Closed Captions Remote Commands 

Expanded Windows Remote Commands 

Teletext Encoder Remote Commands

Remote 
Command

Parameter 
Range

Description

TT ENABLE Off, All, Auto Configures the encoder to transmit teletext information. Parameters are:
■ On = enables ATSC closed captioning
■ Off = does not encode any ATSC closed captioning information (default)
Front panel command: Config>Service>VBI>CC>ATSC CC

TT DATA_ID 0 to FF Setting determines is EBU data included in the Teletext. Values from 0x10 
to 0x1F reflect EBU data. 
Default: 1

TT UNIT_ID 0 to FF Unit ID defines if there are EBU Teletext sub-titles included in the data. Data 
Unit ID has range from 0x00 to 0xFF. Values are:
■ 0x2 = EBU Teletext non-subtitle data is not included (default)
■ 0x3 = EBU Teletext subtitle data is included 
Note: TT Unit_ID must be set to 2 or 3 for proper decoder operations.

Remote 
Command

Parameter 
Range

Description

VE ATSC_CC On, Off Configures the encoder to transmit ATSC closed captioning information. 
Parameters are:
■ On = enables ATSC closed captioning
■ Off = does not encode any ATSC closed captioning information (default)
Front panel command: Config>Service>VBI>CC>ATSC CC

Remote 
Command

Parameter 
Range

Description

VE TCC On, Off Configures the encoder to transmit Tiernan closed captioning information. 
Parameters are:
■ On = encodes two lines of closed captioning information per frame (one 

per filed) at the expense of losing two lines of active video (one per field)
■ Off = does not encode any closed captioning information (default)
Front panel command: Config>Service>VBI>CC>Tiernan CC

Remote Command Parameter 
Range

Description

VE VBI_PASS Off, 16_LINES, 
32_LINES

Configures the encoder to transmit either 16 or 32 lines of VBI information
■ Off – disables expanded windows mode (default)
■ 16_lines – enables 16-line expanded windows mode
■ 32_line – enables 16-line expanded windows mode
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Decoder Command
Listing

Front Panel Commands for Decoder Configuration 
The following front panel commands are used to configure the decoder for VBI 
teletext. 

TDR60 Decoder VBI Front Panel Menu

Menu>SubMenu Description Parameters or Response Format

VBI>Teletext: used to set the teletext parameters

Active Line Query-only; displays the number of the first 
active line of teletext received.

Displays either: 
■ No active lines
■ the number of first active line received

Mode Providing that teletext is available in the selected 
service, the Mode function allows you to 
determine whether the teletext data will be 
included in the video output stream. 

■ On – Teletext data is included in the video 
output stream

■ Off – Teletext data is not included in the 
video output stream (default)

Note: To ensure proper display of teletext, 
VBI>Format>VBI Format must be set to Off.

PID Selects the teletext PIDs available in the 
selected service. The TDR60 automatically 
selects the first PID available in the selected 
service.

List of teletext PIDs available in the selected 
service.

Standard Sets the inversion or non-inversion of teletext 
data.

■ DVB – sets DVB teletext standard (default)
■ Proprietary — sets proprietary teletext 

standard

VBI>Format: used to set the teletext parameters

VBI Format Providing that the selected VBI information is 
available in the selected service, this command 
determines if the data will be included in the 
video output stream.
Note: This command is query-only when 
VBI>Format>VBI Format Cntrl is set to Auto.

■ Off – VBI mode is disabled (default)
■ Tiernan CC – Tiernan proprietary closed 

caption information will be included
■ Lines 16 – Expanded windows lines-16 

information will be included; for PAL modes 
this includes VBI information found in lines 15 
to 22; in NTSC mode this includes VBI 
information in lines 14 to 21.

■ Lines 32 – Expanded windows lines-32 
information will be included; for PAL modes 
this includes VBI information found in lines 7 
to 22; in NTSC mode this includes VBI 
information in lines 7 to 21.

VBI Format Cntrl Setting determines if the TDR60 will 
automatically detect incoming VBI data or if the 
VBI format will be manually configured by the 
operator.

■ Auto – TDR60 automatically detects the 
format of the incoming VBI information. 
When Auto is selected, VBI>Format>VBI 
Format is query only.

■ Manual – enables the operator to manually 
configure the VBI format. (default)
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Remote Commands For Decoder Configuration
The following front panel and remote commands are used to configure the 
decoder for VBI teletext. 

Remote Command 
Mnemonic

Parameter Range Description

VBI CONTROL Auto, Manual Setting determines if the TDR60 will automatically detect 
incoming VBI data or if the VBI format will be manually 
configured by the operator.
■ Auto – TDR60 automatically detects the format of the 

incoming VBI information. 
When Auto is selected, VBI CONTROL is query only.

■ Manual – enables the operator to manually configure the 
VBI format. (default)

VBI FORMAT Off, TiernanCC, 
Lines16, Lines32

Providing that VBI information is available in the selected 
service, this command determines if the data will be included in 
the video output stream.
Note: This command is query-only when VBI FORMAT is set to 
AUTO.
■ Off – VBI mode is disabled (default)
■ TiernanCC – Tiernan proprietary closed caption information 

will be included
■ Lines16 – Expanded windows lines-16 information will be 

included; for PAL modes this includes VBI information found 
in lines 15 to 22; in NTSC mode this includes VBI 
information in lines 14 to 21.

■ Lines32 – Expanded windows lines-32 information will be 
included; for PAL modes this includes VBI information found 
in lines 7 to 22; in NTSC mode this includes VBI information 
in lines 7 to 21.

VBI TELETEXT LINES — Query-only; displays a list of the teletext lines detected in the 
selected service or the message no active lines 
when teletext is not present.
Available only when VD MODE is set to NTSC.
Front panel equivalent: VBI>Active Line

VBI TELETEXT MODE On, Off Providing that teletext data is available in the selected service, 
this function allows you to determine whether teletext data will 
be included in the output stream. 
■ On – data will be included
■ Off – data will not be included (default)
Teletext is only available only when VD MODE is set to PAL.
Note: To ensure proper display of teletext, VD CC must be set 
to Off.
Front panel equivalent: VBI>Mode

VBI TELETEXT PID <available PIDs> or Off Selects the teletext data PID from the selected service.
To query available PIDS, enter the command VBI TELETEXT 
PID ?
Available only when VD MODE is set to PAL.
Front panel equivalent: VBI>PID

VBI TELETEXT STANDARD DVB, Proprietary Sets the inversion or non-inversion of teletext data.
■ DVB – sets DVB teletext standard (default)
■ Proprietary — sets proprietary teletext standard
Available only when VD MODE is set to PAL.
Front panel equivalent: VBI>Standard
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CConditional Access

Conditional Access
Overview

Conditional access (CA) is a method for securing and scrambling transmission 
streams so that only those decoders which are authorized to do so can receive the 
transmitted streams. 
The TE6000A provides two methods for conditional access: 

■ BISS – an industry-standard scheme which allows full conditional access 
operability between various vendor’s DSNG equipment

■ PGCA – a Tiernan proprietary scheme providing conditional access within 
the Tiernan family of products

BISS Overview BISS, the Basic Interoperable Scrambling System, is an industry-standard, 
conditional access scheme used to secure and scramble DSNG broadcasts while 
allowing full inter-operability between various vendor’s DSNG equipment. 
The TE6000A currently supports BISS Mode 1 scrambling. With Mode 1, all 
components of the transmission stream are scrambled by a fixed control word 
(CW). The control word must be manually entered into the encoder and decoder 
for BISS operations.

High-level BISS
Procedure

BISS is managed and enabled at an individual service level. To configure the 
TE6000A for BISS operations, follow these steps:
1. Select the service for BISS conditional access.
2. Enable BISS for that service.
3. Enter the Scramble key.

Configuring BISS
from the Front Panel

To configure the TE6000A for BISS operations, follow these steps:

Select a Service
1. From the main menu, select Config>CA>Setup>Service. A list of all 

available services displays. 
If only one service is available, the service parameter is query-only, as this 
one service is automatically selected.

2. Scroll through the list to select the service to be configured for BISS 
scrambling and press Enter. The Scramble menu displays. 

3. Ensure that the correct service name displays in the menu line. If the 
displayed service is incorrect, return to step 1.

Enable BISS for that Service
4. From the Scramble menu, select BISS Mode 1 and press Enter. 
5. When the asterisk disappears, press the right arrow key to go to the BISS key 

parameter.

Enter the Scramble Key
6. Use the numeric keypad to enter the 12-digit key. Once all 12 digits are 

entered, the key will begin to flash. Press Enter. 
When the asterisk disappears, the BISS configuration settings are 
immediately implemented for that service. 
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Continue to Enable and Disable Individual Services, as Required
7. Continue selecting services and enabling/disabling each as required.

TE6000A is Now Processing Data Using the Current BISS Configuration
8. BISS is now enabled and will continue to use the current BISS configuration 

until BISS is disabled (turned off) or the BISS configuration is changed.

Disable BISS for an Individual Service
To disable BISS for a selected service, perform these steps:
1. From the main menu, select Config>CA>Setup>Service. A list of all 

available services displays. 
2. Scroll through the list to select the service to be configured for BISS 

scrambling and press Enter. 
The Scramble menu displays. Ensure that the correct service name displays in 
the menu line.
If the displayed service is incorrect, return to step 1.

3. From the Scramble menu, select None and press Enter.
Conditional access is now disabled for the selected service.

Even though BISS conditional access may be disabled for a service, the TE6000A 
retains the BISS scramble key set for that service.

Configuring BISS
from a Remote Unit

Before you begin configuring the encoder for BISS conditional access, you must 
have a remote unit with a communications program installed, such as ProComm.

Connect to a Remote Unit
1. Ensure that the remote unit has a communications program installed, such as 

ProComm.
2. Connect an RS-232 cable from the PC COM port 1 to the TE6000A RS-232 

port.
3. Start the ProComm software.  Configure ProComm to communicate via 

COM port 1 at a baud rate of 38400 bps.
4. Power on the encoder.  
5. Wait for the main menu to display on the encoder’s front panel.
6. ProComm should display various messages and then end with the prompt >. 

If the > prompt does not display, flip the DCE/DTE switch on the back of the 
TE6000A to the other position. Press the Enter key on the keyboard several 
times. The > prompt should display .

Configure BISS Parameters
1. Review the current BISS configuration parameters for all active services. 

Type mux prog_info and press Enter.
The current conditional access settings for all services is displayed. 
Information includes: program number, program name, previous scrambling 
mode, current scrambling mode, and the key.

2. Enable BISS for a service. Type mux scram_en <service#> mode_1 
and press Enter.
This command enables BISS scrambling mode 1 for the service number 
entered in the <service#> parameter.
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3. Enter the Scramble key for the selected service. 
Type mux scram_key <service#> <key> and press Enter.
This command sets the BISS scrambling key for the service number entered 
in the <service#> parameter. The key is a 12-digit hexadecimal number.

4. Disable BISS for any services, as required. 
Type mux scram_en <service#> off and press Enter.

5. Review the current BISS configuration parameters for all active services to 
ensure that all BISS settings are correct. Type mux prog_info and press 
Enter.

6. Enable BISS at the system level. Type mux biss_en on and press Enter.
Note: BISS cannot be enabled if PGCA is enabled.

Save the Current BISS Configuration
7. Save the current BISS configuration to either:

❒ Flash memory using the CM Save command
❒ A user-defined configuration set, using the cm create and

cm save_cfg commands.
Any parameter changes, including conditional access changes, that are made 
using a remote unit are not automatically stored in flash memory. When the 
TE6000A configuration is changed using a remote unit, an operational test 
should be performed to verify that the system is operating correctly. Then the 
new configuration should be saved by issuing the cm save command. 
If the TE6000A is reset, or looses power prior to issuing the cm save 
command, any changes made using the remote unit will not be restored. 
Instead, the TE6000A restores the last changes saved to flash memory. Once 
the configuration is saved using the cm save command, the TE6000A 
automatically restores the saved settings when the unit is reset or powered up.

To Disable BISS

For a Service
Type mux scram_en <service#> off and press Enter.

At the System Level
Type mux biss_en off and press Enter.
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Tiernan PGCA
Overview

PGCA, Privacy Guard Conditional Access, is a Tiernan-proprietary conditional 
access scrambling system supported by all Tiernan DVB-compatible encoders and 
decoders.
PGCA is a fixed key scrambling system that is addressible.  This means that the 
scrambling key is included in the transport stream, along with the list of individual 
decoder addresses authorized to descramble the transmission.  
Using PGCA allows the uplink to control which decoders are authorized to 
receive the transmission, and what key is used to scramble the stream.  The 
decoders automatically receive and process the authorization list.  If they are 
authorized to receive the transmission, they extract the key and use it to 
descramble the service.  If they are not authorized, they do not descramble or 
decode the service, and there is no output of video or audio from the decoder.  
Although this is a fixed key system, the addressibility and in-band transmission of 
all information required to authorize and descramble the service is very powerful 
for controlling groups of IRDs and the services they are allowed to receive, 
without compromising the security by distributing the scrambling key in the clear 
to the decoders.  The “fixed” key is programmable and can be changed by the 
uplink encoder operator if desired.
Managing the key and the decoder authorization list is simple to do using the 
encoder front panel menu or remote control commands.  No control computer or 
special software is necessary.  PGCA is included in all Tiernan DVB-compliant 
encoders and decoders as a standard feature, so there are no additional costs to use 
PGCA in a system.

High-level PGCA
Procedure

PGCA is managed at an individual IRD level and enabled at the system level. To 
configure the TE6000A for PGCA operations, follow these steps:

1. Manage the IRD List.
a. Review the IRD conditional access list to ensure that all IRDs are listed 

and that all IRD information is correctly.
b. Add IRDs to the conditional access list, as needed.

A decoder’s MAC address is required in order to create an authorized 
decoder database. This address must be entered in the following 
16-character hexadecimal format. The TE6000A automatically enters the 
decimal points: XX.XX.XX.XX.XX.XX.XX.XX 
If you do not know a decoder’s MAC address, navigate through the 
decoder’s front panel menu to locate the information: 
• On the TDR600, TDR77, and TDR777 decoders, the MAC address is 

displayed on the System>Status>ID:xxxxxxxxxxxxxxxx 
menu.

• On the TDR7 and TD3 decoders, the MAC address is displayed on 
the System>ID:xxxxxxxxxxxxxxxx menu.

• On the TDR6 decoder, the MAC address is displayed on the 
Control>Network>Addr:xxxxxxxxxxxx menu.
The MAC address on the TDR6 decoder is missing two bytes. To 
enter this number into the MAC address field when creating the 
authorized decoder database, simply add zeros to the most significant 
bits, for example: 00.00.xx.xx.xx.xx.xx.xx 

c. Delete IRDs from the conditional access list, if required
d. Enable and disable individual IRDs, as appropriate.
98 01-0873-401B 06/02 Conditional Access



2. Enable PGCA at the System Level
e. Enable PGCA. 

When PGCA is enabled, all current PGCA configuration settings are 
immediately implemented. As you enable and disable individual IRDs, 
those configuration settings are immediately implemented as well. 
If you do not want the TE6000A to immediately implement your PGCA 
configurations settings, you should set Scramble to None, configure the 
individual IRDs, and, when ready to implement PGCA, set Scramble to 
PGCA .

f. Enter the PGCA Key. 
g. For front panel configurations, PGCA is now enabled and will continue 

to use the current PGCA configuration until PGCA is disabled (tuned off) 
or the PGCA configuration is changed. 
As with all other front panel configuration changes, PGCA changes are 
automatically saved and immediately implemented. 

h. For remote unit configuration, the new PGCA configuration must be 
saved.

During PGCA set-up and configuration, signals may be temporarily unscrambled.

The high-level procedure for configuring PGCA from the front panel or a remote unit is the same, 
however, at the detailed step-by-step level, there are a few important differences which must be 
followed. Before configuring the TE6000A from the front panel or remote unit, carefully read and 
follow these instructions.

Configuring PGCA
from the Front Panel

Before you begin configuring the encoder for PGCA, you must have the TMA 
addresses for each of the decoders in your system. 
To configure the TE6000A for PGCA, follow these steps:

Manage the IRD List

Review the IRD Conditional Access List
1. Review the IRD conditional access list to ensure that all IRDs are listed, all 

IRD information is correct, and that each IRD are correctly enabled and 
disabled.
To review the IRD list, select Config>CA>PGCAcfg>LST IRD. The IRD 
List menu displays, showing the following information for each IRD: name of 
the IRD, it’s MAC address, and if it is enabled (on) or disabled (off).

2. Add, deleted, and enable and disable IRDs as needed.

Add IRDs to the Conditional Access List, as Needed
3. From the PGCAcfg menu, select ADD IRD. The Name menu displays with 

the parameter Name = 0.
4. Enter the name for the IRD using the alpha-numeric keypad and press Enter.

The Enter TMA Address menu displays.
5. Enter the 16-character MAC address for the IRD using the alphanumeric 

keypad. Press Enter. 
When the information is processed, the system returns to the Name menu.

NOTE

NOTE
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6. Continue to add all IRDs to the conditional access list.
7. When you have finished adding IRDs to the conditional access list, press Exit 

to return to the PGCA menu.

Delete an IRD from the Conditional Access List, if Required
8. From the PGCAcfg menu, select DEL IRD. The IRD Delete menu displays. 
9. Use the Up and Down buttons to scroll through the list and select the required 

IRD.
10. Press Enter. The LCD will display Delete <IRD name> Yes [No]
11. Ensure that the correct IRD name is displayed and select Yes.
12. Press Enter. When the information is processed, the system returns to the 

PGCA menu.

View the IRD Conditional Access List
13. View the IRD conditional access list to ensure that all IRDs are listed and that 

all IRD information was correctly entered.
14. From the PGCAcfg menu, select LST IRD. The IRD List menu displays. 

For each IRD, the following information is displayed: name of the IRD, it’s 
MAC address, and if it is enabled (on) or disabled (off).

Enable and Disable Individual IRDs
15. From the PGCAcfg menu, select LST IRD. The IRD List menu displays. 
16. Use the Up and Down buttons to scroll through the list and select the required 

IRD.
17. Enable or disable the selected IRD. Use the minus sign (-) on the 

alpha-numeric keypad to toggle between On and Off for the selected IRD.
18. Continue selecting IRDs and enabling/disabling each as required.
19. Press Enter. When the information is processed, the system returns to the 

PGCAcfg menu.

Enable PGCA at the System Level

Enable PGCA
20. From the main menu, select Config>CA>Setup>Service>Scramble>PGCA.

Enter the Scramble Key
21. Select PGCA KEY. Type in the key using the alpha-numeric keypad and 

press Enter.

TE6000A is Now Processing Data Using the Current PGCA Configuration
22. PGCA is now enabled and will continue to use the current PGCA 

configuration until PGCA is disabled or the PGCA configuration is changed.

To Disable PGCA at the System Level
To disable PGCA at the system level, select Config>CA>Setup>Service> 
Scramble>None.
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Configuring PGCA
from a Remote Unit

Before you begin configuring the encoder for PGCA, you must have the 
following:

■ A remote unit with a communications program installed, such as ProComm.
■ The TMA addresses for each of the decoders in your system. 

Connect to a Remote Unit
1. Ensure that the remote unit has a communications program installed, such as 

ProComm.
2. Connect an RS-232 cable from the PC COM port 1 to the TE6000A RS-232 

port.
3. Start the ProComm software.  Configure ProComm to communicate via 

COM port 1 at a baud rate of 38400 bps.
4. Power on the encoder.  
5. Wait for the main menu to display on the encoder’s front panel.
6. ProComm should display various messages and then end with the prompt >. 

If the > prompt does not display, flip the DCE/DTE switch on the back of the 
TE6000A to the other position. Press the Enter key on the keyboard several 
times. The > prompt should display .

Enable PGCA at the System Level
1. Type tca enable on and press Enter.

Note: PGCA cannot be enabled if BISS is enabled.

Enter the PGCA Scramble Key
2. Type tca mask <value> and press Enter.

Manage the IRD List

View the IRD Conditional Access List
3. Type tca list and press Enter.

Add IRDs to the Conditional Access List
4. Type tca add <decoder name>@<decoder TMA Address> and press 

Enter.
Decoder names are limited to 15 characters in length or less. Decoders are 
automatically authorized when they are added to the list.

5. Repeat for all required decoders.

Delete IRDs from the Conditional Access List
6. Type tca delete <decoder name> and press Enter.
7. Repeat for all required decoders.

Enable Individual IRDs
An enabled, or authorized, decoder will be able to unscramble the incoming 
transmission from the encoder.
8. Type tca auth <decoder name> and press Enter.
9. Repeat for all required decoders.
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Disable Individual IRDs
A disabled, or deauthorized, encoder will not be able to unscramble the incoming 
transmission from the encoder.
10. Type tca deauth <decoder name> and press Enter.
11. Repeat for all required decoders.

TE6000A is Now Processing Using the Current PGCA Configuration
12. PGCA is now enabled and will continue to use the current PGCA 

configuration until PGCA is disabled (tuned off) or the PGCA configuration 
is changed.

Save the Current PGCA Configuration
13. Save the current PGCA configuration to either:

❒ Flash memory using the CM Save command
❒ A user-defined configuration set, using the cm create and

cm save_cfg commands.
Any parameter changes, including conditional access changes, that are made 
using a remote unit are not automatically stored in flash memory. When the 
TE6000A configuration is changed using a remote unit, an operational test 
should be performed to verify that the system is operating correctly. Then the 
new configuration should be saved by issuing the CM SAVE command. 
If the TE6000A is reset, or looses power prior to issuing the CM SAVE 
command, any changes made using the remote unit will not be restored. 
Instead, the TE6000A restores the last changes saved to flash memory. Once 
the configuration is saved using the CM SAVE command, the TE6000A 
automatically restores the saved settings when the unit is reset or powered up.

To Disable PGCA at the System Level
14. Type tca enable off and press Enter.

PGCA Remote Unit
Configuration

Example

The following example shows how to add, delete, enable (authorize) and disable 
(de-authorize) decoders using a remote unit connected to a TE6000A. At the end 
of the example, the PGCA configuration is saved to flash memory.
In this example, the following assumptions apply:

■ Two decoders already exist in the database; both are enabled for PGCA. The 
existing decoders are:
❒ decoder1@11.22.33.44.55.66.77.88
❒ decoder2@22.33.44.55.66.77.88.99

■ Decoder1 will be disabled
■ Decoder2 will be deleted from the database
■ Three new decoders will be added to the database and remain authorized.

Enable PGCA
tca enable on

Enter the PGCA Scramble Key
tca mask <value>

Deauthorize decoder – decoder1 is disabled, or deauthorized
tca deauth decoder1
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Remove decoder – decoder2 is deleted from the PGCA database
tca delete decoder2

Add decoders – three decoders are added to the PGCA database
tca add decoder3@33.44.55.66.77.88.99.00
tca add decoder4@44.55.66.77.88.99.00.11
tca add decoder5@55.66.77.88.99.00.11.22

When decoders are added to the database, they are automatically authorized, 
or enabled; therefore, these three new decoders do not have to be authorized 
using the tca auth command.

Review the IRD conditional access list to ensure it is correct
tca list

The TE6000A displays the following:
Decoder 0x586bd0
ID: 11.22.33.44.55.66.77.88
Auth: Deauthorized
Name: decoder1

Decoder 0x586dd0
ID: 33.44.55.66.77.88.99.00
Auth: Authorized
Name: decoder3

Decoder 0x586ad0
ID: 44.55.66.77.88.99.00.11
Auth: Authorized
Name: decoder4

Decoder 0x586cd0
ID: 55.66.77.88.99.00.11.22
Auth: Authorized
Name: decoder5

The list is correct, save the PGCA configuration changes to flash
cm save
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DIF Looptest 

An IF looptest is performed before installing the TE6000A and before sending the 
unit out for field deployment. The IF looptest helps you verify proper cabling and 
configuration of the equipment prior to beginning operations.
The looptest procedure is illustrated in the following diagram.

Required Equipment The following equipment is required to perform an IF looptest using the front 
panel:

■ IF to L-band upconverter
■ A compatible integrated receiver/decoder (IRD) such as a TDR6 4:2:2 

MPEG-2 receiver/decoder, or TDR777 4:2:0 MPEG-2 receiver/decoder
■ Video source (test pattern generator, camera, VTR, or equivalent)
■ Video input cable (BNC)
■ Audio source (test tone generator, camera audio, VTR audio, or equivalent)
■ Two audio input cables (analog or digital)
■ ASI coaxial cable (BNC)
■ Baseband video monitor (NTSC, PAL, or auto-detecting)
■ Video output cable (BNC)
■ Baseband audio monitor
■ Audio output cables
■ Modulator output cable (to cable the BNC connector output of the modulator 

to an upconverter)
■ Looptest cable with an F-type connector to cable the upconverter to an IRD

You may also need other cables and test equipment, depending upon your 
site-specific installation and testing requirements.

Satellite
Looptest

IF
Looptest

70 MHz
IF

L-Band IF
(950 to 2050 MHz)

TE6000A Internal
Satellite Modulator

Digital
Looptest

TE6000A
MPEG-2 Encoder

Video

Audio

Audio

Video

Tiernan MPEG
Receiver/Decoder

(IRD)

70 MHz to L-Band
Up-converter
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Setting Up the
TE6000A

Placement
To begin the IF looptest, set the unit on a stable bench or table-top, where you 
have easy access to the rear panel for cabling. 

Cabling and Connections
To cable the TE6000A for an IF looptest perform the following steps.
1. Ensure that the TE6000A On/Off switch is in the Off position.
2. Connect the AC line cord to the TE6000A rear panel and then to an AC outlet. 

For U.S. and Canadian applications, use the IEC 320 power cord. For 
international applications, refer to Chapter 2 for power cord selection and 
installation. 

3. Cable the video input to the TE6000A with a coaxial BNC compatible cable. 
The TE6000A provides both a serial digital connector and a composite analog 
input connector. 

4. Cable the audio channel A input to the TE6000A with an XLR connector. The 
TE6000A provides analog audio A left and right connectors as well as a serial 
digital audio A connector.

5. Cable the audio channel B input to the TE6000A with an XLR connector. The 
TE6000A provides analog audio B left and right connectors as well as a 
digital audio B input connector.

6. Cable the ASI Out Primary transport output to the MOD ASI IN.
7. Cable the modulated output of the modulator from the TX IF OUT port to the 

L-band upconverter using the modulator output cable.
8. Cable the output of the upconverter to the appropriate input port of an IRD 

using the looptest cable.
9. Cable the video and audio outputs from the IRD to the appropriate output 

devices.

For specific instructions on cabling and configuring the IRD, refer to the appropriate IRD operator 
manual.

Powering the Equipment
Once the cabling and interconnections for both the TE6000A and the selected IRD 
are completed, you may power-up the units. Ensure that the video and audio 
sources and output monitors are also powered-up and operating properly.
When the TE6000A is powered-up, the green power LED illuminates. The 
power-on cycle takes approximately 3-4 minutes to complete, as the TE6000A 
performs extensive self-diagnostics in this time period. During the power-up 
process, the TE6000A will display Initializing, and the Status LED may 
blink.

TE6000A Looptest
Configuration

The TE6000A is now ready to be configured for an IF looptest. The steps required 
to configure the TE6000A are:
1. Initialize the TE6000A to the factory DVB default settings. 
2. Select the video source.
3. Select the audio source.

NOTE
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Initializing to the DVB Defaults
To initialize the TE6000A to the DVB default settings using the front panel, 
perform the following steps.
1. From the main menu, select Config>Presets> Restore.
2. The Restore menu displays. Select DVB.

The configuration option that appears on the LCD, for example DVB, is the 
current TE6000A configuration. 
Note: If the LCD initially displays DVB, as the selected configuration the 
TE6000A was initialized to the default DVB configurations. However, some 
or all of the parameters may have been manually changed since the unit was 
initialized. To ensure that all of the TE6000A parameters are set to the default 
DVB configuration, scroll through the configuration options and select DVB.

3. Press Enter. 
4. Initializing displays for a few seconds.
5. When the LCD displays the main menu, the TE6000A is set to the default 

DVB configuration.

Selecting the Video Source
Next, select the video source which will be used for the test. To select a video 
source:
1. From the main menu, select Config>Service>Video.
2. The Enable option, followed by the default setting, is displayed.
3. Scroll through the list until the Input Source parameters displays.
4. Select the required Input Source option and press Enter button. The selected 

parameter flashes for a few seconds. When it stops flashing, the TE6000A has 
set the parameter.

Selecting the Audio Source
After the video source is selected, the audio source is selected. To select an audio 
source, perform the following steps:
1. From the main menu, select Config>Service>Audio.
2. From the Audio menu select the type of audio input, either Digital or Analog. 

The LCD displays the selected audio menu.
3. Select the required audio slot option. The LCD displays the Enable option 

followed by its current setting.
4. Set the Enable option to On. 
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IRD Looptest
Configuration

Once you have configured the TE6000A for the IF looptest, you must set the IRD 
to match the TE6000A configuration. To configure the IRD system parameters, 
refer to the operator’s manual which accompanied that IRD, and perform the 
following steps:
1. Initialize the IRD to the DVB defaults.
2. Set the decoder RF frequency.
3. Set the decoder LO frequency.

Once the RF and the LO frequencies are correctly set, you are ready to begin 
the IF looptest.

Performing the IF
Looptest

After you have configured both the TE6000A and the IRD, check the IRD to 
ensure that the demod, decoder, and transport functions all display locked. If any 
of the functions display unlocked:

■ Ensure that you have set the TE6000A and IRD parameters correctly
■ Use the troubleshooting guide provided in this manual and in the IRD 

operator manual to isolate and correct any problems
■ Contact Tiernan Customer Service if you need assistance

Once the IRD demod, decoder, and transport functions all display locked, 
continue to the operational fault check section.

Operational Fault
Check

To perform an operational fault check, perform these steps:
1. Clear the fault history memory for both the TE6000A and IRD using the front 

panel menus. 
2. Verify that the TE6000A Status LED is illuminated green, indicating normal 

operation with no faults.
3. The TE6000A is designed to present flawless video and audio. If the video is 

not clean, the audio is not clear, or if faults are occurring, use the 
troubleshooting chapter of this manual to correct any faults.

Testing the TE6000A
Operational Features

While your system is configured for the IF looptest, you can also perform a few 
operational tests to evaluate the effectiveness of various parameters for your 
operations. 
For example, you may want to observe video performance at resolutions other 
than 720 pixels per line, or you may want to disable audio channel B to allocate 
more transport bits to the video. Increased bits allocated to video will improve 
performance of fast moving complex video scenes passing through the 
compression system.
For a complete list of configuration commands and parameters, refer to the 
chapters on front panel and/or remote unit operations.
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ETE6000A Default Settings

This appendix provides the default settings for the TE6000A DVB and ATSC 
factory configurations. All parameter settings are the same for all factory defaults, 
except where noted.
The TE6000A is set to the DVB-compliant defaults at the factory. 
 

 

Video Encoder Default Settings

Parameter DVB and ATSC Defaults Exceptions

Data Rate Calc Auto —
Enable On —
Format Mode Auto —
Optimize Quality —
PID 33 decimal —
Resolution 720 —
Data Rate ■ if analog: 7.443 Mbps

■ if digital: 8.0563 Mbps
—

Chroma 4:2:0 —
Timebase Video Input —
Source Analog —
PGCA Off —

Audio Encoder Default Settings

Parameter DVB and ATSC Defaults Exceptions

Audio Channel A

Enable ■ if digital audio: off
■ if analog audio: on

—

Compression MPEG —
Data Rate 256 Kbps —
Format Stereo —
PID 36 decimal —
Sample Rate 48 KSps —
Source Analog —
Lip Sync 0 msec —
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Audio Channel B

Enable ■ if digital audio: off
■ if analog audio: on

—

Compression MPEG —
Data Rate 256 Kbps —
Format Stereo —
PID 37 decimal —
Sample Rate 48 KSps —
Source Analog —

Lip Sync 0 msec —

Aux Data Channels Default Settings

Parameter DVB and ATSC Defaults Exceptions

Aux Data Channel A

Enable Off —
Communication Mode Asynchronous —
Interface RS-232 —
Data Rate 102400 bps —
Baud 38400 bps —
Data Bits 8 —
Parity none —
Stop Bits 1 —
Clock Source Internal —
PID 42 decimal —

Aux Data Channel B

Enable Off —
Communication Mode Asynchronous —
Interface RS-232 —
Data Rate 102400 bps —
Baud 38400 bps —
Data Bits 8 —
Parity none —
Stop Bits 1 —
Clock Source Internal —
PID 42 decimal —

Audio Encoder Default Settings (continued) (continued)

Parameter DVB and ATSC Defaults Exceptions
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Multiplexer TTX Output Default Settings

Parameter DVB and ATSC Defaults Exceptions

Program Clock Reference 
(PCR) PID 

8190 —

Mode SCPC —
Redundant State Standby —
Rate Calc Auto —
Table Types — DVB: DVB

ATSC: ATSC
Local Input Enable —
Locally Generated 
Transport Stream

8.448 Mbps —

SMPTE Output Disable —
Output 8.448 Mbps —

Modulator Factory Default Settings

Parameter DVB and ATSC Defaults Exceptions

Internal Transport Stream 
Data Rate

8.448 Mbps —

Viterbi Rate 5/6 —
Transmit Power –5.0dBm —
Transmit Frequency 70.0 MHz —
Transmit (RF) Output On —
Spectrum Inversion Normal —
Symbol Rate 5.500187 MSps —
Transmit Enabled Off —
Transmit Source Backplane —
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PSI/SI Tables Default Settings

Parameter DVB and ATSC Defaults Exceptions

Event Information Table (EIT)

Enable On —
PID 18 —
Transmission Interval 15 dsec —

Network Information Table (NIT)

Enable On —
FEC Convolution Code Rate 5/6 —
Network ID 0 —
Network Name MPEG–2 Encoder —
PID 16 —
Satellite Frequency 011.75725 GHz —
Satellite Modulation Scheme QPSK —
Satellite Orbital Position 019.2° West —
Signal Polarization Vertical —
Symbol Rate 005.5002 MSps —
Transmission Interval 15 dsec —

Program Association Table (PAT)

Enable On —
PID 0 —
Program Number — DVB: 1

ATSC: 2
Transmission Interval 1 dsec —
Transport Stream ID 1 —
Program Map Table (PMT) —
Enable On —
PID 32 decimal —
Transmission Interval 1 dsec —

Service Description Table (SDT)

Enable On —
PID 17 decimal —
Service Name — DVB: Service 1

ATSC: Ch2
Service Provider Unnamed —
Transmission Interval 15 dsec —
Enable Off —
PID 20 decimal —
Transmission Interval 100 dsec —
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Remote Control Port Default Settings

Parameter DVB and ATSC Defaults Exceptions

Baud rate 38400 bps —
Data bits 8 —
Stop bits 1 —
Parity None —
Flow control Software XON/XOFF —
Communication method Full duplex —

Network Default Settings

Parameter DVB and ATSC Defaults Exceptions

IP Address 0.0.0.0 —
IP Mask 225.225.0.0 —
IP Router 0.0.0.0 —
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FTE6000A PID Assignments

The TE6000A automatically sets PID assignments. This automatic assignment of 
PIDs is the same across MPEG, DVB, and ATSC table modes, and follows the 
ATSC PID assignment rules, which are compatible with DVB and MPEG. 
Automatic PID assignment is performed according to the following rules:

■ PID calculations are performed in hex (h). 
■ A program’s base PID is assigned by multiplying the program number by 10h.
■ The program mapping table (PMT) is created from the program’s base PID, 

according to the following rules:
❒ PMT equals the base PID
❒ Video and program clock reference (PCR) are base +1
❒ Audio A is base + 4
❒ Audio B is base + 5 
❒ Audio C is base + 6
❒ Audio D is base + 7
❒ Audio E is base + 1000 hex (4096 decimal)
❒ Audio F is base + 1001 hex (4097 decimal)
❒ Audio G is base + 1002 hex (4098 decimal)
❒ Audio H is base + 1003 hex (4099 decimal)
❒ Auxiliary Data A is base + A hex (10 decimal)
❒ Auxiliary Data B is base + B hex (11 decimal)

For example, for a service with a program number of 2, the following PIDs are 
automatically assigned:

■ Program’s base PID is 20 hex (2h x 10h = 20 hex)
■ PMT, which equivalent to the base PID, is PID 20 hex or 32 decimal
■ Video and PCR are 21 hex or 33 decimal (20h + 1 = 21 hex)
■ Audio A is 24 hex or 36 decimal (20h + 4 = 24 hex)
■ Auxiliary Data A is 2A hex or 42 decimal (20h +10d = 2A hex)

In addition, for full compatibility between ATSC and DVB PID assignments, 
program number 1 should not be used. Using this program number will cause a 
conflict between the elementary stream PID assignments and DVB table PID 
assignments.
For a listing of additional default PID assignments, refer to Appendix B.
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GTable Top and Rack Mount 
Installation Instructions

This appendix presents step-by step instructions for the installation of Tiernan 1U, 
2U, and 4U products. Instructions are presented for installing products:

■ On a table top
■ Using front rack mount brackets
■ Using rear rack mount brackets

Table Top Instructions To install a Tiernan unit on a tabletop or other flat surface, install the rubber feet 
included in the shipping kit, or place the unit on a rubber mat or other material that 
will prevent the unit from sliding and protect the table top surface. 
Ensure that the unit is placed on a stable surface of sufficient size and strength 
where it will not be jarred or pushed off its surface. Ensure that all cables and 
cords are out of the way and that they will not be tripped over, as this may cause 
personal injury or serious damage to the unit.
To install the rubber feet, perform these steps:
1. Ensure that there are four rubber feet included in the shipping kit. 
2. Break the feet apart from one another. Working with one rubber foot at a time:

a. Remove the protective backing
b. Place the foot under one corner of the unit, with the sticky side against the 

unit. 
c. Press the foot firmly against the unit. When you are finished, there should 

be one rubber foot under each corner of the unit.
3. Ensure that the unit’s location and position provide the minimum required air 

flow clearance.

Front Rack Mount
Instructions

To install a Tiernan unit in a standard 19-inch equipment rack using front 
mounting brackets, perform these steps:
1. Ensure that there are two brackets and 4 screws in the front bracket kit. 

One side of each bracket has small holes while the other side has large holes. 
The small holes are counter-sunk on one side. The side which is not 
counter-sunk is placed against the unit.  

The 4U unit contains 8 screws in the shipping kit. One side of each bracket has four small holes 
while the other side has two large holes.

Large Holes
Small Holes

NOTE
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2. Attach the brackets to both sides of the unit:
a. Line up the small holes on the bracket with the unit’s mounting holes, 

which are located towards the front of each side panel. 
b. Thread all of the screws through the bracket’s small holes and into the 

Tiernan unit. The screws should be flush with the bracket when tightened.

3. Mount the unit in the rack by attaching the front brackets to the rack using 
your own washers and bolts.

4. Ensure that the installation provides the minimum required air flow 
clearances at the sides and rear of the unit.

Rear Rack Mount
Instructions

The rear rack mount kit contains the following items:
■ Two mounting plates 
■ Two rack mount brackets
■ Four mounting plate screws
■ Four connector screws with attached washers. Note: the 1U ship kit contains 

eight connector screws.
■ Four rack mount bracket screws with attached washers 

CARRIER OFF CARRIER LOW CARRIER ON MODULATE

Front Bracket

Front Bracket

CARRIER OFF CARRIER LOW CARRIER ON MODULATE

mounting plate screws

connector screws
 with washers

rack mount bracket screws
with washers

rack mount
brackets

mounting
plates

Note: 1U kit contains
eight connector screws
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Rear Rack Bracket Mounting Instructions
To install a Tiernan unit in a standard 19-inch equipment rack using rear 
mounting brackets, perform the following steps: 
1. Attach the mounting plates to both sides of the unit:

a. The mounting plates have a series of oblong slots and two small holes 
which are counter-sunk on one side. The side which in not countersunk is 
placed against the unit.

b. Line up the small holes on the mounting plate with the mounting holes 
located on the unit towards the rear of each side panel. 

c. Thread a mounting screw through the bracket and into the Tiernan unit. 
The screw should be flush with the plate when tightened. 

2. Align the rack mount bracket with the mounting plate. The rack mount 
bracket should lie flat against the outside of the mounting plate with the 
bracket nuts facing away from the mounting plate. The top and bottom of the 
bracket and plate should be even and the bracket holes should line up with the 
mounting plate slots.

3. Attach the rack mount brackets to the rack using the rack mount bracket 
screws. 

4. Attach the mounting plate to the rack mount bracket using all provided 
connector screws. 2U and 4U units use two connector screws per bracket, 1U 
units use four connector screws per bracket. Screws are inserted from the 
inside of the bracket.

5. Ensure that the installation provides the minimum required air flow 
clearances at the sides and rear of the unit.
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Safety Precautions If rack-mounted units are installed in a closed or multi-unit rack, consider the 
following items; further evaluation by a Certifying Agency may be required. 

Ambient Temperature The ambient temperature within the rack may be greater 
than the room’s ambient temperature. When installing the unit, ensure that the 
required air flow for safe operation is provided. 

Rack Stability During installation, consider weight distribution on the rack; 
hazardous stability conditions may arise if units are loaded into the rack unevenly.

Input Supply Overloading of supply circuits could impact over-current 
protection and supply wiring. To ensure that supply circuits are not overloaded 
review the nameplate ratings. 

Grounding Reliable grounding of this equipment must be maintained. Pay 
particular attention to supply connections when connecting to power strips, rather 
than direct connections to the branch circuit.
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